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intelligent Workload Distribution 8.5
Deployment Guide
Welcome to the intelligent Workload Distribution 8.5 Deployment Guide. This document describes
how to install and configure intelligent Workload Distribution (iWD).This document is valid for 8.5.x
releases of this product.

This document is primarily intended for IT staff who are responsible for iWD installation and
configuration and business analysts who are responsible for department and process configuration. It
has been written with the assumption that you have a basic understanding of:

• The workflow concepts as implemented in the various enterprise source systems (for example, business
process management (BPM) systems, host systems, CRM systems, and so on) from which iWD solution
will capture tasks.

• Network design and operation.
• Your own network configurations.

Overview

New Features by Release
Systems, Platforms and Compatibilities
iWD Solution Architecture for 8.5.x
Migration to 8.5.0/8.5.1

Installation Overview

Deployment Overview
InstallationPhaseOverview
SystemConfigurationOverview
BusinessLogicOverview
Prepare for Installation

Installation 1

Interaction Server Configuration
Installing iWD GAX Plug-in
Uploading IPs Using GAX
Installing Runtime Node

Installation 2

Creating the Tenant in GAX
Working with Integrated Capture Points
iWD Setup Utility
Manual Setup of the IWDBPs in 8.5.104

intelligent Workload Distribution 8.5 Deployment Guide

iWD Deployment Guide 4

https://docs.genesys.com/Documentation/IW/8.5.1/Dep/NewIn850
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/SystemGuideInfo
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDArchitecture
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDMigration
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/InstallationOverview
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/InstallationPhaseOverview
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/SystemConfigurationOverview
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/BusinessLogicOverview
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/Installation
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDIXServerInstall
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDGAXPluginInstall2
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDGAXIPUpload
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDRuntimeInstall
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDCreateTenant
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDIntCapturePoints
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDSetupUtil
https://docs.genesys.com/Documentation/IW/8.5.1/Dep/IWDManualBPSetup


Installing iWD Manager
Enabling/Disabling ADDP Connections

Stat Server Extensions
Installation 3

Logging
Preparing iWD for use with Social
Engagement
Installing/Removing Language Packs

Troubleshooting

Troubleshooting
Support for RHEL 64-bit Platforms
Blocked Lookup Tables

Configuration

iWD Manager Configuration
Roles and Privileges in GAX
Setting Shared User Access Roles Across
iWD and GRS
Integration with Genesys Rules System and
Universal Contact Server
iWD Business Solution Configuration
iWD Services
iWD Reporting
Configuring Multiple Business Processes
Database Cluster Configuration

iWD Web Installation and
Configuration

Installing iWD Web for Windows Manually
Installing iWD Web on Linux
Create/Configure iWD Web in GAX
Configure Web Service Capture Point
Configuring Spring Services

Further Configuration

Customer and Partner Translation
High Availability
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New Features by Release

New in 8.5.1

8.5.108.01
Additional Platform Support

iWD GAX Plugin now supports Windows Server 2016 for GAX version 8.5.290.09+. Associated
language packs also now support Windows Server 2016.

Improvements to the IWD Business Process for ORS/Composer

A Pause block with a configurable delay has been added to the InvokeGRE workflow of the IWD
Business Process for Composer/ORS, to guarantee that interaction updates will be received. By
default, the delay value is set to 0. Previously during the task life cycle, when the Genesys Rules
Engine changed interaction properties, ORS did not always have enough time to receive an
acknowledgement of the changes from Interaction Server and so it continued executing the workflow.
This could lead to unexpected behavior. For example, tasks might go to the ErrorHeld queue
sporadically without visible reasons. There is more information here:

• Changes to IWDBP Strategies & Subroutines in 8.5.108.01.

8.5.106.03
Support for Secure Database Connections

The following improvements have been made:

• Secure connection between Stat Server Extensions and the IWD Data Mart Oracle database is now
supported using a new Oracle JDBC driver. There is more information here:
• Database Cluster Configuration

• Database connections from iWD Manager are declared secure in this release.

Improvements to the IWD Business Process for ORS/Composer

The following improvements have been made to the iWD Business Process for ORS/Composer:

• User Data properties have been removed from the InvokeGRE block.
• IWD_ReprioritizeDateTime is now deleted before a call to the InvokeGRE block if

IWD_ReprioritizeDateTime is undefined.
• The NumberOfRulesApplied has been attached to the interaction.
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Important
A minimum version of ORS 8.1.400.48 is required to use these improvements.

8.5.105.02
Improvements to the IWD Business Process

• Segmentation Support—Segmentation settings have been added to the ToDistribute view of the
Distribution routing strategy in the iWD Business Processes for both IRD and Composer/ORS.
Segmenting interactions ensures that all agents are kept busy by distributing tasks in each segment
separately, thus reducing agents' idle time. As a result, even in a Distribution strategy that is populated
by high-priority tasks assigned to small groups of agents, the strategy will not become so saturated
that distribution of tasks to other agents is blocked.

With segmentation it is now possible to identify an interaction attribute (IWD_Segment) that will
be checked in the segmentation settings. The Distribution strategy checks the interaction attribute
used in the segmentation settings and, based on its value, routes the interaction to the correct
agent/agent group. Each agent group can have its own task queue, and each segment can have
its own limit. There is more information here:

• IWDBP for IRD
• IWD Business Process diagram (new document)
• IWD BP Strategies & Subroutines in 8.5.105 (new document)

• IWDBP for Composer/ORS
• IWD BP Strategies & Subroutines in 8.5.105 (new document)

Business Structure Permissions

• Business Structure details in the iWD GAX Plug-in now include a Permissions tab on which users with
the relevant permissions can view and edit permissions setting for all users of the selected node. There
is more information here:
• Permissions Settings (new document)

Role-Based Access Control (RBAC)

• In order to apply full RBAC to the iWD GAX Plug-in on the GAX dashboard, the following role permissions
have been added to the iWD GAX Plug-in's template:
• IWD_READ_LOOKUP_TABLES
• IWD_MODIFY_LOOKUP_TABLES
• IWD_CREATE_LOOKUP_TABLES
• IWD_DELETE_LOOKUP_TABLES
• IWD_READ_DATAMART
• IWD_MODIFY_DATAMART
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• IWD_MONITOR_DATAMART
• IWD_MANAGE_DATAMART

Users without the relevant permissions will not be able to view the iWD tile on the GAX dashboard.

Improvements to Dimensions Handling

• The operation of indexes of dimensions tables on MSSQL has been improved. Previously, parameters
were passed in Unicode which required a conversion to non-Unicode before the parameters could be
used in queries. Now, parameters are sent in non-Unicode.

The dimensions caching mechanism has also been improved. Previously, the Load Intraday job
cached dimensions values, but the cache was cleared with every run of the Load Intraday job.
Now, you can retain cache values between job runs, which significantly reduces the number of the
queries to the Data Mart database.

A new option has been added to in the settings section of the iWD Runtime Node application in
Configuration Server and iWD GAX Plug-in:

• clear-cache (Clear Dimension Cache in GAX Plug-in)
• Valid values: true/false
• Default value: false

When this option is set to true, the dimension's cache is cleared when the Load Intraday job
completes. When this option is set to false, the cache persists between Load Intraday job runs.

8.5.104.03
Support for Composer/ORS in iWDBP

Release 8.5.104 ships with versions of the IWDBP available in both Genesys Interaction Routing
Designer (IRD) and Genesys Composer/ORS. There are also some updates to the content of the
original IRD IWDBP.

Composer is a single Integrated Development Environment (IDE) for creating applications to
orchestrate the entire customer experience. Composer-created voice and routing applications can
command and control the customer experience through all channels (IVR, voice, e-services, and so
on). Composer's open framework enables widely-available, existing competencies to be used to
create reusable components that manage the customer experience. The IDE allows both customers
and integrators to utilize existing code sets (HTML, VXML, Java, Perl, REST and others) to control the
customer experience. The open framework also allows simplified integration into all Enterprise
applications to harness the information within the Enterprise to drive and personalize the customer
experience.

Differences from IRD

Before iWD 8.5.104, Interaction Routing Designer (IRD) was the Genesys tool used to create iWD
routing applications. Genesys Composer is now the tool of choice for creating both routing and voice
self-service applications. A few of the differences between Composer and Interaction Routing
Designer are listed below.

• Composer is integrated with Orchestration Server allowing you to manage customer conversations
spread out over time using the ORS session-based functionality and persistent storage as well as
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Orchestration Extensions.
• Composer encompasses IRD's functionality and much more routing functionality in general.
• Composer lets you create routing applications using an open language (SCXML) and ECMAScript for

decision-making. In contrast, IRD uses a Genesys proprietary language (IRL).
• Composer gives the option of writing your own SCXML code and/or using predefined blocks.
• You can also use Composer to create voice self-service applications for Genesys Voice Platform,

including VoiceXML and CCXML-based applications. You can also create integrated voice and routing
applications.

Important
There is a summary of the differences between IRD and Composer here (new
document).

Recommendation for Installation

Genesys recommends using manual installation procedures for the 8.5.104 versions of the iWD
Business Process. There is more information here:

• here for more details.

Further Reading

Please refer to these documents for full information:

• Working with the IWDBP in IRD
• Working with the IWDBP in Composer

Security Enhancements

Security improvements against Cross-Frame Scripting and Session Fixation are implemented in this
release.

Support for Postgre SQL 9

Support for Postgre SQL 9 database is implemented in this release.

Platform Support Changes

Support for the AIX and Solaris platforms is discontinued in this release.

8.5.103.03
Support for Oracle 12c

Support for both Oracle 12c and Oracle 12c RAC has been implemented. Configurations with and
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without Single Client Access Name (SCAN) are supported.

• For iWD Manager configuration information relating to Oracle 12 support, click here.
• For general Oracle 12 configuration information for iWD, click here.

Custom JDBC URL support

Custom JDBC URL support has been added to the Statistics Adapter.

8.5.102.03 and iWD Web 8.5.100.06
iWD Web—Initial Release

iWD Web is a web-based, easy-to-deploy workload management solution. It enables organizations to
automate and optimize the distribution and handling of tasks and increase workforce efficiency.
Purpose-built to deliver rapid time to value, it provides the capability to upload task lists without the
need to connect to other source systems, such as CRM, ERP, and legacy systems, leveraging export
functionality commonly available to business users.

Instead of having to rely on manual task distribution to your team via spreadsheets (and also CSV
files,) or team members having to pick their next work item manually from a CRM, ERP, or legacy
system, iWD Web enables you to create new lists with task definitions based on data that business or
operations managers can upload from .CSV, .XLS and .XLSX files. You can use your CRM, ERP, or
legacy system's export to spreadsheet/CSV file feature to download a list of work items that your
team needs to work on and import that file to iWD Web, which reads and treats every line of your
spreadsheet as a task to be analyzed and properly distributed to your available team members. See
iWD Help.

8.5.101.03
Integration with Genesys Hub

• Single Sign-On—iWD now participates in the Genesys Single Sign-On (SSO) framework where
deployment takes place to a Genesys Engage cloud SSO environment. When iWD is deployed into this
environment, iWD users will log in once to the portal. If they choose iWD Manager, they will bypass the
login screen if they are still authenticated. Note that this feature does not apply for Genesys on-
premise customers deploying iWD.

This release fully integrates iWD with the Genesys Hub. The main features of this integration are:

• Single sign-on (SSO)—A single login allows access to all applications where permissions are
configured.

• Simplified user provisioning.
• Improvements to the user security model.

Enabling and disabling of SSO/SLO is performed by editing properties in the iwd.properties file.
See the iWD Manager installation procedures.

• An iWD app launcher on the Hub central navigation page.
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Setting Shared User Rights for iWD and GRS

This feature enables administration-level users to set shared user access roles across iWD and GRS,
enforcing consistent behaviour between them. Before the introduction of this feature, if you
configured in IWD two roles—Manager1 and Manager 2—where Manager 1 is dedicated to
Department 1 and Manager 2 is dedicated to Department 2, these configuration constraints were not
read correctly by iWD Manager. This meant that in iWD Manager, both Manager 1 and Manager 2
could see everything in both Departments. With this feature, roles are configured consistently across
GRS and IWD.

Support for Multiple Rule Packages in a Single ESP Call

The ESP interface with Genesys Rules Engine has been extended to allow a rules package on the
Solution level to specify multiple rule package names in a single ESP call. On an incoming request
when the Service parameter is set to BusinessContextManagement and the Method parameter equals
either SetBusinessContext (Classification phase), Prioritize, or Archive, the interface will accept
multiple rule packages specified in the following format: rule.package1, rule.package2,
rule.package3…… and delivered, for example, by a transaction called Iwd_Package_List for the
default Business Process. Task History for multiple rule packages can also be displayed.

8.5.100.02
Support for Multiple Business Processes in one Tenant

In release 8.5.1 you can create new business processes (under the same Tenant) that can support
clear logical distinctions between processes and departments For example, interactions from different
media types (email, chat, SMS and so on) can be handled by separate business processes with their
own customized queue names, and this in turn can provide clear logical distinctions in reporting,
because the queue name is the basis for handling reporting requirements. This is achieved by by
cloning and editing the iWDBP, and making the interaction queues (supplied out-of-box with iWD)
configurable for your needs, together with some additional configuration changes. See Working with
the iWD Business Process guide for a full description.

Additional Message Server for iWD GAX Plug-in

Genesys now recommends configuring a separate Message Server for the iWD GAX Plug-in to prevent
log files becoming excessively large.

Platform Support

Support for Genesys Platform SDK 8.5
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New in 8.5.0

8.5.000.15
Re-architecting of IWD

Most of the deployment and configuration of iWD is now carried out using new components and
interfaces. Some of the effects of this change are:

• Standardization of many of the procedures involved with deployment and configuration, using new
components as well as a refreshed iWD Manager component.

• A completely new user configuration interface based on the Genesys Administrator Extension (GAX)
plug-in.

• Removal of support for configuration using the Genesys Configuration Manager client.

The changes are detailed as follows:

• iWD is now deployed by means of a new GAX Automatic Service Deployment (ASD) plug-in component
called iWD Setup Utility.

• iWD configuration is now performed via Genesys Administrator Extension (GAX) and a new iWD GAX
plug-in component. Specifically, the following aspects that were previously carried out in iWD Manager
have now moved:
• Tenant profile (to GAX)
• Lookup tables (to iWD GAX Plugin)
• Services (to iWD GAX Plugin)
• Generic capture point (to GAX)
• Data Mart Services (to iWD GAX Plugin)
• Departments and processes (to iWD GAX Plugin)
• Audit history (to a centralized log database)
• Security policy (to Genesys Administrator, using Role-Based Access Control (RBAC))

• The IWD Data Mart Services view is now replaced by a GAX dashboard monitoring the state of the Data
Mart node.

• Data Mart can now run as a standalone Java module and is now managed directly using Solution Control
Server.

• The modules and components mechanism is removed from iWD Manager.
• The Business Context Management Service (BCMS) functionality is moved to the Genesys Rules Engine.
• IWD Manager is now used primarily for task management and monitoring using the Global Task List.
• Support for legacy capture points is removed.
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Deployment/Configuration Using Genesys Administrator Extension

• Support for configuration using the Genesys Configuration Manager client is withdrawn in release 8.5.0.
• You must use Genesys Administrator Extension (GAX) together with the iWD GAX Plugin component for

deployment and configuration in release 8.5.0.

High Availability

• Support for Unresponsive Process Detection in iWD Runtime Node

Additional Database Server Support

• Support for SQL Server Cluster 2008
• Support for MS SQL Server 2012
• Support for MS SQL Server 2012 Cluster

Additional Platform Support

• Support for Windows Server 2012 64-bit native
• Support for Red Hat Enterprise Linux 6.0 64-bit native

Additional Virtualization Platform Support

• Support for Windows 2012 Server Hyper-V

Additional Servlet Support

• Support for Java 7 SE bundle
• Support for Java 7 EE bundle

Additional Servlet Engines

• Support for Websphere 8.5

Additional Browser Support

• Support for Google Chrome
• Support for Internet Explorer 10 and 11
• Support for Firefox 24ESR
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Discontinued Support

• Internet Explorer 7
• Firefox 3, 4
• MySQL - all versions
• Oracle 10g and 10g RAC
• IBM AIX 5.3
• MS Windows Server 2003
• Red Hat Enterprise Linux 4
• Solaris/SPARC version 9
• WebSphere Application Server 6
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Systems, Platforms and Compatibilities
Summary
Please refer to these documents for further information.

Release 8.5

Genesys Supported Operating Environment Reference for iWD Provides operating environments
information required to run Genesys iWD.

Genesys Interoperability Guide

Use this document for product availability and interoperability when you plan to
add or upgrade Genesys products.
Genesys Supported Media Interfaces Reference Manual Use this document for information on media
interfaces.

Genesys 8.1 Security Deployment Guide
Use this document for information on how to configure security levels for your environment.

intelligent Workload Distribution 8.5 Deployment
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iWD Architecture Diagrams for 8.5.x

Video - Differences between 8.1.1 and 8.5.0

Click here to watch a short video of differences between the 8.1.1 and 8.5.0 architectures.

8.5.x Component Architecture
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8.5.x Genesys CIM Platform and IWD Solution

Genesys CIM Platform
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Genesys CIM Platform with IWD Solution

intelligent Workload Distribution 8.5 Deployment Guide iWD Architecture Diagrams for 8.5.x

iWD Deployment Guide 18



Migration to 8.5.1

General comments

• ETL scripts—Please note that each new IWD release delivers newer versions of ETL scripts, and the path
to ETL is configurable (GAX -> Configuration -> iWD -> Datamart -> YOUR SOLUTION -> <ETL
Scripts Directory>). You must ensure that you are using the latest version of scripts. Any
customizations must also be re-applied.

8.5.106.03

A minimum version of ORS 8.1.400.48 is required to use the new Stat Server Extension features
implemented in this release.

From 8.5.102/3 to 8.5.104

iWD Manager deployment on Tomcat 6 is no longer supported. Customers using Tomcat must
upgrade to Tomcat 7.0.67 or later.

Please consult the iWD Business Process documentation for IRD and for Composer to understand
the changes in the 8.5.104 release of iWD. There are improvements and enhancements to the
previous 8.5.1 IRD business process.

Genesys recommends manual installation of the updated iWD Business Process for IRD and the iWD
Business Process for Composer.

From 8.5.101 to 8.5.102

Message Server or Message Server DAP in Data Mart have been replaced with
Configuration Server DAP in release 8.5.102
Please follow the procedure in Configuring Data Mart Logging.

Using Genesys Administrator Extension, remove the Message Server or Message Server DAP as
described below.

1. Navigate to Configuration > Applications.
2. Find the Data Mart application and open it.
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3. On the Connections tab, locate the Message Server or Message Server DAP applications and do the
following:
a. If no Message Server or Message Server DAP applications are found, click Cancel and skip the

following step.
b. If Message Server or Message Server DAP applications are found, select the check box next to their

name and click Remove. Click Save to save changes.

iWD Runtime Node Application type has been changed from ThirdParty to iWD
Runtime Node in release 8.5.102

1. Log in to Genesys Administrator Extension and navigate to the iWD Runtime Node application—for
example, Configuration > Applications.

2. Open the ThirdParty iWD Runtime Node application.
3. Navigate to the Options tab and from the More menu select the Export option.
4. Create a new iWD Runtime Node application with type iWD Runtime Node, as follows:

a. if you are installing iWD Runtime Node via Genesys Administrator Extension (see Deployment Guide)
the new iWD Runtime Node application will be created automatically.

b. In all other cases you need to create it manually, as follows:
i. Import the iWD Runtime Node Template. If it does not exist just create a new template for the

application type iWD Runtime Node.
ii. Create a new iWD Runtime Node application using the iWD Runtime Node template.

5. In the newly created iWD Runtime Node application go to the Options tab and from the More menu
select the Import option. Other settings should be the same as in the old ThirdParty iWD Runtime Node
application.

6. Remove the old ThirdParty iWD Runtime Node application.
7. Set the iWD Runtime Node application name to that of the removed ThirdParty iWD Runtime Node

application name.
8. Navigate to Home > Datamart ><used solution>

9. On the General tab, select the newly created application and save the changes.

From 8.5.0

To migrate from 8.5.0 to 8.5.1 use the following procedures:

1. Use the installation procedures for each component to install 8.5.1 on top of 8.5.0.

Important
Note that for each component you must uninstall the previous version before installing the new version. Note
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also that the Uninstall action is not supported by the GAX interface for either plug-ins or any other
application, whether or not it was installed using the GAX interface. See the procedure for installing
and removing plug-ins.

2. Run the migration script
a. Install Python 2.6 or 2.7 and the httplib2 library. GAX must be accessible through the network from

the machine where Python is installed.
b. Go to iWD Manager installation directory and then to the configuration directory inside—for

example, C:\Program Files (x86)\GCTI\iWD Manager\config
c. Unpack the migration.zip file to the migration directory.
d. Run the script for each tenant being migrated, including the Environment (tenant_runtime_id

SYSTEM) tenant. For the Environment tenant, provide the same .xml file for flags –s and –i.
python main850_851.py –t <tenant_name> -r <tenant_runtime_id> -i
<tenant_export_file>.xml –s <system_tenant_export_file>.xml
–g <GAX_URL> -u <username> -p <password> -v –d <mapping_file>.ini

Important
The tenant_runtime_id can be found in GAX. From the Configuration page in the Environment links list,
click on the Tenants link, and then click on the Tenant name. On the General tab the Tenant name is
defined in the Name field. On the iWD Attributes tab the tenant_runtime_id is defined in the ID field.

3. If Universal Contact Server is configured it must be added to iWD Manager's connections. Normal
configuration requires one UCS instance per iWD Solution, so if you have more than one Solution
configured, you must add a connection from iWD Manager to each required UCS
a. On the Connections tab, add the connection(s) and connection parameters to Universal Contact

Server (UCS) that your iWD Solution(s) will use:
i. Add the Port ID on the Interaction Server that iWD Manager will connect to. It can be a secure

port if you intend to use TLS.
ii. Specify the Connection Protocol: simple or addp.
iii. Specify the Local Timeout and the Remote Timeout—These values are required only if you

specified addp in Connection Protocol. This value specifies the heartbeat polling interval,
measured in seconds, on the client side. This indicates how often the client application sends
polling signals to the server application. To enable this functionality, specify any integer as the
value.

iv. Specify a Trace Mode—The connection trace mode used between a server and its client.
• Trace Is Turned Off—Select if you do not want either the client or the server application

to print ADDP-related messages in its log.
• Trace On Client Side—Select if you want the client application to print ADDP-related

messages in its log.
• Trace On Server Side—Select if you want the server application to print ADDP-related

messages in its log.
• Trace On Both Sides—Select if you want both the client and server applications to print
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ADDP-related messages in their logs.

b. Specify Transport Protocol Paramters—Any text, usually key-value pairs, separated by a
semicolon (;). This property is application-specific.

c. Specify Application Parameters—Any text, usually key-value pairs, separated by a semicolon (;).
This property is application-specific.

From 8.1.1

1. From iWD Manager 8.1.1, export the configuration to .xml files. All tenants must be exported.
2. Install Genesys Administrator Extension 8.5.200.12.
3. Log in to GRAT, click on each rule package that you want to migrate and export it as an XML file.

Warning
Previously these steps were part of the GRS migration procedure. However since 8.1.300 they are applicable
only for iWD migration

4. Upgrade the Genesys Rules System according to the GRS and IWD Compatibility Matrix.
5. Install iWD 8.5.1 components including iWD Plug-in for GAX.

Important
iWD Manager has a new template in 8.5—this must be upgraded as well.

6. After iWD Manager is installed, configure roles and privileges for IWD.
7. Upgrade the Business Process.
8. Upgrade the Standard Rule Templates.
9. Start GAX. Make sure, that iWD Plugin for GAX is available.

10. If setting up a new system, make sure that:

• All tenants are already created (the migration script does not create Tenants).
• All tenants have already uploaded at least one Business Process with default queue names— iWD_New,

iWD_Queued and so on.
• The Interaction Server application and Database Access Points (DAPs) are defined.

• Make sure the Runtime Node application exists. Create a Runtime Node DAP application if is not already
defined.

• Install Python 2.6 or 2.7 and the httplib2 library. GAX must be accessible through network from the machine
where Python is installed.
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• Run the script for each tenant being migrated, including the Environment (tenant_runtime_id SYSTEM)
tenant. For the Environment tenant, provide the same .xml file for flags –s and –i.
python main.py –t <tenant_name> -r <tenant_runtime_id> -i <tenant_export_file>.xml –s
<system_tenant_export_file>.xml
–g <GAX_URL> -u <username> -p <password> -v –d <mapping_file>.ini

Important
The tenant_runtime_id can be found in GAX. From the Configuration page in the Environment links list, click on
the Tenants link, and then click on the Tenant name. On the General tab the Tenant name is defined in the Name
field. On the iWD Attributes tab the tenant_runtime_id is defined in the ID field.

• Review the configuration using iWD Plugin for GAX.
• Import the previously exported rule packages into GRAT.
• Create new integrated capture points. See the Working with Integrated Capture Points section.
• Start iWD Manager and upgrade the iWD Manager database.
• If you are migrating an existing system/Data Mart configuration, update the Audit Events. Do this by running

the following query against the Data Mart database, after the Business Structure is configured in
Configuration Server:
DELETE FROM ETL_AUDIT WHERE PROCESS_NAME = 'Load_Config_GTL_DM'

• Start iWD Runtime Node (optional).

From Releases Prior to 8.1.1
No direct migration process is supported from releases earlier than 8.1.1 to 8.5.1. To migrate from these earlier releases, you must first
migrate to 8.1.1.
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Deployment Overview

Important
Genesys strongly recommends that you perform all 8.5.0+ installations manually, and
subsequently configure the application using the Genesys Administrator Extension
(GAX) and the iWD Plug-in for GAX.

Deployment of IWD consists of three main phases:

• Installation phase
• System configuration phase
• Business logic configuration phase
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Installation Phase Overview

Definitions

Installation is the initial iWD deployment phase that results in a fully functional iWD Manager
application and prepared iWD runtime node. Whereas in pre-8.5.0 releases, iWD Manager was used
for the rest of the deployment configuration, from 8.5.0 most of the configuration is carried out using
the Genesys Administrator Extension (GAX) component and the iWD Plug-in for GAX component (from
now on referred to as iWD GAX Plugin).

From 8.5.0, iWD Manager is used mostly for task monitoring and management via the Global Task
List.

The iWD Runtime Node is a container in which the iWD runtime services run.

The installation phase requires knowledge of the overall system infrastructure in which iWD is being
deployed, such as Java web application server and database configuration. This phase is typically
implemented by IT personnel.

iWD installation consists of two steps:

• Preparing databases
• Installing applications

Database Preparation

The first step of iWD installation is database preparation. A basic iWD deployment uses four
operational databases:

• iWD Configuration database—iWD Manager utilizes a database in which all of the configuration data
(GTL Filters) is stored. The rest of the configuration have moved to the Configuration Server database.

• Genesys Rules System rule repository—Stores business rule templates and business rules. For more
information, see the Genesys Rules System 8.5 Deployment Guide

• Interaction Server databases—Stores iWD tasks and related task events. Make sure that you have
installed and configured the Interaction Server and its associated databases, as described in the
eServices (Multimedia) 8.1 Deployment Guide.

• Data Mart database—Uses Fact tables, aggregates, dimension and measures to provide sophisticated
reporting options.

For a list of the database engines that are supported by the iWD application, Genesys Rules System,
and Interaction Server, refer to the Genesys Supported Operating Environment
Reference_Guide. Please note that the iWD application might not support all of the databases that
are supported by Interaction Server or the Genesys Rules System.
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To prepare the iWD Configuration database, two actions must be performed manually via the
database's administrative interface:

• Creation of a database
• Creation of a database user who will need the following permissions:

• CREATE TABLE

• CREATE INDEX

• CREATE VIEW

• CREATE TRIGGER (Oracle)
• CREATE SEQUENCE (Oracle)

The rest of the database setup, such as creation of tables and indexes, is performed automatically by
iWD.

Application Installation

After the iWD operational databases have been prepared, the iWD GAX Plugin component, the iWD
Manager application and the iWD Runtime Nodes can be installed. iWD Manager runs on a Java
application server. iWD Runtime Node is a stand-alone Java application. In release 8.5, both
applications should be installed manually and subsequently configured by using Genesys
Administrator Extension (GAX).

Refer to the 'Genesys Supported Operating Environment Reference Guide for a list of the Java
application servers that are supported by iWD.

A basic iWD deployment, such as in a lab environment, utilizes a single instance of iWD Manager, as
well as a single instance of an iWD Runtime Node. In more complex scenarios, such as multi-tenant,
high-volume or high-availability deployments, multiple iWD Runtime Node instances can be installed.
These deployments provide more controlled resource partitioning and allow load distribution across
multiple physical servers.

Up to release 8.1, for a production deployment, Genesys recommended that you deploy iWD Data
Mart services on a dedicated iWD Runtime Node. In release 8.5, Data Mart can be run as a stand-
alone Java application and can be controlled by Solution Control Service (SCS)

In addition to the iWD GAX Plugin, the iWD Manager and iWD Runtime Node installation, Genesys
Rules System must be installed. This installation includes:

• Genesys Rules Development Tool, which is an Eclipse plug-in for business rule template development
• Genesys Rules Authoring Tool, which is used for authoring and deploying business rules
• Genesys Rules Engine, which is an engine that receives and processes requests for business rule

evaluation from clients, such as the routing strategies in the iWD Business Process (IWDBP).
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System Configuration Phase Overview

Tenants

iWD configuration supports multi-tenancy. iWD automatically creates a root tenant that is named
System by default. The System tenant is automatically mapped to the Environment tenant in
Genesys Configuration Server. Although it is possible to configure iWD solutions, services, and
business logic directly at the System tenant level, it is recommended that you create a subtenant for
that configuration. In iWD terminology, such a subtenant is called a managed tenant. This managed
tenant is associated directly with a tenant defined in Genesys Configuration Server. In a single-tenant
environment the configured managed tenant maps to the Resources tenant in Genesys Configuration
Server.

A user who is configuring the system in Genesys Administrator Extension (GAX) can have access to
one or more managed tenants. Access is defined by the role-based access controls that are
configured in GAX, per tenant. The policy allows definition of an arbitrary numbers of user roles,
where each role can be assigned to any Genesys Configuration Server users or access groups. Each
role has a number of associated iWD permissions. Note, that iWD Manager and iWD GAX Plugin have
separate lists of permissions.

Important
The tenancy model that is supported in the iWD application currently has a one-to-one
relationship with the tenancy model in Genesys Configuration Server.

Multi-tenant Configurations
If you are using a Multi-Tenant Configuration Server, please be aware that the iWD tenant can only
access resources (such as Skills and Agent Groups) that are specifically configured under the
corresponding Genesys Configuration Server Tenant in GAX. Therefore, any Skills, Agent Groups, or
other resources that are configured at the Environment Level will not be accessible in rules at a child-
tenant level in iWD. To make these resources accessible, they must be configured as resources under
the child tenant in Configuration Server.

Solutions

Solutions are used for partitioning logical and physical resources for purposes of user access control
and load partitioning (performance). Normally there will be one Solution per Tenant.

A solution in iWD represents a runtime environment, which is composed of the following:

• Runtime nodes—iWD runtime application instances that are stand-alone Java applications. Runtime
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nodes require simple preparation during installation.
• StatServer—Provides statistics to CCPulse+ via iWD Stat Extensions
• Business logic configuration—Primarily the configuration of iWD departments and processes.
• Multiple solution instances can be configured per tenant, if necessary (for example, “Production” and

“Test”).

Runtime Nodes

Runtime Nodes are instances of the iWD runtime application and are run as a stand-alone Java
application. Services that run within a runtime node are configured in (and managed through) the
iWD GAX Plugin application.

Services

iWD Services implement actual iWD functionality, such as loading data into the Data Mart. Refer to
iWD Services for more information about iWD Services, including the recommended order of
configuration.
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Business Logic Configuration Phase
Overview
The iWD business logic configuration phase is where iWD business context is introduced. This
includes definition of departments and processes. This phase also includes the definition of business
rules for use in task processing. After this phase, iWD is fully functional and can start processing
tasks. The iWD system configuration phase requires knowledge of business context for tasks that will
be handled by iWD. This includes business processes, service-level agreements (SLAs), and other
factors that influence task-handling logic.

Departments and Processes

Departments represent organizational entities for which iWD will perform task prioritization and
routing. Processes represent the business processes that are within those enterprise departments. In
iWD, processes are always grouped within (associated with) a department. Departments and
Processes allow for the definition of task-handling business rules that are specific to a department or
process context.

Departments and Processes are created in iWD GAX Plugin and stored on Genesys Configuration
Server. They are used by iWD Manager for task filtering and Genesys Rules System for managing
rules.

Each department and process allows for the definition of a maximum of 5 custom attributes to a
department/process in order to provide additional enterprise-specific context for reporting purposes.

Important
In release 8.5.1 you can create new business processes (under the same Tenant) that
can support clear logical distinctions between Processes and Departments For
example, interactions from different media types (e-mail, chat, SMS and so on) can be
handled by separate business processes with their own customized queue names, and
this in turn can provide clear logical distinctions in reporting, because the queue name
is the basis for handling reporting requirements. See either Working with the
iWDBP for IRD or Working with the iWDBP for Composer

Rules

Part of configuring the business logic for departments and processes in iWD is configuring and
associating rules. All business rule authoring for iWD is done through the Genesys Rules Authoring
Tool, which is a component of the Genesys Rules System. These rules define the task-handling
business logic that is applicable to the departments, processes, or the entire system. Generally, a
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rule is represented by zero, one or more conditions and one or more actions. If there are no
conditions for the rule, its actions will always be executed. If all of the conditions are true, all of the
actions are executed. If any condition is not true, none of the actions are executed.

Rules are expressed in an easy-to-understand human language, such as:

If the task is due in 10 or more minutes, increase priority by 10.

The implementation details are hidden in rule templates, and users who configure business logic deal
only with high-level logical expressions.

Rules can be defined in one of two ways:

• As a linear rule
• As a decision table.

Linear rules are intended for complex rules that have many conditions and/or actions. Each condition
or action is represented by a single line in the rule. Linear Rule Example shows an example of a linear
rule.

Decision tables represent a more compact form of rule representation; however, they might not be as
well suited to complex rules. In a decision table, multiple rules are grouped together, so that each
condition or action is represented by a column in a table, and each row represents a rule. The
number and type of conditions and actions (columns) is constant across all of the rules in the list.

Task Classification

Task classification does the following:

• Associates a task with a configured process.
• (Optionally) assign values to other task attributes, such as business value and due time.

Task-classification logic is expressed via business rules that can be defined for three different
contexts:

• Package-level rules (also known as Global Rules)
• Department
• Process

If rules are defined for more than one context, they are evaluated in sequence, as previously listed.
After a process has been assigned to a task, additional classification rules are evaluated that have
been defined, first at the rule package or global level, then at the department level, and finally at the
process level. The figure below shows an example of Task Classification.

A process must be assigned during the classification phase. It can be assigned in two places:

• At the global level
• At the department level.
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(A department can be assigned at the global level and then, the rule evaluation can continue at the
department level to actually select a process.)

Important
Capture Point rules are configured at the rule package (global) level, by using the rule
condition Capture Point is.

.

Task Classification Using the “Capture Point is” Rule Condition
For more information about task classification, refer to Working with the iWD Business Process
for IRD or Working with the iWD Business Process for Composer.

Task Prioritization

The primary purpose of task prioritization is dynamic priority calculation, where dynamic means that
the task priority can be recalculated multiple times during the task’s life cycle. As with task
classification, prioritization logic is expressed via rules.

Prioritization rules are initially applied immediately after classification rules and then reapplied after a
specified reprioritization period. The reprioritization period is expressed in the same way as any other
rule action.

Task Prioritization
If a reprioritization period is not set for a task during the prioritization phase in business rules, the
IWD_reprioritizeDateTime attribute is set to Dec 31, 2030. Therefore, for all intents and purposes.
the task will not undergo further reprioritization unless it is restarted.

The Standard Rules Template includes two rule conditions, Is first prioritization and Is
reprioritization that should be used in prioritization rules to ensure that the reprioritization
interval is set correctly, while avoiding any unnecessary immediate reprioritization of a task (that is,
the first time prioritization rules are evaluated).

For example, suppose you have a task that, during the classification phase, gets an initial priority of
100. You wish to increase the priority by 15 every 2 hours, if the task is due in less than 24 hours. You
want to do the first check 1 hour after the task is classified. You would set this up by using two
different prioritization rules, configured in the order shown below. The example Rule 1—Is First
Prioritization shows the first rule, which includes the Is first prioritization condition. The
second rule, shown in Rule 2—Is Reprioritization, includes the Is reprioritization condition.
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Rule 1—Is First Prioritization

Rule1-Is First Prioritization Example

Rule 2—Is Reprioritization

Rule2-Is Prioritization Example

For more information about task prioritization, refer to the Working with IWD Business Process
documentation.

Business Calendars

A business calendar is a set of configuration parameters that define working days and hours, as well
as holidays that apply to the business. In its simplest form, the business calendar would consist of
definitions for both a working week and working hours that apply to all working days.

A definition of a working week from Monday to Friday—in which each day starts at 9:00 AM and ends
at 5:00 PM—is a classic example of a simple business calendar. If necessary, exceptions to the usual
working schedule (public holidays, business-specific holidays, nonstandard working hours, and so on)
can be added to the business calendar.

Business calendars can be used in iWD rules to perform date and time calculations that take into
account the working schedule of the business. Business calendars can either be assigned to a rule
itself, or can be assigned in a rule action. In either case, the business calendar must be assigned
before other rules that use the business calendar can be evaluated.

Important
Business Calendars are created in the Genesys Rules Authoring Tool. In Genesys Rules
System release 8.5.1, business calendar functionality has been enhanced. See
Business Calendar Enhancements (GRS Best Practice/User Guide).
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Business Calendar

Business Calendar Example
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Installation

Task Summary: Installing iWD 8.5

The following table outlines the task flow for installing iWD 8.5. The procedures referenced in this
table provide instructions about installing iWD components on Windows hosts.

Installing iWD 8.5

Objective Related procedures and actions

1. Prepare for installation and review prerequisites.
Ensure that your environment meets the prerequisites. Ensure
that the required CDs are available. See Preparing for
Installation.

2. Install Interaction Server.

iWD 8.5 requires Interaction Server 8.1.1 or higher. Genesys
recommends that you use the latest version of Interaction
Server that is included with iWD. If your environment does not
have an instance of Interaction Server installed already (such as
for an eServices solution), you must install one. See Install
Interaction Server.

3. Install Genesys Administrator Extension (GAX).
If it is not already installed, you must install GAX.
8.5.0: Install GAX release 8.5.000.47 or higher.
8.5.1: Install GAX 8.5.200.12 or higher.

4. (Optional) Upload the iWD Installation Packages in GAX.
Optionally you can upload all the iWD installation packages (IPs)
now. See Uploading IPs Using GAX. Alternatively, you can do
this on a component-by-component basis, in which case the
templates must be uploaded separately.

5. Install the iWD GAX Plugin.
In Genesys Administrator Extension, install the iWD GAX Plugin
component, which is required to complete iWD configuration.
See Install iWD GAX Plugin.

6. Install the Genesys Rules System.

Install GRS 8.5.001 or higher.

The full iWD/GRS compatibility matrix is here. Complete steps 1
to 6 (only) in the Task Summary: Installing Genesys Rules
System section of the Genesys Rules System 8.5 Deployment
Guide.

Note: Step 7 in the Task Summary is about defining the
business structure, which from release 8.5.0 is done in the iWD
GAX Plugin.

7. Install iWD Runtime Node. Install Runtime Node and associate a Person account to the iWD
Runtime Node application. Install Runtime Node.
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Objective Related procedures and actions

8. Install iWD Manager. See Install IWD Manager.

9. Create an iWD Tenant in GAX. See Creating a Tenant in GAX.

10. Create an iWD Business Solution in the iWD GAX Plug-in. See Create an iWD Business Solution in the iWD GAX
Plug-in.

11. Configure the necessary Integrated Capture Points for use
with iWD.

For background on Capture Points, see eServices Integrated
Capture Points Guide. For iWD-specific details, see Capture
Point Details.

12. Install and run the iWD Setup Utility to configure various
mandatory configuration objects. Note: Not supported from
release 8.5.104 onwards. Manual configuration is required for
later releases.

From release 8.5.0, iWD Setup Utility ships in the IP for iWD
Manager. See Install iWD Setup Utility.

13. Install iWD Stat Server Extensions. See Installing the iWD Stat Extensions.

14. Configure logging for iWD Manager and iWD Runtime Node. See Logging.

15. Update the Interaction Server databases and Event Log DAP. See Working with Task Attributes.

16. Configure remaining iWD services and objects. See the iWD GAX Plug-in Help topics.

17. Optional: Configure iWD Reporting. See iWD Reporting for details on configuring CCPulse+ for iWD
and creating CCPulse+ templates.

18. Optional: Configure Multiple Business Processes (from
release 8.5.1).

See Configuring Multiple Business Processes for details on
how to clone the iWD Business Process to create new business
processes with custom queue names.

19. Optional: Configure the system to start/stop application
server service through Genesys Solution Control Interface (SCI)
or Genesys Administrator.

20. Optional from iWD 8.5.102—Install and configure iWD Web. iWD Web allows you to upload tasks to INX/iWD directly from
spreadsheets. See Installing iWD Web for details.
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Preparing for Installation

Installation Prerequisites

Installation Prerequisites

• iWD 8.5.0 requires Genesys Administrator Extension version 8.5.000.47 or later.
• iWD 8.5.1 requires Genesys Administrator Extension 8.5.200.12 or later.
• iWD 8.5.104 further requires Eclipse in order to use the Composer version of the iWD BP.
• iWD 8.5.106 further requires ORS 8.1.400.48 to utilize the improvements in the IWD BP for Composer/

ORS.
• Tomcat web application server must be stopped. Stopping is optional for WebSphere Application Server.
• A supported web application server, such as Tomcat or WebSphere, must be installed on the

computer(s) on which iWD will be installed. For production deployments, install the iWD web
applications and the Genesys Rules System web applications on separate instances of the application
server.

• A supported database server must be installed, with the database created and accessible for both the
iWD Data Mart and the iWD configuration database.

• The following are required:
• OpenJRE 7 for Linux
• IBM JDK 7 for Websphere
• IBM JDK 6 or 7 for AIX
• Oracle JRE 7 for Windows. Please see http://www.oracle.com/technetwork/java/javase/downloads/

index.html and should be moved to Windows bullet.

• For customers using Tomcat, Genesys only supports Java JDK 7—Java 6 is no longer supported. Java SDK
can be downloaded from http://java.sun.com/javase/downloads/index.jsp

• Microsoft C++ Redistributable 2010 package is required for iWD Runtime Node to start correctly.

Important
Refer to the Genesys Supported Operating Environment Reference Manual for
supported platforms, Java application servers and database servers.
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Support for RHEL 64-bit Platforms

Installers support installation of Red Hat Linux 64-bit platforms only when RHEL standard
compatibility packs for 32-bit platforms have been installed. These packages have generic names
like:

• compat-glibc*

• compat-libstdc++*

• libstdc++* '

You might also need to ensure that the JAVA_HOME variable points to the correct JDK.

iWD DVD

This DVD contains the following components:

• iWD Runtime Node—Runs scheduled iWD Data Mart services.
• iWD Manager—A graphical user interface (GUI). iWD Manager is used for real-time management of

tasks. In 8.5.0+ it also contains iWD Setup Utility, which is an XML file containing iWD-specific
configuration and setup information.

• iWD GAX Plugin—Business configuration of the iWD solution.
• iWD Stat Extensions—Stat Server Java Extensions that provide Stat Server clients, such as CCPulse+,

the ability to request and display current-day statistics from iWD’s Data Mart.
• iWD Web—A web-based, easy-to-deploy workload management solution.

Configuration of Application Servers

It is necessary to configure your application server to successfully run iWD and the Genesys Rules
System. Apache Tomcat and IBM WebSphere are supported.

Important
For production deployments, install the iWD web applications and the Genesys Rules
System web applications as separate application server instances, for improved
scalability and memory management.

Installing on Tomcat
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Installing on Tomcat

If Tomcat is running as Windows service:

Add the following Java options to the Tomcat service configuration:

-XX:MaxPermSize=128m

-Dcom.genesyslab.platform.commons.connection.factory.class=com.
genesyslab.platform.commons.connection.impl.netty.NettyConnectionFactory

For iWD Manager, configure the initial and maximum memory pools to 256 and 1536 megabytes.

If Tomcat is running as Windows console application:

Add the following to the setenv.bat file:

set JAVA_OPTS=-XX:MaxPermSize=128m -Xms256M -Xmx1536M
-Dcom.genesyslab.platform.commons.connection.factory.class=com.
genesyslab.platform.commons.connection.impl.netty.NettyConnectionFactory

On UNIX machines:

Edit the setenv.sh file and add the following:

export JAVA_OPTS="-XX:MaxPermSize=128m -Xms256M -Xmx1536M
-Dcom.genesyslab.platform.commons.connection.factory.class=com.
genesyslab.platform.commons.connection.impl.netty.NettyConnectionFactory”

setenv.sh and setenv.bat files:

By default, setenv.sh and setenv.bat files are not present after the installation of Tomcat, so you
need to create them manually under the Tomcat_installation/bin directory and correctly configure
the access rights on UNIX machines properly for these files.

Installing on WebSphere
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Installing on WebSphere

1. Log in to the WebSphere Integrated Solution Console.
2. Select Servers > Application Servers and select a server from the list.
3. Then continue to > Server Infrastructure, Java and Process Management

> Process Definition > Java Virtual Machine.

4. In Generic JVM Arguments, add these settings, if not present: -XX:MaxPermSize=128m
-Dcom.genesyslab.platform.commons.connection.factory.class=com.
genesyslab.platform.commons.connection.impl.netty.NettyConnectionFactory

5. Configure the initial and maximum heap size, using the same guidelines as for Tomcat.
6. If installing on WebSphere 7.0 or later, add this Generic JVM parameter:

-Dorg.ajax4jsf.cache.CacheFactory=org.ajax4jsf.cache.OSCacheCacheFactory

7. Restart the application server.

Installing as Standalone Application

Installing as Standalone Application

An embedded webserver can also be deployed as a standalone application. In this case it would not
need any other application servers such as Tomcat or WebSphere.

On Windows

To deploy on Windows, find the following files:

• JavaServerStarter.exe—This is the executable binary that is used in Windows service definition and is
used to launch the application defined in the JavaServerStarter.ini file.

• JavaServerStarter.ini—This is a configuration file that allows you to define the application and its
starting options. Because iWD depends on Java you can define Java options here. For example;

[Service]
AppTitle="Genesys iWD Data Mart"
AppVersion=8.5.106.04
JVMPath=JRE_PATH\bin\server\jvm.dll
MainClass=evo/main/NodeLauncher
EventHandlerMethod=stopNode

[JavaArgs]
-Xms256m
-Xmx1536m
-XX:MaxPermSize=128m
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[Djava.class.path]
iwd_node.jar

On UNIX

On UNIX there are no JavaServerStarter files. The application uses a regular script, for example;
iwd_runtime.sh, where Java with its optional arguments is explicitly called. Then you can simply use
following example:

JAVA_JRE -XX:MaxPermSize=128m -Xms256M -Xmx1536M -host Configuration Server Host -port
Configuration Server Port -app Application_Name

Important
Since support for the 64-bit UNIX was added, you can define more than 1.5GB for the
Xmx parameter. For example, Genesys recommends 12GB for the Runtime Node
application.
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Interaction Server Configuration
Interaction Server is required for iWD 8.5. If you are an existing eServices customer, and Interaction
Server and its databases are already installed and configured for your environment, you can proceed
with installing the iWD Runtime Node (Windows). Otherwise, please install Interaction Server by using
the procedures in the e-Services Deployment Guide.

A Multimedia Switching Office and Multimedia Switch must be created in Genesys Configuration
Database, to support Stat Server and URS operations. Refer to the eServices 8.1 Deployment Guide
for more details on these topics.

completed-queues

There is a specific Interaction Server configuration option named completed-queues that specifies a
list of queues for completed interactions. When an interaction is placed into one of these queues, the
CompletedAt timestamp is set for that interaction. This is also the timestamp that will be used to
calculate the Age of the interaction that is displayed on the Global Task List. This option, if it is not
already present, will be added for you automatically by using the Configure Ixn Custom
Properties feature of iWD Manager. However, this will only add the iWD_Completed queue to the
option. You might want to add other queues to this option, based on how you want this Age to be
calculated. For example:

• When using the iWDBP for IRD you may wish to set it to: iWD_Completed, iWD_Canceled,
iWD_Rejected

• When using the iWDBP for Composer you may wish to set it to: iwd_bp_comp.Main.iWD_Completed,
iwd_bp_comp.Main.iWD_Canceled, iwd_bp_comp.Main.iWD_Rejected

• Section: settings
• Option name: completed-queues
• Valid Values: Comma-separated list of queue names

enable-revoke-from-agent

Starting with Interaction Server 8.1.2, a configuration option, enable-revoke-from-agent, has been
provided to support enhancements to task management in the Global Task List. Specifically, this
option allows an Assigned interaction to be revoked from an employee desktop when the interaction
is put on hold, canceled, or completed, from the Global Task List or through an iWD capture point.
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Installing the iWD GAX Plugin
iWD GAX Plugin is installed in the GAX standard way - the procedure is described here (opens a new
document).

Important
Before any install of the GAX Plug-in, if you have installed it previously you must
perform the removal procedure below to ensure a clean installation.

Notes on Localization

• The base GAX application and its plugins (including iWD GAX plug-in) are not fully separated with their
localization.

• All localization packages of all supported plugins and the GAX base localization package should be
installed together.

• All installed localization packages should contain the same set of languages.

Note on Removing the iWD GAX Plug-in

Important
If you perform the GAX Plug-in removal procedure for the iWD GAX Plug-in, you
need to make sure that following files have been deleted (if you are working on
Windows, some of these files might be already removed by the generic Windows
uninstaller):

• <GAX_HOME>/webapp/WEB-INF/lib/gax-iwd.jar file
• <GAX_HOME>/plug-ins/gax-iwd.jar file
• <GAX_HOME>/webapp/plugins/gax-iwd directory
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Note on Installing/Removing Language Pack Plug-ins

Important
Before you perform the Installing Language Packs procedure for any iWD GAX
Plug-in language upgrade or after you perform the GAX Plug-in removal
procedure procedure for Language Pack removal, you need to make sure that
following files have been deleted:

• <GAX_HOME>/webapp/WEB-INF/lib/gax-iwd-lp-<lang-build>.jar (for example, gax-
iwd-lp-de-de-8.5.100.02.jar file -this should be removed by iWD GAX language
pack uninstaller).

• <GAX_HOME>/plug-ins/gax-iwd-lp-<lang-build>.jar (for example, gax-iwd-lp-de-
de-8.5.100.02.jar file).

• <GAX_HOME>/webapp/plugins/gax-iwd-lp-<lang> (for example, gax-iwd-lp-de-de
directory).

Upgrading Plug-ins from 8.5.0 to 8.5.1+

To upgrade any plug-in, you need to follow the instructions above to remove the old plug-in, then
install the new one.
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Uploading IPs Using GAX
Once you have installed the GAX, you can (optional at this stage—you can do this on a component-
by-component basis) upload the relevant IPs that are required for the configuration process.

Click here (new document) for the GAX IP Upload Procedure.
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Integration with Genesys Rules System and
Universal Contact Server

Important
There is a separate document dedicated to how Genesys Rules System
interoperates with iWD.

Installing Genesys Rules System for Use with iWD

For production deployments, install the Genesys Rules System web applications (Genesys Rules
Engine and the Genesys Rules Authoring Tool) on a dedicated application server instance, apart from
the application server instance that is dedicated to the iWD web applications.

Important
To install Genesys Rules System for use with iWD, complete steps 1 to 6 of the GRS
Installation Task Summary. Step 7 of the Task Summary is not required. For iWD
installations, you will create the business structure in the iWD GAX Plugin.

Creating the Connection to Interaction Server

Create a connection by using the Connections tab in the Interaction Server Application to the
Genesys Rules Engine application. If GRE is configured as a cluster, add the GRE_Cluster application
on the Connections tab instead of the Genesys Rules Engine application.

Configuring Universal Contact Server (UCS)

Important
Use of iWD Setup Utility is no longer supported from iWD release 8.5.104.
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Configuring UCS is optional. However, if you provide any UCS name during the process of setup using
iWD Setup Utility, then a dedicated mapping is created inside the Iwd_Esp_List transaction object
content—and if iWD Manager does not have that UCS application in its connections, an alarm will be
generated.

GRE Cluster Additional Steps

iWD Setup Utility has never supported GRE cluster configuration. If you want to use GRE clusters you
must correct the transaction object content of Iwd_Esp_List. Instead of using a particular GRE
application name you need to add the GRE cluster application name attached to your solution. Then
this name will be used by the iWD Business Process—for example, by the sub-strategy invoke_GRE.
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Installing Runtime Node
This section describes the procedures that are used to install iWD Runtime Node.

Prerequisites

Prerequisites

The iWD Runtime Node must be installed as a standalone Java application server before it can run
iWD services. When deploying services for multiple solutions, each solution should have its own
dedicated Runtime Node and the installation procedure must be repeated for each of them.

• The environment meets the requirements that are described in Installation Prerequisites
• The computer on which the iWD Runtime Node is going to be installed has network access to the

computer that is hosting Genesys Configuration Server, Interaction Server and Message Server
databases.

• You have access rights to execute install.sh or setup.exe, depending on the operating system.
• For upgrades from 8.5.0 to 8.5.1+:

• iWD Runtime Node is stopped.
• The previous version of iWD Runtime Node is uninstalled.

Important
Genesys recommends 12GB memory for the Runtime Node application.

On Windows
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On Windows

Purpose

To install the iWD Runtime Node application on the Windows platform.

Summary

Installation of iWD Runtime Node saves the required database scripts and Kettle files in the working
directory. For more information about the database go to the Create the Data Mart Database tab. The
current procedure assumes that the application already exists in Configuration Server. If not, see the
required steps in the iWD Runtime Node Application Definition tab.

Important
If you are upgrading, ensure that you have uninstalled the previous version and
proceed with the current installation procedure. Also make sure not to skip the
Application Definition step, because new versions might deliver new options.

Procedure

1. Locate and double-click setup.exe in the iWD Runtime Node directory of the iWD DVD.
2. The iWD Runtime Node Installation Wizard opens. Click Next in the Welcome screen.
3. In the Connection Parameters to the Configuration Server screen, enter the login details to connect

to Genesys Configuration Server and then click Next:
• Host name—The host of Genesys Configuration Server
• Port—The port that is used by Genesys Configuration Server
• User name—The user name of the Person (or User) as defined in Genesys Configuration Manager or

Genesys Administrator.
• Password—The password that is associated with the Person (or User).

4. Select application from proposed list. Those selection will provide details for rest of dialog.
5. Click Next.
6. The installer suggests an installation path. Change it if needed, then accept by clicking Next'.
7. In the Ready to Install screen, click Install to begin the installation of iWD Runtime Node.
8. When installation has been completed, click Finish.
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9. The installed JavaServerStarter.ini file should not require any updates but you can review it.
10. The appropriate Windows service should be created and should appear on the list of Windows services.

This allows you to start/stop it.
11. Turn on any of the plug-ins by editing the plugins.properties file, or install localization if needed.
12. Start the iWD Runtime Node Windows service

End of procedure

On UNIX

On Unix

Purpose

To install the iWD Runtime Node application on the UNIX platform.

Summary

Installation of iWD Runtime Node saves the required database scripts and Kettle files in the working
directory. For more information about the database go to the Create the Data Mart Database tab. The
current procedure assumes that application already exists in Configuration Server. If this is not the
case, follow the required steps in the iWD Runtime Node Application Definition tab.

Important
If you are upgrading, ensure that you have uninstalled the previous version and
proceed with the current installation procedure. Also make sure not to skip the
Application Definition step, because new versions might deliver new options.

Procedure

1. As the iWD Runtime Node user, browse to the install directory and enter ./install.sh.
2. When the following output is displayed, enter the required information, as indicated at each prompt.
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**************************************************
* Welcome to the Genesys 8.5 Installation Script *
**************************************************

Installing iWD Runtime Node, version 8.5.XXX.XX

Please enter the hostname or press enter for "HOSTNAME" =>

Please enter the following information about your Configuration Server:

Configuration Server Hostname =>CONFIGURATION_SERVER_HOSTNAME
Network port =>CONFIGURATION_SERVER_PORT
User name =>CONFIGURATION_SERVER_USERNAME
Password =>CONFIGURATION_SERVER_PASSWORD

Please choose which application to install:
1 : iWD_Runtime_Node
=>1

Please enter full path of the destination directory for installation =>/YOUR_PATH/iwd/
YOUR_APP_NAME/

Extracting tarfile: data.tar.gz to directory: /YOUR_PATH/iwd/YOUR_APP_NAME/
...
etl/
etl/kettle_mssql.properties
etl/aggregate_intraday.kjb
etl/kettle_mysql.properties
etl/plugins/
etl/plugins/queue/
...
etl/plugins/plugins.properties
...
iWD_Data_Mart_Service_Script.sh
iWD_Runtime.sh
iwd_node.jar
lib/
...
sql_scripts/
sql_scripts/mssql/
sql_scripts/mssql/iwd_dm_mssql.sql
sql_scripts/oracle/
sql_scripts/oracle/iwd_dm_oracle.sql

Installation of iWD Runtime Node, version 8.5.XXX.XX has completed successfully.

3. Turn on any of the plug-ins by editing the plugins.properties file, or install localization if needed.
4. Review and make changes, if needed, to the any files iWD_Runtime.sh (since 8.5.106.03

iwd_runtime.sh or iWD_Runtime_Service.sh), for example, providing flags to Java. White characters
(such as spaces) are not supported in the script variables—for example, DM_APPL=iWD Runtime Node is
illegal.

Important
Please note that the path must be provided in the application configuration.

5. Start the iWD Runtime Node process.
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iWD Runtime Node Application Definition

Procedure

1. Log into Genesys Administrator or GAX and import the iWD Runtime Node Application template from the
iWD DVD.

2. Create a new Application object based on the template. For upgrades from 8.5.0 to 8.5.1 you can
either create a new application in place of the previous one or simply update the application by using
the new template. To begin the Create procedure, navigate to Configuration > Environment >
Applications and click New.

3. On the General tab:
a. Enter your chosen name, for example, iWDRuntimeSolutionName. Using spaces is not

recommended.
b. Select the application Template—Use type Third Party Server for releases 8.5.100.xx and

8.5.101.xx and type iWD Runtime Node for 8.5.102+.
c. Version, Tenant and Is Application Server boxes are pre-selected according to the template

type.
d. Fill in fields Working Directory, Command Line and Command Line Arguments per the

example below:
Attribute name Windows Unix

Working Directory C:\Program Files (x86)\GCTI\
iWD Runtime Node

/IWD_APP_PATH/
iWDRuntimeNode/

Command Line JavaServerStarter.exe /INIT_PATH/iwd_runtime.sh

Command Line Arguments
-host YOUR_CFG_SRV_HOST
-port YOUR_CFG_SRV_PORT
-app YOUR_APP_NAME -service
YOUR_SERVICE_NAME

start

e. Choose the host where the application will run.
Optional fields

f. Certificate—The security certificate value. In Windows, select the certificate value from the list of
installed certificates. In UNIX, enter the full path to the <serial_#>_<host_name>_cert.pem file.

g. Certificate Description—An optional description of the Certificate.
h. Certificate Key—The full path to the <serial_#>_<host_name>_priv_key.pem file of the

security certificate key. This field is used only if Genesys Security is deployed on UNIX; otherwise
this field is empty.

i. State Enabled— If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

j. Login As Account— Select a user account that has full access to the relevant Tenant, and to both
Applications and Applications Templates. These fields are displayed after the application is created.
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Important
The Load Config service will need to read certain settings from your Tenant and parent tenant (if the latter
exists). For example, it needs to have read permission to all applications involved in the Solution,
including Capture Points and their application templates. The Statistics Adapter service will need to
update the options in Stat Server application, and it does this through the iWD Runtime Node application
that has been configured in Configuration Server. For this reason iWD Runtime Node should be configured
so that it can make the required changes to the Stat Server application on behalf of a user with
appropriate security permissions.

4. On the Connections tab, add:
a. A Data Mart DAP to point at the database that will be used.
b. Only in releases prior to 8.5.102—A Message Server to provide current information about the

iWD Solution. Solution data will be collected via the Message Server DAP. Please also note there are
two types of connection for DAP (default and jdbc) and they require different configuration as
follows:

DAP: connection
types Database DBMS Name Database Name

default

MSSQL

The database server
name.

The message server
database name.

Oracle

The message server
database SID or the
net service name as
specified in the
tnsnames.ora file.

DB2 The message server
database name.

The database server
name.

PostgreSQL Not supported

jdbc

MSSQL

N/A

The message server
database name.

Oracle

The message server
database SID or the
net service name as
specified in the
tnsnames.ora file.

DB2 The database server
name.

PostgreSQL Not supported

5. On the Ports tab lists add a new port that will be used to communicate between the GAX Datamart
Dashboard and iWD Runtime Node. The value of ID should be webservice and have the setup protocol
http.

6. On the Tenants tab choose only one Tenant where your solution is located.
7. Ignore the Options tab.
8. Ignore the Application Options tab.
9. Click Save to save the Application object.
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If you have re-created the iWD Runtime Node application you should go to GAX > Configuration >
Datamart section to confirm that the selected application for your solution is correct and has a
suitable configuration.

Important
Any changes made to application settings require iWD Runtime Node restart in order
to be applied.

Create the Data Mart Database

Create the Data Mart Database

• For information about Genesys Interactive Insights (GI2) for iWD, see the GI2 8.0 guides. The
functionality in GI2 8.0 is the same as in GI2 8.1—however GI2 8.0 for iWD is powered by SAP BO XI 3.1,
whereas GI2 8.1 for iWD is powered by SAP BI 4.1.

• If you will be using the Genesys Interactive Insights for the iWD product for historical reporting based on
the iWD Data Mart, you must enable several aggregates that are not enabled by default. Please see the
Reading iWD Aggregation section of the Interactive Insights 8.0 Deployment Guide.

This is a general procedure. Work with your enterprise’s database administrator to follow the specific
procedure that is required by your database management system and your enterprise policies.

Prerequisites

• iWD Runtime Node must be installed
• A Database Access Point (DAP) application with connection type JDBC needs to created

Important
Remember to set up the port in that DAP to the value of the database server port—for
example, for MSSQL the default port is 1433. This number needs to be set up as the
port in the DAP configuration.
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Procedure

1. Ensure that the database server is running.
2. Log on to the database server’s administrative interface (such as Oracle Enterprise Manager).
3. Create a new database user account (for example, iwddatamartuser).
4. Create a new database (for example, iwddatamartdb).
5. Ensure that there is a user, who has access to the Data Mart database, who has the following

permissions:

• CREATE TABLE

• CREAT INDEX

• CREATE VIEW

• CREATE TRIGGER (Oracle)
• CREATE SEQUENCE (Oracle)

• The iWD Data Mart database will be initialized automatically the first time the Database Service and Kettle
ETL Service are started. If the Database Service’s Auto Sync option is selected, this initialization is
automatic, and the Database Service will also check for updates to the iWD Data Mart database whenever a
new version of iWD Data Mart is installed. The Auto Sync option will also initialize ETL plug-ins.

Important
You can find the Auto Sync option by following this path: GAX (with iWD plugin installed) -> Configuration ->
Datamart -> YOUR_SOLUTION -> Database. Any changes to these options require iWD Runtime Node to be
restarted take effect.

Add Configuration Server Audit Logging

Add Configuration Server Audit Logging

Important
This section applies only to iWD releases 8.5.102 and later.

Use the following steps to configure a Configuration Server DAP and use it in Data Mart.
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Important
Before release 8.5.102, Data Mart required Message Server for audit logs. This is no
longer required.

Prerequisites

• iWD Runtime Node must be installed.
• All audit events from GAX's Message Server or Message Server dedicated to iWD have been processed

by iWD Data Mart—for example, no modifications of either Capture Points or Business Structure have
taken place since Data Mart's last successful Load Config job.

• No Data Mart jobs are running.
• iWD Runtime Node is stopped.

Procedure

1. Using Configuration Manager, create an audit folder:
a. Create the iWD Audit configuration unit (folder) under the Environment tenant.
b. Grant Full Control permission to the SYSTEM user.

2. Create a Configuration Server DAP using GAX:
a. Navigate to Configuration > Applications.
b. Click the New button to create a new application.
c. Configure the DAP as follows:

• Name—Enter the name; for example, confserv_DAP.
• Template—Select the correct template; for example, Database_Access_Point_xxx.
• Host—Select the Configuration Server host.
• Connection type—Select JDBC.
• DBMS Type—Select the type of the Configuration Server database.
• Database Name—Enter the database name
• Username—Enter the database username
• Password—Enter the database password

d. On the Application Options tab, add:
• A new section called iWD containing the role configuration option set to value cfgserver.
• A new section called jdbc with option url. The value of the url option should be a valid JDBC URL
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pointing to the Configuration Server database—for example:
• jdbc:evo:oracle:@//oracle.example.com:1521/CONFIG

• jdbc:postgresql://psql.example.com/DB

• jdbc:sqlserver://mssql.example.com:1433;databaseName=cfg

Important
The jdbc section with the url option is mandatory for the DB2 database engine. It is optional when
Configuration Server database is located on Oracle, MS SQL or PostgreSQL.

For Configuration Server running on DB2, the following additional parameters need to be appended to the JDBC
connection string:

jdbc:db2://db2.example.com:5021/DB:driverType=4;
fullyMaterializeLobData=true;fullyMaterializeInputStreams=true;

progressiveStreaming=2;progressiveLocators=2;

e. Click Apply.

3. Configure Data Mart:
a. Navigate to Configuration > iWD > Datamart.
b. Open the General tab and select the Configuration Server DAP in the Configuration Server DAP

option.
c. Click Save.

Post-Procedure Steps

1. Start iWD Runtime Node.

Add Dedicated/Shared Audit Logging

Add Dedicated/Shared Audit Logging

Important
This section applies only to iWD releases before 8.5.102. In iWD releases 8.5.102 and

Installation Installing Runtime Node

iWD Deployment Guide 56



later use Configuring Data Mart Logging.

Important
By default iWD GAX Plug-in uses GAX Message Server for auditing. However, as the
amount of audit message data generated by other Genesys applications can be huge,
for better Data Mart performance Genesys highly recommends configuring a Message
Server dedicated to iWD.

Prerequisites

• iWD Runtime Node must be installed.
• A Message Server dedicated to iWD is installed, configured to work with the database via DAP, and is

running.

Important
From release 8.5.1, Runtime Node supports both connection types for DAPs in
Messages Server: default and JDBC

• A corresponding Message Server application is created and configured in the Genesys configuration
environment.

• All audit events from GAX's Message Server have been processed by iWD Data Mart—for example, no
modifications of either Capture Points or Business Structure have taken place since Data Mart's last
successful Load Config job.

• No Data Mart jobs are running.
• iWD Runtime Node is stopped.

Add a Message Server Dedicated to iWD

1. Navigate to Configuration > Applications.
2. Select the GAX application (of type Genesys Administrator Server).
3. Click on the Connections tab to open it.
4. Verify that only GAX's Message Server is displayed.
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5. Click the Add button.
6. For the Server, choose the Message Server dedicated to iWD.
7. Click OK to add the new Message Server to the GAX application and close the window.
8. Verify that the newly added Message Server is on the list in the Connections tab.
9. Click Save.

10. Navigate to Configuration > Applications.
11. Select the Message Server dedicated to iWD.
12. On the Application Options tab, add the role key in the GAX section with value of datamart.
13. Click Save.
14. Navigate to Configuration > Applications.
15. Select GAX's Message Server.
16. On the Application Options tab, add role key in the GAX section with value of gax.
17. Navigate to Configuration > Applications.
18. Select the iWD Runtime Node application.
19. Click on the Connections tab to open it.
20. Verify that only Message Server dedicated to iWD is displayed. If not then remove other Message

Servers (check the check box next to the Message Server and click Remove.)
21. If Message Server dedicated to iWD is not added than:

• Click the Add button.
• For the Server, choose the Message Server dedicated to iWD.
• Click OK to add the new Message Server to the GAX application and close the window.

22. Click Save.

Remove a Message Server Dedicated to iWD

1. Navigate to Configuration > Applications.
2. Select the GAX application (of type Genesys Administrator Server).
3. Click on the Connections tab to open it.
4. Verify that there are two Message Servers—one for GAX and one for iWD.
5. Check the check box next to the iWD Message Server and click Remove.
6. Click Save.
7. Configure GAX's Message Server according to GAX Configuring the Auditing Feature (new

document).
• Navigate to Configuration > Applications.
• Select GAX's Message Server.
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• On the Application Options tab, remove role key in the GAX section with value of gax.
• Click Save.

8. Navigate to Configuration > Applications.
9. Select the iWD Runtime Node application

10. Click on the Connections tab to open it.
11. Remove Message Server dedicated to iWD

• Check the check box next to the Message Server and click Remove.

12. Add GAX's Message Server.
• Click the Add button.
• For the Server, choose the GAX's Message Server.
• Click OK to add the GAX's Message Server to the iWD Node application and close the window.

13. Click Save.

Post-procedure steps

1. Restart GAX.
2. Start iWD Runtime Node.
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Installing IWD Manager

Prerequisites

Prerequisites

• The environment meets the requirements that are described in Installation Prerequisites

• The computer on which the iWD Manager is going to be installed has network access to the
computer that is hosting Genesys Configuration Server. Users of iWD Manager will be
authenticated through Genesys Configuration Server.

• You have access rights to execute install.sh or setup.exe, depending on the operating system.
• For upgrades from 8.5.0 to 8.5.1+:

• The servlet container (for example, Tomcat) is stopped.
• The previous version of iWD Manager is uninstalled—the iwd_manager directory from the web

server is removed.

On Windows

On Windows

Prerequisites

• Installation Packages have been installed.

Purpose

To install the iWD Manager application on the Windows platform.
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Summary

Installation of iWD Manager saves the required database scripts in the working directory. These
scripts must be run against the iWD Configuration database and the Interaction Server database. iWD
Manager does this automatically after a user's successful login and authentication, when it detects a
different database schema than expected. For Iteration Server synchronization, there is a dedicated
option Configure Ixn Custom Properties in iWD Manager. The current procedure assumes that the
application already exists in Configuration Server—the required steps are described in iWD Manager
Application Definition.

Important
If you are upgrading, ensure that you have uninstalled the previous version and
proceed with the current installation procedure. Also make sure not to skip the
Application Definition step, because new versions might deliver new options.

Procedure

1. Locate and double-click setup.exe in the iWD Manager directory eg. of the iWD DVD.
2. The iWD Manager Installation Wizard opens. Click Next in the Welcome screen.
3. Select the web container (for example, Tomcat or WebSphere) and click Next.
4. If you selected WebSphere in Step 7, select the appropriate JDK from the list.

Important
This is not the JDK which will be used by WebSphere. This is necessary to properly configure the scripts which
will be used to build the WAR archive.

5. If you selected Apache Tomcat in Step 7, browse to the Home directory for your Apache Tomcat
installation (for example, C:\ProgramFiles\Apache\Tomcat7\). The iWD Manager components will be
installed in the selected directory, under the webapps/ subdirectory.

6. Click Next.
7. In the Connection Parameters to the Configuration Server screen, enter the login details to connect

to Genesys Configuration Server and then click Next:
• Host name—The host of Genesys Configuration Server
• Port—The port that is used by Genesys Configuration Server
• User name—The user name of the Person (or User) as defined in Genesys Configuration Manager or

Genesys Administrator.
• Password—The password that is associated with the Person (or User).
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8. (Post-8.5.101.03 only) From the list of available choices, choose the iWD Manager application that you
want to install and click Next.

9. Choose the destination location for iWD Manager. If you selected Websphere in Step 7, both supporting
files and iWD Manager Java application part will be installed in that location. If you selected Tomcat in
Step 7, only supporting files for iWD Manager will be installation in that location. The iWD Manager web
application will be installed directly into the webapps folder under your Tomcat home directory.

10. Click Next.
11. Select the database type that will be used by the iWD Configuration database.
12. Enter the parameters that are used to connect to the iWD Configuration database in the next screen.

Enter the following information:
• DB Server Host—The name of the computer on which the database is located.
• Database Name—The name of the iWD Configuration database.
• User Name—The name of the user that is used to connect to the database.
• Password—The password that is used to connect to the database.

13. Click Next.
14. Enter the host name and port of the computer on which the backup Genesys Configuration Server is

running. If there is no backup Configuration Server in your environment, specify the primary
Configuration Server host and port. Click Next.

15. In the Ready to Install screen, click Install to begin the installation of iWD Manager.
16. When installation has been completed, click Finish.
17. Perform any optional steps or install localization if needed.

For WebSphere configuration after installation of iWD Manager, build the WAR archive as described in
Post-Installation Steps For WebSphere and install the generated WAR file by using the WebSphere
Integrated Solutions Console.

End of procedure

On UNIX

On Unix

Prerequisites

• Installation Packages have been installed.
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Purpose

To install the iWD Manager application on the UNIX platform.

Summary

Installation of iWD Manager saves the required database scripts in the working directory. These
scripts must be run against the iWD Configuration database and the Interaction Server database. iWD
Manager does this automatically after a user's successful authentication in the login every time that
it detects a different database schema than expected. For Interation Server synchronization there is a
dedicated option Configure Ixn Custom Properties. The current procedure assumes that the
application already exists in Configuration Server—the required steps are described in iWD Manager
Application Definition.

Important
If you are upgrading, ensure that you have uninstalled the previous version and
proceed with the current installation procedure. Also make sure not to skip the
Application Definition step, because new versions might deliver new options.

Procedure

1. Locate the install directory and enter ./install.sh.
2. When the following output is displayed, enter the required information, as indicated at each prompt.

Important
In this procedure Websphere is selected for the servlet container. When asked to provide the destination
directory, enter an arbitrary location. iWD Manager Java application and supporting files will be installed in
this directory.

Othercase you can select Tomcat option. Then you will be asked additionally for you tomcat installation path: Please enter the full
path to your Tomcat installation

And java application will be installed directly into Tomcat as iwd_manager and rest of supporting files in
location that you provided.

**************************************************
* Welcome to the Genesys 8.5 Installation Script *
**************************************************

Installing iWD Manager, version 8.5.101.XX

Installation Installing IWD Manager

iWD Deployment Guide 63

https://docs.genesys.com/Documentation/IWD/DRAFT851/Dep/IWDManagerInstall#t-4
https://docs.genesys.com/Documentation/IWD/DRAFT851/Dep/IWDManagerInstall#t-4


Please select your servlet container type by number:
1. Tomcat
2. WebSphere
=>1

Please specify the type of used Database Server:
1) MS SQL Server
2) Oracle Server
=>2

Please enter the Database Server hostname or IP address =>X.X.X.X

Please enter the Database name =>XE

Please enter the Database Server user name =>iWD

Please specify the Database Server user password =>

Please enter the Configuration Server Host Name =>X.X.X.X

Please enter the Configuration Server Port =>2020

Please enter the Configuration Server Backup Host Name =>X.X.X.X

Please enter the Configuration Server Backup Port =>2020

Please enter the Configuration Server Application Name =>iWD Manager (Note:
Post-8.5.101.03 only)

Please enter full path of the destination directory for installation =>/var/iwd85/manager

Extracting tarfile: data.tar.gz to directory: /var/iwd85/manager
...
webapp/
...
webapp/WEB-INF/
webapp/WEB-INF/application.properties
webapp/WEB-INF/web.xml
webapp/WEB-INF/faces-config.xml
webapp/WEB-INF/lib/
webapp/WEB-INF/lib/hibernate.jar
webapp/WEB-INF/lib/packagedstatisticsdeprecated.jar
webapp/WEB-INF/lib/commons-lang.jar
webapp/WEB-INF/lib/commons-logging.jar
...
webapp/META-INF/MANIFEST.MF

Installation of iWD Manager, version 8.5.XXX.XX has completed successfully.

3. Perform any optional steps or install localization if needed.

For WebSphere configuration after installation of iWD Manager, build the WAR archive as described in
Post-Installation Steps For WebSphere and install the generated WAR file by using the WebSphere
Integrated Solutions Console.

iWD Manager Application Definition
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Procedure

1. Log into Genesys Administrator or GAX and import the iWD Manager Application template eg. from the
iWD DVD. Since 8.5.0, the iWD Manager template also includes privileges. Double-check to see whether
metadata were correctly imported. This is important for definition of roles in Genesys Administrator. For
GAX, importing the IP automatically also imports privileges. In that case, metadata are options since
you would manage roles using GAX in those circumstances.

2. Create a new Application object based on the template. For upgrades from 8.5.0 to 8.5.1 you can
either create a new application in place of the previous one or simply update the application by using
the new template. As for second option be careful with privileges part.

Important
The must be only one iWD Manager application on the Configuration Server. Additional ones will be ignored.

3. To begin create procedure navigate to Configuration > Environment > Applications and click New.
4. On the General tab:

a. Enter a name for the iWD Manager.
b. Select the application Template—This must of type iWD Manager.
c. Version, Tenant and Is Application Server boxes are pre-selected according to the template

type.
d. State Enabled—If selected, indicates that the object is in regular operating condition and can be

used without any restrictions.

5. On the Connections tab, add the connections to the Interaction Server and to Universal Contact Server
(UCS) that your iWD Solution will use. If you need to:
a. Add the Port ID on the Interaction Server that iWD Manager will connect to.
b. Specify the Connection Protocol: simple or addp.
c. Specify the Local Timeout and the Remote Timeout—These values are required only if you

specified addp in Connection Protocol. This value specifies the heartbeat polling interval, measured
in seconds, on a client side. This indicates how often the client application sends polling signals to
the server application. To enable this functionality, specify any integer as the value.

d. Specify a Trace Mode—The connection trace mode used between a server and its client.

• Trace Is Turned Off—Select if you do not want either the client or the server application to print
ADDP-related messages in its log.

• Trace On Client Side—Select if you want the client application to print ADDP-related messages in
its log.

• Trace On Server Side—Select if you want the server application to print ADDP-related messages
in its log.

• Trace On Both Sides—Select if you want both the client and server applications to print ADDP-
related messages in their log.

6. Specify Transport Protocol Paramters—Any text, usually key=value pairs, separated by a semicolon
(;). This property is application-specific.
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7. Specify Application Parameters—Any text, usually key=value pairs, separated by a semicolon (;).
This property is application-specific.

• The Ports tab lists communication ports used by the clients of an application to connect to a server. To
support specific high-availability configurations, more than one server can be registered on the same port
within the same host. Otherwise, do not assign the port number to any other server on the same host. Click
Add to add a connection.

• Ignore the Options tab.
• Ignore the Application Options tab.
• Click Save to save the Application object.

Additional Configuration for Database Cluster Solutions

Additional Configuration for Oracle RAC and MS SQL

After a standard installation of iWD Manager, you must do one of the following to correctly configure
iWD Manager for either Oracle RAC or MS SQL clusters:

• Edit the iwd.properties file

1. Edit the iWD Manager configuration file (iwd.properties) and replace the iwd.configDatabase.url
property value with a valid JDBC URL for either Oracle RAC or MS SQL.

2. Start iWD Manager.

See also here for differences between the Oracle RAC SCAN-on and SCAN-off URLs.

Post-Installation Steps for WebSphere

Post-Installation Steps for WebSphere

After the installation of iWD Manager it is necessary to build the WAR archives and install them into
WebSphere using Integrated Solutions Console.

Building WAR archives for iWD Manager

1. Browse to the directory which was specified during installation of iWD Manager and continue to
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subdirectory \webapps.
2. Launch the iWD_Manager.bat or iWD_Manager.sh file, depending on your operating system. This will

create the iwd_manager.war file. For example, for UNIX the following output will be displayed:
bash-3.00# cd /var/iwd85
bash-3.00# ls
manager
bash-3.00# cd manager/webapps
bash-3.00# ls
iWD_Manager.sh iwd_manager
bash-3.00# ./iWD_Manager.sh
added manifest
...
adding: ui/lib/codepress/images/line-numbers.png(in = 16556) (out=
16556)(stored 0%)
bash-3.00#

3. Log in to Websphere Integrated Solutions Console.
4. Uninstall the existing iWD Manager applications, if they are present.
5. Install iWD applications, and select the prepared WAR files when prompted.
6. When installation is completed, adjust the order of classloaders for each installed iWD application. By

default, classloader order is Parent first, then Application. iWD requires the order to be Application first,
then Parent.

7. To change the order of the classloaders, in WebSphere Integrated Solutions Console, click on
Application, click Manage Modules, click on Module (one per application), then change the
classloader order to Application, then Parent.

8. Click Save.
9. From the installed application list:

a. Click on the application.
b. Click on the [JSP and JSF options] link.

Important
When deploying on Websphere 8.x, the JSF implementation must be set to SunRI1.2 for the iwd_manager
application.

c. Select SunRI1.2 from the drop-down list.
d. Click Save.
e. Set the WebSphere cookie path to /iwd_manager with the session management override enabled.

This setting is located in iwd_manager_war> Session Management> Enable Cookies.
f. Click Save.

10. Start the application.
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Encode your database password

Encode your database password

Purpose

An optional step that allows you encrypt the database password, because it is held in configuration
files.

Procedure

A file named passwordEncoder.cmd (or passwordEncoder.sh for UNIX-based operating systems) file
is included when you install iWD Manager. This utility can be run to encode the database password
that appears in the iwd.properties file, which is located in <web application server
directory>/webapps/iwd_manager/WEB-INF/classes (the password is in plain text in the
iwd.properties file by default).

1. On Windows open command-line window (go to Start -> Run and enter cmd in the Run dialog box). On
other systems, open the console.

2. Navigate to the directory where iWD Manager has been installed (for example, cd C:\Program Files
(x86)\GCTI\iWDManager\passwordEncoder). Navigate to directory passwordEncoder.

3. Enter passwordEncoder <unencoded password> (for example, if the password is genesys you would
type in passwordEncoder genesys).

4. The command-line window will display the encoded version of the password.
5. In the iwd.properties file, replace the unencoded version of the password string with the encoded

version (iwd.configDatabase.password=).
6. Change the value of the iwd.configDatabase.passwordEncoded property to true.
7. Save the iwd.properties file.

Below are two sample files. The first shows an iwd.properties file before the password was
encoded. The example shows the same file after the password was encoded.

In order for the password encoder to work, the JRE bin directory must be added to the PATH system
environment variable for users that handle iWD Manager server. For example, if the JRE is installed in
C:\Java\jre1.7.0_45_x64 then c:\Java\jre1.7.0_45_x64\bin should be in the PATH system
environment variable.

Sample file with unencoded password

iwd.configDatabase.url=jdbc:sqlserver://iwd80vm;
databaseName=iwdmanagerdb
iwd.configDatabase.username=genesys
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iwd.configDatabase.password=genesys
iwd.configDatabase.passwordEncoded=false
iwd.configDatabase.driverClassName=
com.microsoft.sqlserver.jdbc.SQLServerDriver
iwd.configDatabase.hibernateDialect=
org.hibernate.dialect.SQLServerDialect
iwd.configDatabase.type=mssql
iwd.cfgServerHost=localhost
iwd.cfgServerPort=2020
iwd.cfgServerBackupHost=localhost
iwd.cfgServerBackupPort=2020
iwd.host=maestro_01

Sample file with encoded password

iwd.configDatabase.url=jdbc:sqlserver:
//iwd80vm;databaseName=iwdmanagerdb
iwd.configDatabase.username=genesys
iwd.configDatabase.password=********
iwd.configDatabase.passwordEncoded=true
iwd.configDatabase.driverClassName=
com.microsoft.sqlserver.jdbc.SQLServerDriver
iwd.configDatabase.hibernateDialect=
org.hibernate.dialect.SQLServerDialect
iwd.configDatabase.type=mssql
iwd.cfgServerHost=localhost
iwd.cfgServerPort=2020
iwd.cfgServerBackupHost=localhost
iwd.cfgServerBackupPort=2020
iwd.host=maestro_01.

Important
You can use other Base64 encoders to encode your password as well. These can be
found easily on the Web. One example is: http://www.motobit.com/util/
base64-decoder-encoder.asp.

End of procedure

Implementing Single Sign-On and Single Log-Out

Implementing Single Sign-On & Log-Out

To configure single sign-on (SSO), the following additional configuration is required:

1. Edit the sso.properties section and set the following properties:
• iwd.saml.enabled—Set to true

• iwd.saml_entityid—Set to a value that is unique within the SSO circle (the full URL path, for
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example)
• iwd.saml_idp_metadata—The URL from which to obtain the IDP's metadata file (a locally stored

metadata file could be used as an alternative)
• iwd.saml_sp_metadata—The path to the locally stored metadata file for the current SP (iWD

Manager). The default value is metadata/iwdmanager_sp.xml .
• iwd.saml.iwd_url—Set to the full URL of the local SP.

2. In order to confgure Single Log-Out set following attributes in the sso.properties :
• iwd.saml.sloEnabled—Set to true.
• iwd.saml.sloAppName—Set to application name.
• iwd.saml.sloRegEndpoint—Set to <activity-monitor-url>/v01/slo/registration/sp.
• iwd.saml.sloUnregEndpoint—Set to <activity-monitor-url>/v01/slo/unregistration/sp.
• iwd.saml.spSloEndpoint—Set to <iwd-manager-url>/saml/logout.
• iwd.saml.spHeartbeatHandlerEndpoint—Set to <activity-monitor-url>/v01/server/

activities.
• iwd.saml.sloLogoutUrl—Set to /saml/logout.
• iwd.saml.postLogoutUrl—Set to <hub-landing-page-url> or /ui/blank.jsf.

3. Obtain encryption keys and store them in the local keystore file. The Java keystore is managed using the
JDK keytool command. iWD needs to know the location of the keystore file, key name and passwords
which are provided using the following properties:
• iwd.saml.keystore—/security/samlKeystore.jks

• iwd.saml.keyname—iwdmanager

• iwd.saml.keypass—ChangeIt

• iwd.saml.keystorepass—ChangeIt

4. To encrypt password fields, use the passwordEncoder tool and set
iwd.saml.keystorePasswordsEncoded as follows:
• iwd.saml.keypass—********

• iwd.saml.keystorepass—********

• iwd.saml.keystorePasswordsEncoded—true

5. Generate the metadata file if it is not present:

Before 8.5.103.04
a. Set the iwd.saml.generate_metadata property to true.
b. Set the iwd.saml.iwd_url property to <iwd-manager-url>/saml/metadata. in the

iwd.properties file. In case missing of such atribute, please add it.
c. Restart iWD Manager and go to the <iwd-manager-url>/saml/metadata URL.
d. Rollback generate_matadata to false.
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After 8.5.103.04
a. Go to the <iwd-manager-url>/saml/metadata URL, no additional configuation modification is

required.
b. Save the downloaded metadata file.

6. Provide the SP's metadata file to your IDP.
7. Enable concurrent former logging to iWD Manager in the HUB environment by setting the

iwd.saml.formLoginEnabled property to true in sso.property file.

Configuring UCS over TLS (Win)

Configuring UCS over TLS (Win)

When UCS has Transport Layer Security (TLS) configured, either as a server on its ESP port, or as a
client in its connection to Message Server, there are two ways to enable it as a Windows Service:

-Log on As a Local Host User

1. Select the Windows service related to UCS.
2. Select the Log On tab. The default setting is Log on as local system account.
3. Select Log on as this account and provide the login/password of a local host user.

-Import a Certificate to the Local System Account

1. Do one of the following:
• Run psexec.exe -i -s mmc.exe, then import a certificate for a user that is the local system

account.
• Run psexec.exe -i -s certutil -f -user -p [password] -importpfx [path to the

certificate]

Important
With the flag -s, psexec.exe executes the specified program under the system
account. psexec is part of PSTools, which can be downloaded from
http://technet.microsoft.com/en-US/sysinternals
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Enabling/Disabling ADDP Connections
1. After installation, navigate in GAX to Configuration > Environment > Applications.
2. Locate the iWD Manager or Runtime Node in the list and open it.
3. Select the Connections tab and then select the server connection you want to change.
4. Open it and select addp from the Connection Protocol drop-down options.
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Creating the Tenant in GAX

Procedure

1. Navigate to GAX -> Configuration -> Environment > Tenants.
2. Click New to open a configuration page. This has three tabs: General, Options and iWD Attributes.

Two other tabs, Permissions, Dependencies appear when the Tenant is saved.
3. Enter the following information. For some fields, you can either enter the name of a value or click

Browse to select a value from a list: General tab
• Name—The name of the Tenant. You must specify a value for this property, and that value must be

unique within the Configuration Database.
• Password—A password that must be used to access this Tenant.
• Confirm Password—A confirmation of the password.
• Parent Tenant—The parent Tenant of this Tenant. By default, the parent Tenant is the Tenant in

which you are creating the new Tenant. If you change this field, the new Tenant will be created as a
new child Tenant under the specified parent Tenant. To subsequently change the parent Tenant,
refer to the Structure tab, above.

• Chargeable Number—The account number to which activities for this Tenant are charged, for cost-
tracking purposes.

• Default Contract—The default cost contract applied to resources of this Tenant. For more
information, refer to the Routing Solutions chapter of the Universal Routing 8.0 Routing Application
Configuration Guide.

• State Enabled—If selected, indicates that the object is in regular operating condition and can be
used without any restrictions.

• Ignore the Options tab.
Permissions

4. Configure user permissions for this Tenant.

Dependencies

5. Configure any Dependencies for this Tenant.

iWD Attributes

6. Configure the iWD Attributes for this Tenant.

• ID—The Tenant's runtime ID, generated automatically.
• Description of the tenant.
• Social Messaging Enabled—Check to enable social engagement integration for this Tenant.
• Rule Authoring Tool URL—The URL of the Genesys Rules Authoring Tool for this iWD Tenant.
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• Click Inventory Report to print to screen a complete view of the Tenant hierarchy, including Solutions,
Departments and Processes.

• Add any Custom Tenant attributes by clicking Add and filling in the Name Type and Value table.

Important
If you are not logged in as the default User, or are not a member of the
SuperAdministrators Access Group, you must have special permissions and role
privileges to create a Tenant. Refer to the Genesys 8.1 Security Deployment
Guide for details about the security requirements for creating a Tenant.

Next Steps

Configure your IWD Soluton by installing and running the iWD Setup Utility. Create as many iWD
solutions as are required for your business needs. Each iWD solution requires its own dedicated Stat
Server. For each iWD solution that you you create, run the iWD Setup Utility and install the Stat
Server Java Extension.

Important
It is recommended that you do not create any Solutions and Services under the
System Tenant. You should do so under a managed Tenant.
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Working with Integrated Capture Points
Capture point (CP) functionality allows iWD to create new tasks, based on data coming from an
enterprise application or source system. CPs also enable existing tasks to be canceled, completed,
held/resumed, restarted, or modified. CP functionality is integrated into Interaction Server.

However, for customers upgrading from iWD 7.6.1 or 8.0, iWD 8.5 no longer supports the legacy CPs
services from those releases.

Genesys recommends that you use the Integrated CPs (ICPs). Because iWD 8.5 no longer supports
legacy capture points, you will need to migrate to using ICPs. See the Moving from Legacy to ICPs tab
on this page.

Important
See the iWD Web topics for information regarding capture points for iWD Web.

Installing iWD ICPs

Installing iWD Integrated CPs

Installation procedures for ICPs are described in the eServices Integrated Capture Points 8.1 Guide.

Important
Remember that legacy capture points are not supported in iWD 8.5.

The prerequisites and other information will differ in the eServices 8.1 Deployment Guide, depending
on the ICP being used. However, for all ICPs there are two common installation steps:

• Creating the Capture Point application.
• Configuring Capture Point iWD attributes.

Creating a Generic Capture Point
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Creating a Generic Capture Point

The procedures in this section are applicable to all types of Capture Point. Differences in configuration
between pre-8.5 ICPs are mentioned specifically in the procedures are documented in the e-Service
Capture Point Guide.

Creating the Capture Point application
Purpose

• The Capture Point functionality is built within Interaction Server 8.1, which means that there is no
separate installation package for any type of Capture Points. An Application object for the Capture
Point must be configured in GAX. One Application must be configured for each instance of the
Capture Point. Interaction Server supports multiple capture points.

Prerequisites

• Interaction Server must be installed.
• iWD 8.5 must be installed.

Start

1. Login to GAX.
2. Navigate to Environment > Applications.
3. Create a new Application object based on the chosen Capture Point template. The CapturePointId

will be automatically set to the name of the Capture Point application as configured in GAX. In iWD
compatibility mode, it will also be saved as the IWD_capturePointId property in user data. When the
Capture Point is configured, the Capture Point ID must be the same as the application name in order to
ensure accurate events history reporting and accurate filtering. (The Capture Point Name can be
anything).

Important
The name of the Capture Point Application must start with a letter, contain only
alpha-numeric characters and underscores, and cannot be longer than 16
characters and cannot contain spaces.

4. Because the Capture Point is integrated with Interaction Server, the Host and Port information is taken
from Interaction Server (which must be listed as a connection on the Connections tab). Host and Port
information comes from Interaction Server.

5. Add a connection to Interaction Server. Multiple Capture Point Application objects can connect to the
same Interaction Server.

6. On the Ports tab, add any additional ports required for connection to Interaction Server.
7. On the Tenants tab, add the relevant Tenant.
8. Ignore the Options tab.
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9. Ignore the Application Options tab.
10. On the iWD Attributes tab, select the Solution from the drop-down list and add a Description. The

runtime ID of the capture point is generated by GAX to a default initial value and it can be changed.
Interaction queues configured in the Solution are copied to the appropriate Capture Point's options. If
the Solution has defined incorrect or disallowed queue names, they should be fixed in the Solution
configuration first. Otherwise the Capture Point object cannot be saved.

11. Save the Application object.
12. When configuration is complete, click Save.

End

Moving from Legacy to ICPs

Moving from Legacy to ICPs

Mapping Native iWD Task Actions to Native IXS Message
Operations

This section is intended to help you understand how the native Interaction Server (IXS) XML message
operations compare to the native iWD XML message operations. The information provided here is
mainly derived from the eServices 8.1 User's Guide.

This page shows how the operations you would specify in the iWD message format correspond, or
translate, to the operations you would specify in the IXS message format.

Task action iWD XML message operation Interaction Server message
operation

Create a new task/interaction in iWD CreateTask <interaction operation="submit">

Get information about a task/interaction
in iWD GetTaskInfo <interaction operation="getinfo">

Update a task/interaction in iWD UpdateTask <interaction operation="update">

Complete a task/interaction in iWD CompleteTask <interaction operation="update">

Hold a task/interaction in iWD HoldTask <interaction operation="hold">
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Task action iWD XML message operation Interaction Server message
operation

Resume a held task/interaction in iWD ResumeTask <interaction operation="resume">

Restart a task/interaction in iWD RestartTask <interaction operation="update">

Cancel a task/interaction in iWD CancelTask <interaction operation="update">

Creating a New Task or Interaction

When you are creating a new task/interaction by using the <interaction operation="submit">
operation to specify the all initial properties of the interaction, use the properties element,
which is a direct child of the interaction element. Alternatively, you can provide default values for
any interaction properties, as part of the Integrated Capture Point Application configuration. See
the descriptions of the default-values sections (which are repeated for each capture type) in the
eServices 8.1 Reference Manual.

Configuration of some properties is mandatory to ensure iWD behaves as expected. Also, in Task
Attribute Mapping in the columnInteraction Attached Data Key, the names of the properties are
described as you would refer to them in this message. You can cross-reference this with the
information in the tables titled Translation Table for Known Attributes-Inbound and
Translation Table for Known Attributes-Outbound in the eServices 8.1 User's Guide.

Updating, Completing, Canceling, or Restarting a Task/Interaction

Use the <interaction operation="update"> operation when you are updating, completing,
canceling, or restarting a task/interaction. Use the properties element, which is a direct child of the
interaction element, to specify which properties to update.

In the special cases, when you are completing, canceling, or restarting a task/interaction, specify the
Queue property, to move the task/interaction to the iWD_Completed/
iwd_bp_comp.Main.iWD_Completedqueues, iWD_Canceled/iwd_bp_comp.Main.iWD_Canceled
queues, or the iWD_New/iwd_bp_comp.Main.iWD_New queues, respectively.

Important
When you use the iWD_Completed/iwd_bp_comp.Main.iWD_Completed,
iWD_Canceled/iwd_bp_comp.Main.iWD_Canceled and iWD_New/
iwd_bp_comp.Main.iWD_New queue names it is assumed that you are using the out-of-
the-box business process that is provided with iWD (IWDBP). If you have modified this
business process to add/change queue names, you will need to consider this when
you are specifying the Queue property for the update action.
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Differences in Task Restart Process
Restarting a held task differs for legacy CPs and integrated CPs. With legacy CPs, if a held task is
restarted, its state changes to New and it is processed again as a new task. However, for integrated
CPs, after a task is restarted, it must first be resumed before processing continues. If the task is not
resumed, then it stays in the iWD_New queue as held.

Mandatory Interaction Properties

When you submit a new interaction to Interaction Server (<interaction operation="submit">), the
following properties are mandatory. Therefore, they are also mandatory for the Integrated Capture
Points:

• InteractionType

• InteractionSubtype

• MediaType

• Queue

• TenantID

Important
In this case, TenantID is the Genesys tenant ID, not the ID of the managed tenant
that is created in the iWD configuration.

You do not need to specify these properties in the XML message, because several of them are
normally not relevant to iWD. There is an configuration option for the Capture Point Application
template, called default-values (for a description, see the eServices 8.1 Reference Guide), which
enables you to enter default values for any of these properties (as well as any other interaction
properties). Therefore, if the default values for these five attributes/properties are specified in the
options, then the message itself need not contain any other properties for Interaction Server to
accept and process it.

The Queue property is an exception, because you can configure the default queue as part of the
business process configuration by using the endpoints section.

In addition to these mandatory properties, three other properties, specific to iWD interactions, are
used to ensure that interactions are accounted for correctly by iWD Data Mart and are displayed
properly through the Global Task List. The properties are:

• iWD_TenantId

• iWD_SolutionId

• iWD_CapturePointId

The iWD_CapturePointId property will be equivalent to the name of your Capture Point
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Application in Configuration Server. See the procedure, “Creating the capture point application” in
the eServices 8.1 Deployment Guide.

When you deploy the Integrated Capture Point, you must also set the ID and Solution on the iWD
Attributes tab.

The iWD_SolutionId and the iWD_TenantId properties are the ID of the Solution and the Tenant,
respectively, under which the capture point application has been created in GAX. Similar to the
mandatory interaction properties, these three additional properties are set automatically by the
iWD GAX Plugin when the iWD Attributes tab is completed.

More Information About CPs

More Information About CPs

For a description of some optional ways to format the information inside the <properties> element,
see the section, “Properties Element” in the eServices 8.1 User's Guide.

For additional information about other elements, such as changed, deleted, reason, actor, and
party, and about how responses to capture point requests are processed, see Chapter 9 in the
eServices 8.1 User's Guide.

By default, when you specify any interaction property that is not considered a core property of the
Interaction Server interaction data model, or that is not a core or extended attribute in terms of the
iWD data model, the value of that property will be stored in a BLOB in the interactions table of the
Interaction Server database. If you need to use this custom property in any Queue Views, or to use
filtering in the Global Task List, see the Working with Task Attributes and Interaction
Properties document.
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Configuring iWD Using Setup Utility (for
releases up to 8.5.103)

Important
Use of the iWD Setup Utility is supported only for iWD 8.5.0x up to 8.5.103x and only
for the iWDBP for IRD for versions from 8.5.0x to 8.5.103x.
From release 8.5.104, Genesys supports only manually configuring iWD deployments (including
deploying and cloning the IRD Business Process and the Composer Business Process) using the procedures
described here.

The 8.5.104 versions of the iWDBP must be installed manually. These procedures are
described here.

For details of how to use the iWD Setup Utility to clone the iWDBP for IRD version 8.5.0x to 8.5.103x
and customize it into a new business process, see Cloning the iWDBP to Create a New Business
Process.

Overview for iWDBP 8.5.0x to 8.5.103x

Overview

Important
From release 8.5.0, the Setup Utility does not ship in a separate IP. It ships as part of
iWD Manager IP.

The iWD Setup utility performs the following functions:

• Imports iWD business processes to Genesys Configuration Server. The iWD Setup Utility includes the
following business processes:
• IWDBP—the default business process. See Working with the iWD Business Process (IWDBP).

• The Customize IWDBP option in release 8.5.1 allows you to clone the iWDBP and edit it with
customized queue names so that you can run more than one business process under the same
Tenant. See Configuring iWD for Multiple Business Processes and Cloning the iWDBP to
Create New Business Process.
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• Standard Genesys to IWD adapter—the business process used to insert into IWDBP to serve
Genesys standard open media channels. These business processes are also provided as a .wie file
that can be imported manually through the Genesys Interaction Routing Designer. This is useful
when you are upgrading from one iWD release to another and you do not have to run the iWD Setup
Utility. The iWD business process .wie file is saved to your file system when the iWD Manager
Installation Package is installed.

• ABC IWD Simple BP—the business process used to insert into existing business processes.

• Creates an Agent Group called IWD in your Genesys Configuration Database. This is the name of the
Agent Group that is used in the example Distribution routing strategy that is included in the standard
iWD Business Process (IWDBP ). Although all customers are expected to modify this Distribution routing
strategy for their own needs, having the IWD Agent Group created out of the box will make it easier to
use IWDBP to process interactions for testing purposes.

• Creates the capacity rule that includes the media type workitem and provides the option to assign it
to the Tenant.

• Enables you to select and configure the Stat Server to use with iWD Stat Extensions.
• Configures the iWD Stat Server Java Extensions into the specified Stat Server.
• Creates the two List Objects—Iwd_Esp_List and Iwd_Package_List—that are necessary to ensure

business rules are invoked from business processes, such as IWDBP.

Important
Iwd_Esp_List also defines the list of Universal Contact Servers to be used with
Interaction Server that allow the iWD business process (IWDBP) to update the
interaction record in the Universal Contact Server, to mark the interaction as done.

• Creates the connector objects for the iWD solution.

Installing and Using the Setup Utility 8.5.0x to 8.5.103x

Installing and Using the Setup Utility

This procedure configures the objects required in Configuration Server for your iWD installation.

Important
The iWD Setup Utility can be run multiple times, as it is possible to have multiple iWD Solutions in your
environment. The following procedure outlines the steps taken the first time the utility is run. Subsequent
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runs of the utility may result in some screens not being displayed, as the information has already been
configured. Therefore, when you run the iWD Setup Utility it might not follow the exact procedure outlined
below.

The iWD Setup Utility will not over-write the iWD business process if it has already been imported by a
previous run of the iWD Setup Utility. So, if any customization has been made on the business process,
running the iWD Setup Utility will not impact your customization, provided all strategy names are the same.

If you have made changes to the iWD business process, but would like to see the
business process that is included in the iWD Setup Utility, you must export the
customized business process from IRD, delete it, and then run the iWD Setup Utility
again. Or, you can run the iWD Setup Utility against a different Tenant.

Environment Prerequisites

• iWD Manager is installed (iWD Setup Utility is shipped with the iWD Manager IP).
• iWD Runtime Node is installed.
• The iWD Data Mart has been installed and the iWD Data Mart database has been created.
• Interaction Server 8.0.1 or later has been installed. If you are not an existing eServices customer, you

will need to install an instance of Interaction Server to use with iWD.

Configuration Prerequisites

• Ensure that you have a Switch Office object created on the Environment tenant. This object can be used
for configuring any sub-tenants.

• Ensure that, for any sub-tenant, you have a switch configured that uses the Switch Office configured on
the Environment tenant.

• Ensure that you have the sub-tenant added to the Tenants tab in your Interaction Server application.
• Copy the IWD strategies (.rbn files) from the IWD Manager's install folder (C:\Program Files\GCTI\

IWD_Mngr\config\ASD) to a location that you will specify in the procedure below in Samples
Placement.

Procedure

1. In GAX, navigate to Administration > Solution Definitions
2. Select iWD Setup Utility from the displayed list. Your screen should look like this:
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3. Check the Deployable check box. If for any reason your Setup Utility is not deployable, you will be
prompted at this point.

4. From the Settings menu (indicated on the screen above) select Install. This action opens the
Automated Service Deployment Wizard, which is a sequence of configuration screens in which you will
define your iWD solution instance. Click Next to begin deployment. Deloyment consists of the
following:
a. Tenant Selection—Browse and select the Tenant where you plan to install the iWD Solution

components.
b. Multimedia Switch Selection—Add the name of a multimedia switch if appropriate. A Multimedia

Switching Office and Multimedia Switch must be created in Genesys Configuration Database, to
support Stat Server and URS operations. Refer to the eServices 8.1 Deployment Guide for more
details on these topics.

c. Universal Router Server Selection—Select the URS for this iWD Solution.
d. Samples Placement—Enter the name of the directory where routing strategy files for sample

import will be placed.
e. Resource Capacity Rules Selection—To select the capacity rule. This action will create a capacity

rule that can be used immediately.
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Important
The default capacity rule that will be created by the iWD Setup Utility will be based on the media type
workitem. You are not required to use workitem as the media type. You can create new media types in
Configuration Manager or Genesys Administrator (as Business Attribute objects) and you can use the new
media types in any Capture Points you create, as well as in any capacity rules you configure.

f. Interaction Server Selection—Browse to and select the Interaction Server you plan to use to
process interactions for this iWD Solution.

g. Database Access Point Selection—Browse to the Database Access Point that is configured for
the Interaction Server Event Log database, or create a new one if necessary.

h. Stat Server Selection—Select an existing Stat Server to configure the iWD Stat Server Java
Extension for this solution.

Important
Each iWD Solution requires its own dedicated Stat Server. For more information about installing and
configuring Stat Server, refer to the Framework 8.1 Stat Server Deployment Guide.

i. Universal Contact Server Selection—Select an existing UCS to use with this iWD Solution. If this
does not exist, you can skip this step. Having the Universal Contact Server name associated with
your iWD Solution ensures that the business logic in the out-of-box iWD business process (IWDBP)
will update the interaction record in the UCS database when an interaction is considered done (that
is, the value of the Status column in the Interaction table in the UCS database will be set to 3).
Normally such an update is done in a routing strategy when processing is stopped for an interaction
and the interaction is deleted in the Interaction Server database. However, in the case of the iWD
business process, even though interactions may persist in the Interaction Server database for a
long period of time, they should still be considered done from an interaction history standpoint in
the UCS database. Selecting a Universal Contact Server application on this screen will cause the
iWD Setup Utility to update the Iwd_Esp_List list object with an association between your iWD
Solution name and this UCS application name.

j. iWD Manager Creation—Add the name of the iWD Manager application, and browse and select
the parent applications folder where the iWD Manager application is located.

k. Genesys Rules Engine Application Selection—Browse and elect an existing Genesys Rules
Engine, or cluster, to evaluate iWD rules.

l. iWD Solution Selection—Enter the enter the Solution ID for the solution.
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Manual Installation of IWDBPs in 8.5.104

Manual Installation of iWDBP for IRD 8.5.104

Manual Installation of iWDBP for IRD 8.5.104

The business process for IRD is provided as a .wie file that can be imported manually through the
Genesys Interaction Routing Designer. The iWD business process .wie files are saved to your file
system when the iWD Manager Installation Package is installed.

Procedure

1. In the IRD main window, click Interaction Design.
2. Click Business Processes. The existing Business Processes are listed for selection.
3. Double-click a Business Process to open the Interaction Design window.
4. From the File menu, select Import. The Configuration Import Wizard Choose File page appears.
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5. Next to the File text box, click Browse. The Open dialog box appears.
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6. Locate the iwdbp.wie file, and double-click it. The Open dialog box closes. IRD inserts the selected
directory path and file name into the File text box in the Configuration Import Wizard.

7. Under Where to put strategy RBN files, do one of the following:
• Click Browse, and then locate the folder that will hold the graphical portion of strategies in the

Business Process (strategy *.rbn files, which consume more space than the script portion of
strategies).

• Select the Into Database check box (if it is enabled), to save *.rbn files in a database.

Notes:
• In order for the Into Database checkbox to be enabled, a Database Access Point must appear in the

Connections tab of the IRD Application in Configuration Manager.
• The database used is the Configuration Server database. The table name is ird_strategies.
• If security is a consideration, you may want to store the .rbn files in a database. For example, if you are

a Service Provider, you might not want your subscribers to have access to your corporate drives. In this
case, saving to the database in the recommended method.

• If you want to save the details of the import operation to a log file, click Browse next to the Log text
box (unless the log file is already selected), and then locate or create the log file.

• Under Log (only if you need it), you have the option of saving business process import details in a log file. If
you wish to do this, click the Browse button and locate/name the log file.

• Click Next. The Configuration Wizard Confirm Importing page appears.
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• If you are satisfied with your entries, click Import; otherwise, click Back to return to the Configuration
Import Wizard Choose File page, and repeat Steps 5-9.
After you click Import, the Configuration Import dialog box appears. A progress bar shows the progress
of the import.

• Do one of the following:

• To update your configuration settings immediately after the update, click Refresh.
• Click Close; then at any time, you can update your configuration settings by selecting Refresh from the

File menu.

• Respond to any messages that appear.

Manual Installation of iWDBP for Composer 8.5.104

Manual Installation of iWDBP for Composer 8.5.104

Import the Composer IWDBP project template (iwd_bp_comp) which is provided with the iWD software
distribution artifacts here:

• <iWD Manager Installation Directory>/config/iwd_bp_comp.

Prerequisites
Configure your Web Application Server by following the application server requirements guidelines
here (new document).

Procedure

1. Run Composer (or Eclipse with the Composer plug-in).
2. Switch to Composer Design or Composer perspective.
3. Select File > Import > General -> Existing Project into Workspace.
4. Select the iwd_bp_comp template and click Next.
5. Select the Project locale and click Finish.
6. Connect to Configuration Server.
7. Select the Tenant that will be used for the business process.
8. Publish the Composer configuration objects to Configuration Server. Do this by right-clicking on the

Interaction Processes/Main.ixnprocess script, then clicking Publish to Configuration Server.
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9. When the project is successfully published to Configuration Server the following objects will be created
under the <selected tenant> Scripts folder on Configuration Server:

10. Composer can show warnings in Queue Interaction blocks. In these blocks select Properties-
>Destination->Interaction Queue Name even it is already set and save changes.
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11. Right-click the iwd_bp_comp project and click Generate All to display the Generate All dialog.

12. Check the Deploy Project and Publish data to Configuration Server checkboxes and click Finish.
This deploys the iwd_bp_comp application to Tomcat and generates *scxml files that can be accessed
via http.

13. To verify that the URL to the generated files is valid, log in to Genesys Administrator.
14. Navigate to <Used tenant> -> Provisioning -> Routing/eServices -> Orchestration ->

iwd_bp_comp.Main.Classification.Classification.
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15. Click Check URI to verify whether the Composer-generated URL is valid.
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Configuring iWD Manually (for releases
from 8.5.104)

Important
This manual procedure replaces (from release 8.5.104 onwards) the configuration and
deployment activities previously carried out by the iWD Setup Utility.

Procedure

1. Log in to GAX.

2. Go to Administration >Installation Packages and click New.

3. Check Installation Package Upload (includes templates) and click Next.

4. Click Upload, select the iWD Manager installation package and click Finish. Upload can take a few
minutes. When it is completed you will see the uploaded iWD Manager installation package.

5. Go to Configuration > Accounts > Capacity Rule and create iwd_capacity_rule (that is, one
interaction of any type) in the tenant's Script folder.

6. Go to Configuration > Switching > Places and create iwd_place for the iwd_admin user.

7. Go to Configuration > Accounts > Users and create the iwd_admin user . In the iwd_admin user, set
the Default Place to iwd_place and the Capacity Rule to iwd_capacity_rule.

8. Go to Configuration > Accounts > Access Groups and create the iwd_access_group. Add the
iwd_admin user in the Members tab.

9. Go to Configuration > Accounts > Agent Groups and create the IWD agent group. Add the
iwd_admin user to the Agents tab.

Installation Configuring iWD Manually (for releases from 8.5.104)

iWD Deployment Guide 93



10. Go to Configuration > Environment > Tenants and in the Permissions tab assign Create, Read,
Update, and Execute permissions to the iwd_access_group.

11. Go to Configuration > Accounts > Roles and create the iwd_role. In the Assigned Privileges tab,
check all the required privileges from the iWD and CfgiWDManager groups.

12. Go to Configuration > Routing >eServices and create the Iwd_Package_List object. Set the Name
and Alias to Iwd_Package_List. In the Options tab create:
a. A section called RulePackageList.
b. A key called <Solution runtime id>, with the value <GRAT package name>

13. Go to Configuration > Routing > eServices and create Iwd_Esp_List object. Set the Name and
Alias to Iwd_Esp_List. In the Options tab create:
a. A section called GREServerList.
b. A key called <Solution runtime id> with the value <GRE application name>.

14. (Optional) If UCS will be used, create:
a. A section called ContactServerList.
b. A key called <Solution runtime id> with the value <UCS application name>

15. Import the iWD Business Process using the procedures described here.

16. Activate the Classification, Prioritization, Distribution, Mark Interaction as Done and Removal
strategies.

17. Go to Configuration > Switching > DNs > Switches > <multimedia switch> > DNs and create a
virtual queue called iWD. Set its Name and Alias to iWD and its Routing Type to Default.

18. Configure the iWD Stat Extensions:

a. Extract the iWD Stat Extensions IP to a temporary folder (such as iwdstatext).
b. Copy ./iwdstatext/java/ext/* to ../statserver/java/ext.

c. Copy ./iwdstatext/java/lib/* to ../statserver/java/lib.

d. Add the following options to Stat Server applications.
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Section Key Value
statserver enable-java true

java-config

java-libraries-dir ./java/lib
java-extensions-dir ./java/ext

jvm-path

<jdk install dir>/jre/lib/amd64/
server/libjvm.so for Linux/
UNIX

<jdk install dir>\jre\lib\amd64\server\
libjvm.dll for Windows

java-extensions BPR_iWD_Extension.jar true

java-extensions-bpr-iwd

dimension-mapping-1 Filter
java-extension BPR_iWD_Extension.jar
java-extension-jar BPR_iWD_Extension.jar

jdbc-driver Please refer to this jdbc-driver-
jar option description.

jdbc-url Please refer to this jdbc-url
option description.

password <iWD datamart password>
refresh 15
service-id-1 STAT_1
service-tenant-1 Resources
<iWD datamart database
user> user

verbose debug
virtual-queue-name-1 iWD

e. Restart the Stat Servers.
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Stat Server Extensions
After the iWD Setup Utility has completed (up to 8.5.103) or you have made a manual installation
(8.5.104 onwards), you can install the iWD Stat Extensions, which provide access to the aggregated
data in the Data Mart. Please note that since release 8.5, Data Mart is distributed as part of the
installation package for iWD Runtime Node.

Installing Stat Server Extensions

Installing Stat Server Extensions

Important
If the Data Mart is not used, Stat Extensions are not required and the solution will
work fine.

Purpose

To provide access to the aggregated data in the Data Mart.

Prerequisites

• An instance of Stat Server is installed, dedicated for use with iWD. Refer to the 8.5 Stat Server
Deployment Guide for more information.

• ORS 8.1.400.48 is installed if you wish to use the new Stat Server Extensions features in iWD release
8.5.106.03.

Procedure

1. From the server that is running Stat Server, navigate to the iWD Stat Extensions folder of the iWD CD.
Locate and double-click Setup.exe.

2. Click Next on the Welcome screen.

Installation Stat Server Extensions

iWD Deployment Guide 96



3. Select the appropriate Stat Server instance from the list that is displayed and click Next.
4. Click Install to install iWD Stat Extensions. Click Finish when the installation has been completed.

Stat Server Configuration Options

Stat Server Configuration Options

java-extensions section

During installation, a new option is added to the java-extensions The option
BPR_iWD_Extension.jar is added with a value of true.

java-extensions-bpr-iwd section

The java-extensions-bpr-iwd section contains options which specify the JDBC connection driver
and parameters for access to the iWD Data Mart database. Most options are managed by the Stat
Adapter job of iWD Data Mart and are rewritten each time the Stat Adapter is run. For reference,
those options are listed below:

• jdbc-driver-jar—The .jar file with the JDBC driver. The path is relative to the directory specified as
java-libraries-dir in the Stat Server configuration (which defaults to ./java/lib in the Stat Server
installation directory). Valid values include:
• sqljdbc4.jar (for MS SQL)
• ojdbc6.jar (for Oracle)
• postgresql-9.4.1209.jre6.jar (for PostgreSQL)

• jdbc-driver—The class name for the corresponding JDBC driver. Valid values include:
• com.microsoft.sqlserver.jdbc.SQLServerDriver (for MS SQL)
• oracle.jdbc.OracleDriver (for Oracle)
• org.postgresql.Driver (for PostgreSQL)

• jdbc-url—The JDBC URL, which describes RDBMS-specific access parameters. Below are some sample
values:
• jdbc:sqlserver://hostname:1433;databaseName=databasename (for MS SQL)
• jdbc:oracle:thin:@//hostname:1521/databasename (for Oracle)
• jdbc:postgresql://hostname:5432/databasename (for PostgreSQL)

• user—The user name for database access.
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• password—The password for database access.
• verbose—The level to control debug information, provided in the Stat Server log file. Possible values are

debug, trace, or standard.
• refresh-interval—The interval (in minutes) for data updates from the database.
• service-id-1—The runtime ID of the Statistics Adapter service in the iWD configuration.
• service-tenant-1—The name of the CME tenant—this is linked to the iWD managed tenant where the

Statistics Adapter service is configured.
• virtual-queue-name-1—The name of the virtual queue prefix. Used when dimension-mapping-1 is

equal to Virtual Queue.
• dimension-mapping-1—The type of the dimension mapping between iWD Data Mart and Stat Server.

Valid values are Filter and Virtual Queue.

You can set a small subset of options manually:

• java-extension-jar—Name of the BPR iWD extension file. Defaults to BPR_iWD_Extension.jar. This
must match the option in java-extensions section in the Stat Server configuration.

• jdbc-properties-file—Path to JDBC driver properties file relative to directory specified as java-
libraries-dir in Stat Server configuration (defaults to ./java/lib in Stat Server installation
directory). Can be used to specify optional driver-specific JDBC options. Please consult driver
documentation for further information.

• reconnection-timeout—Delay in milliseconds between database reconnection attempts performed by
the BPR iWD extension. Defaults to 10000.

• tenant-ids—A list of Configuration Server/Genesys Administrator tenant names mapped to iWD tenant
IDs, separated by a comma. For a system with one tenant with name TenantA and ID T2, this option
should be set to value:Environment=1,TenantA=2.

Report Stats for each Dimension on its own Virtual Queue

Report Stats for each Dimension on its own Virtual Queue

The iWD Stat Server Java Extension can be configured to report statistics in two different ways: all
statistics for all dimensions can be reported on one Virtual Queue, or each dimension can have its
statistics reported on its own Virtual Queue.

The iWD Setup Utility configures Stat Server to use the iWD Stat Server Java Extension to report all
statistics on one Virtual Queue. If you want to change this, you have to modify the configuration
manually.
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Procedure

To report each dimension on its own Virtual Queue:

1. Set the the option dimension-mapping-1 to the value Virtual Queue.
2. Instead of using the Virtual Queue name as a value for the option virtual-queue-name-1, indicate the

prefix that will be used for Virtual Queue names. For example, if virtual-queue-name-1=dim-, then
Virtual Queues with the names dim-CNT_T2_C106, dim-CNT_T2_C107 and so on, have to be created.
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Logging
iWD Manager and iWD Runtime Node support creation of their own log files for troubleshooting
purposes. As well, they both support centralized logging through Genesys Message Server. The
parameters needed for both types of logging are configured in the log4j.properties file for each
application. The following procedures explains how to configure the required parameters.

Important
Write the pathnames using either a single forward ( / ) slash or a double backwards
slash ( \\ ) as a separator.

Configuring logging for iWD Manager and iWD Runtime Node

Configuring logging for iWD Manager and iWD Runtime Node

Prerequisites

• iWD Manager and iWD Runtime are both installed.
• For centralized logging, Genesys Message Server is installed.

Refer to the Framework 8.1 Management Layer User’s Guide for more information about Message
Server.

Start

1. Find the log4j.properties file in the web application server’s (Tomcat or WebSphere) webapps
directory and open it in a text editor.

Important
For WebSphere, the file is located under WAS_root/
profiles/<profile>/installedApps/<node,cell>/
<application>_war.ear/<application>.war/WEB-INF/classes

Example: /usr/IBM/WebSphere/AppServer/profiles/AppSrv01/installedApps/
rs6000Node01Cell/iwd_manager_war.ear/iwd_manager.war/WEB-INF/

classes
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2. The exact path is <Install dir>/iwd_node/config/log4j.properties for iWD Runtime Node and
webapps/iwd_manager/WEB-INF/classes/log4j.properties for iWD Manager.

Important
Be sure to remove the comment symbol (#) when you update the parameters.

3. For centralized logging, update the very first row of the log4j.properties file to include
centralized_node at the end:

log4j.rootLogger=INFO, runtime, centralized_node

• For centralized logging, update the following parameters with the Message Server host and Message Server
port, respectively:

log4j.appender.centralized_manager.MessageServerHost=
[ToBeChanged:MSG_SRV_HOST]

log4j.appender.centralized_manager.MessageServerPort=
[ToBeChanged:MSG_SRV_PORT]

• Update the following line to include the name of your iWD Manager or iWD Runtime application (this is the
application name that you must use to set up alarms in Solution Control Server):

log4j.appender.centralized_node.MessageServerClientName=
iWD Runtime Node

• Configure the parameter to specify the level of logging to send to Message Server:

log4j.appender.centralized_node.Threshold=INFO

Threshold can be set to any of the following values:

• TRACE

• DEBUG

• INFO

• WARN

• ERROR

• For information about various settings for the root logger, refer to log4j framework docs, such as
http://logging.apache.org/log4j/1.2/manual.html.

• You can change the directory where the logs will be written by changing the value of this line:

log4j.appender.runtime.File=C:/GCTI/iWD/iwd_runtime.log
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Important
It is strongly recommended that you only set the file path to a directory on a local
machine, not a remote location such as a shared network drive. Logging to a remote
location can severely impact performance

• You can change the logging level by changing this line (sample is from an iWD Runtime log4j.properties
file):

log4j.appender.runtime.Threshold=INFO

Possible values are Off, Warning, Error, Debug, Info, and Trace.

• You can change the maximum file size of the logs by changing this line:

log4j.appender.runtime.MaxFileSize=256MB

• Save your changes.

The following is a sample iWD Runtime log4j.properties file configured for logging:

info, rolling 256MB each (2 GB max)

log4j.rootLogger=INFO, runtime, centralized_node

log4j.category.org.apache.myfaces.renderkit.html.util=ERROR

log4j.category.org.hibernate.util.JDBCExceptionReporter=FATAL

log4j.category.org.hibernate.event.def.AbstractFlushingEventListener=FATAL

log4j.category.org.apache.commons.httpclient=ERROR

log4j.category.org.apache.commons.digester=ERROR

log4j.category.org.codehaus.xfire.transport.http.HttpChannel=FATAL

log4j.category.org.codehaus.xfire.handler.DefaultFaultHandler=ERROR

log4j.appender.runtime=org.apache.log4j.RollingFileAppender

log4j.appender.runtime.Threshold=INFO

log4j.appender.runtime.File=C:/GCTI/iWD/iwd_runtime.log
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log4j.appender.runtime.layout=org.apache.log4j.PatternLayout

log4j.appender.runtime.layout.ConversionPattern=%d{yyyy-MM-
dd HH:mm:ss}|%t|%p|%c|%m%n

log4j.appender.runtime.MaxBackupIndex=7

log4j.appender.runtime.MaxFileSize=256MB

if you enable centralized_node appender then make sure you
change rootLogger to:

log4j.rootLogger=INFO, runtime, centralized_node

log4j.appender.centralized_node=com.genesyslab.iwd.log.CentralizedAppender

log4j.appender.centralized_node.Threshold=INFO

log4j.appender.centralized_node.layout=org.apache.log4j.PatternLayout

log4j.appender.centralized_node.layout.ConversionPattern=%m

log4j.appender.centralized_manager.MessageServerHost=MsgSrvrHost

log4j.appender.centralized_manager.MessageServerPort=4050

log4j.appender.centralized_node.MessageServerClientName=iWD
Runtime Node

End

Updating the Interaction Server databases and related
configuration objects

Updating the Interaction Server databases and related
configuration objects

Purpose

To ensure iWD automatically runs the update scripts on the Interaction Server databases for
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compatibility with iWD 8.1, updates the configuration options for the Event Log DAP, creates the
necessary Business Attributes in Configuration Server, and configures the completed-queues option
for Interaction Server.

Prerequisites

• Interaction Server is correctly installed. (Refer to the eServices (Multimedia) 8.1 Deployment Guide).
• The installation of iWD components as outlined in this chapter is completed up to this point. In

particular, iWD Manager must be installed.

Start

1. Log into iWD Manager.
2. Navigate to your iWD tenant.
3. Navigate to the Configure Ixn Custom Properties tab and select your solution from the navigation

tree
4. Select Configure Ixn Custom Properties.

The Mapping errors section on the right-side pane notifies you of the updates that must be
made to your Interaction Server Event Log DAP and Business Attribute configuration. The
Interaction Server and Event log database migrations section notifies you of the
updates that must be done to your Interaction Server and Interaction Server Event Log
databases.

5. To initiate these updates, click Configure Ixn Custom Properties.

You are prompted to restart Interaction Server.

End

enable-revoke-from-agent
Starting with Interaction Server 8.1.2, a configuration option, enable-revoke-from-agent, has been
provided to support enhancements to task management in the Global Task List. Specifically, this
option allows an Assigned interaction to be revoked from an employee desktop when the interaction
is put on hold, canceled, or completed, from the Global Task List or through an iWD capture point.
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Preparing iWD For Use With Genesys Social
Engagement
By default, the installation and configuration procedures described above will prepare iWD to support
Genesys Social Engagement. That is, the required database fields will be present in the Interaction
Server and Interaction Server Event Log databases, the required Interaction Custom Properties
(Business Attributes) will be created in Configuration Server, and the required Interaction Server and
Event Log Database Access Point application options will be configured.

Enabling this feature will have the following effect:

• A Global Task List custom filter that uses specific social media-related columns will be visible in the
Filters drop-down list.

• Social media-related attributes will be available custom filters in the advanced Filters drop-down list of
the Global Task List.

• Social media-related attributes will be visible on the Attributes panel of the Global Task List.

Updating the Tenant to enable display of Social Media Attributes
and Filters

1. Log in to the Genesys Administrator Extension.
2. Navigate to Configuration Manager > Environment > Tenant.
3. Select the Tenant to work with.
4. In the iWD Attributes tab,check the Social Messaging Enabled checkbox and save the change.
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Installing/Removing Language Packs
iWD provides two types of packages related to the localization process:

• Those related to the iWD Plug-in for GAX, described here.
• Those related to iWD Manager, Runtime Node and Standard Rules Template (SRT) files that are

described below.

On Windows

1. Stop iWD Manager web server and Runtime Node services.
2. Launch setup.exe and choose whether to install localization for:

• Manager
• Runtime Node
• Both Manager and Runtime Node

Choose the relevant application(s) from the list.
3. The installer will find the correct path by itself and copy all required files there. A localized SRT will be

installed into iWD Manager in the ruleTemplates directory with a suitable language suffix such as
iWD_Standard_Rules_CHS.

4. Restart the stopped services.

Important
Uninstall also requires that you stop services beforehand.

On Linux

1. Stop iWD Manager web server and the Runtime Node process.
2. Launch ./install.sh and in the dialog that opens, provide:

a. Type of server—For Tomcat you will be prompted with an additional question about the path.
b. iWD Manager directory—Provide the path to iWD Manager if you want to install the localization

package to iWD Manager.
c. iWD Node directory—Provide the path to iWD Runtime Node if you want to install localization

package to iWD Manager.
d. Destination directory—This is the path where package contents will be extracted.
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**************************************************
* Welcome to the Genesys 8.5 Installation Script *
**************************************************

Installing iWD Language Pack, version 8.5.XXX.XX

Please select your servlet container type by number:
1. Tomcat
2. WebSphere
=>1

Please enter the full path to your
Tomcat installation =>SOME_PATH

Please enter iWD Manager directory or press ENTER if iWD Manager is not installed
=>PATH_TO_MANAGER

Please enter iWD Node directory or press ENTER if iWD Node is not installed
=>PATH_TO_NODE

Please enter full path of the destination directory for installation =>SOME_WORK_PATH

Extracting tarfile: data.tar.gz to directory:
..
Installation of iWD Language Pack, version 8.5.XXX.XX has completed successfully.

3. Restart the stopped processes.
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IWD Troubleshooting

Support for REHL 64-bit Platforms

Installers support installation of Red Hat Linux 64-bit platforms only when RHEL standard
compatibility packs for 32-bit platforms have been installed. These packages have generic names
like:

• compat-glibc*

• compat-libstdc++*

• libstdc++* '

You might also need to ensure that the JAVA_HOME variable points to the correct JDK.

Blocked Lookup Tables

When a configuration transaction object already exists with its alias attribute set to
Iwd_Lookup_Tables_List, it is not possible to create a new Lookup Table due to a constraint
violation of the uniqueness of the alias attribute value. An error message is displayed to inform users
about this violation.

If this type of error arises, before checking privileges, do the following:

1. Check whether any object with a different on-screen name and the alias Iwd_Lookup_Tables_List
already exists.

2. If so, back it up then remove and recreate the entire whole Lookup Table from scratch via the GAX
interface.

Error when Creating or Updating a Big Lookup Table

Lookup tables have a limit of 1000 entries each. This constraint was implemented to avoid
connection timeouts between GAX and Configuration Server. It is still possible that this problem might
occur in a customer environment when the connection has very low quality. The workaround for this
problem is to edit the Application options of the GAX application and increase the value of the
confserv_timeout property in the General section. If the confserv_timeout option is not present, a
default value of 30 seconds is applied.
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Configuration
The folowing topics describe configuration required for iWD:

• iWD Manager Configuration
• Roles and Privileges Configuration
• IWD GAX Plugin Configuration
• iWD Services Detail
• iWD Reporting
• Configure iWD for Multiple Business Processes
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IWD Manager Configuration

Logging in

Logging in

User Login

Anyone who needs access to iWD Manager must be configured as a Person or in Genesys
Administrator (GA) or Genesys Administrator Extension (GAX) and also must have the required
privileges (usually defined as iWD roles) assigned either in GA or GAX.

The login screen prompts for the following information:

• Username—The username for the Person or User as configured in GA/GAX.
• Password—The password for the Person or User as configured in GA/GAX.
• CME Application—The name of the iWD Manager Application object as configured in GA/GAX.

Programmatic Login

You can log into iWD Manager programmatically by providing the URL for iWD Manager login page
along with a valid username and password. This can facilitate a single sign-on process.

The URL format to use is:

http://<appserverhost>:<appserverport>/<iwdmanagerapplication>/ui/
login.jsf?username=<username>
&password=<password>≈plication=<CMEApplication>&passwordEncoded

or, from release 8.5.101.04 onwards:

http://<appserverhost>:<appserverport>/<iwdmanagerapplication>/ui/
login.jsf?username=<username>
&password=<password>&passwordEncoded

Where:

• <appserverhost> and <appserverport> are the host and port for the application server where iWD
Manager is deployed.
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• <iwdmanagerapplication> is the iWD Manager application running on the application server (for
example, iwd_manager).

• <username> and <password> are a valid username and password combination for the user logging into
iWD Manager.

• <CMEApplication> is the name of the iWD Manager application as configured in the Genesys
Configuration database. You can find the name in GA or GAX. iWD Manager will be shown with an
application type of iWD Manager. From release 8.5.101.04 this parameter is optional.

Important
If you want to include the &passwordEncoded at the end of the URL, then the value for
<password> should be encoded using the BASE64 algorithm. Otherwise, you can pass
a plain-text password in the <password> parameter and omit &passwordEncoded.

An example URL is:

<http://myTomcatHost:8080/iwd_manager/ui/
login.jsf?username=jsmith&password=myPassword&CMEApplication=iWDManager

General Conditions for Configuring an iWD Manager User

General Conditions for Configuring an iWD Manager User

To access the Global Task List, the Person must be associated with a Place in Genesys
Configuration. If the Person is not an Agent, the Place can be configured as an option on the Annex
tab of the Person/User object. Create a section iWD (if it does not already exist) and within the iWD
section, create an option iWDManagerPlace with the value of a valid Place name.

If you want a user to have access to a specific managed tenant in iWD, that user must have
at least Read access to the Configuration Server tenant that is linked to that iWD managed
tenant—either directly or by being a member of an Access Group that does. The user must have at
least Read and Execute permissions to the iWD Manager application in Configuration Server, and
Read permissions to the Configuration Server Host object where the Interaction Server is running,
either directly or by being a member of an Access Group that does.

If the user is going to have access to the Global Task List, then the user must have at least
Read and Execute permissions to these application objects in Configuration Server:

• Interaction Server
• The Database Access Point for the Interaction Server database
• The Database Access Point for the Interaction Server Event Log database.

These permissions may be applied directly to the user, or by the user being a member of an Access
Group that has such permissions.
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The Place that must be associated with the user must be a Place configured under the Configuration
Server tenant that maps to the iWD managed tenant. (This presumes that the Interaction Server
application also has an association with this Configuration Server tenant.) The Place is only used to
give the user access to the Global Task List.

If you want to restrict what the user can do in iWD Manager, use roles and privileges as
described in Role-Based Access Control.

If the user is created under a Configuration Server child tenant, then the following additional
conditions must be met:

• If you want the user to have access to both the iWD SYSTEM tenant as well as the iWD managed tenant
to which the Configuration Server tenant maps, then this user must be either be a member of at least
two Access Groups with the relevant permissions, or must have permissions granted directly to them.

Such Access Groups must have at least Read permission to the tenants.

If the user has no role privilege in a Tenant, then the Tenant is hidden from that user.

If the user is created under the Environment tenant(for example, such as the default user that
is in the Configuration Server database when it is initially deployed) then in order for this user to
have full control of the Global Task List (not just read-only access), two conditions must be met:

• The user must have a valid Place configured, where the Place is created under a child Configuration
Server tenant to which the Interaction Server is associated.

• The user must have an Employee ID that also belongs to a user who is created under a child
Configuration Server tenant to which the Interaction Server is associated.

• The user must have all role privileges from all the "iWD*" groups.

Importing Media Icons

Importing Media Icons

The Media Icons view provides a way to map graphical icons to media types to display in the GTL.
iWD comes with some pre-loaded icons, but additional icons can be uploaded and mapped to existing
media types, or new media types. Icons must be 16x16, but can be in any of the following file
formats:

• GIF
• JPG
• BMP
• PNG

The following properties and actions are available in the Media Icons panel:
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Icon Description

Media Type

The media type to which the icon will be mapped.
This list of media types is retrieved dynamically
from Genesys Configuration Server. Media types
are a type of Business Attribute in Configuration
Server. Genesys provides out-of-the-box media
types but new custom media types can be added.

Icon
The graphical 16x16 icon that will be displayed in
the GTL when a task is of the media type to which
the icon is mapped.

File Name The file name of the icon.

New Icon Mapping Provides a way for you to upload a new icon from
the file system.

Browse Opens a File Upload dialog window to enable you
to browse the file system to select an icon.

Upload Uploads the icon selected via the Browse action.
Save/Save and Close/Cancel Standard iWD Manager functions.

Changes in 8.5.0

Only Media Icons are imported/exported into/out of iWD Manager in release 8.5.0.

Prerequisites

• iWD Manager, iWD Runtime Node are installed.
• Application servers are started (if running on WebSphere – applications are started).

Procedure

1. Log in to iWD Manager.
2. Open Import/Export in the General section of the System tenant.
3. Import the following files:

• <iWD Manager installation directory>\config\iwd_mediaicons.xml.
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Important
The XML file is saved to the installation directory where the iWD Manager supporting
files were installed.

• After each import a message appears at the bottom of the screen to indicate whether the import was
successful.

Filters

Filters

Filters allow you to refine the list of tasks that are displayed in the Global Task List. Each filter is
defined by a set of filter criteria (optional) and table columns that will be displayed in the Global Task
List. Here is an example.
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Preconfigured Filters

The table below lists the attributes and actions that are available in the Filters view.

Filter Attributes

Attribute/Action Description

Name The name of the filter.

Public Whether the filter will be available to all users (checked) or only
the current user (unchecked).

Filter Criteria

Tasks that do not match the defined criteria will be excluded
from the GTL when the filter is selected. New criteria conditions
can be added by selecting them from the Select criteria to
add drop-down list. Some criteria conditions are parameterized;
for such conditions, parameters can be configured directly in a
criteria table (such as, status for Status is ... criteria).
Custom attributes can be used in many of the filter criteria, with
proper configuration. Custom Attributes for tasks are configured
in the iWD GAX Plugin component. See the Task Attributes tab
of the Data Mart section of iWD GAX Plugin Help.

Table Columns

The GTL will display these columns when the filter is selected.
Columns can be added, removed, and reordered. A user can
select from a list that includes all iWD core and extended
attributes, by default. With proper configuration, custom
attributes can also be selected.

Save, Save & Close, Cancel, Delete Standard iWD Manager functions.

Creating Custom Filters

Creating a Custom Filter

1. Click Filter > New in the left navigation pane.
2. Check the Public checkbox to make the new filter available to all users. If this box is not checked, only

the current user can view the new filter.
3. From the Select criteria to add drop-down menu at the bottom left, select filter criteria for the new

filter. Use the red delete button displayed to the right of the selected criterion to delete it if required.
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4. From the Select column to add drop-down menu at the bottom center, add any new table columns for
displaying the filter output. The current selection of table columns appears to the right of the screen.
Use the up/down arrows to sort the display of the table columns. Use the red delete button to delete
any columns as required.

5. Click Save or Save and Close. The newly created filter is now available for selection in the main Global
Task List window.

Understanding Timezones in Filters

Timezones in Filters

Dates in advanced filters are interpreted as half-open time intervals, starting at midnight of the given
day and ending at midnight of the next day. Midnight means the time 00:00:00 in the current user's
timezone. If the user's timezone is not set, the current solution's time zone is used. If this is also
missing, Universal Coordinated Time (UTC) is assumed. Daylight saving rules are also taken into
consideration.

In the case of persistent filters, the timezone of the user who defines the filter is used to calculate the
time interval. If there is no timezone configured, UTC is assumed (filters are independent from
Solutions).

Example
The user's time zone is Europe/Warsaw (GMT+1)(+DST). The user sets a filter on Expiration Date to
2014-10-26. GTL will display tasks that have an Expiration Date Time between 2014-10-26
00:00:00 CEST (inclusive) and 2014-10-27 00:00:00 CET (exclusive). In translation to the UTC
timezone, these will become 2014-10-25 22:00:00 and 2014-10-26 23:00:00. Because of daylight
saving the interval is 25 hours long.
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Roles and Privileges
Role-Based Access Control replaces Security Policies in iWD 8.5. For details of how to use this feature
please see:

• Genesys Administrator documentation set
• Genesys Security Guide
• Roles in the main GAX Help (new document).

Important
Role privileges cannot be seen in GA, only in GAX. GAX iWD Plug-in privileges are
imported when GAX is used to import the GAX iWD Plug-in installation package.

GAX iWD Plug-in Privileges

• iWD Read Solution—Read privilege for iWD Solution.
• iWD Modify Solution—Modify privilege for iWD Solution.
• iWD Create Solution—Create privilege for iWD Solution.
• iWD Delete Solution—Delete privilege for iWD Solution.
• iWD Read Department—Read privilege for iWD Department.
• iWD Modify Department—Modify privilege for iWD Department.
• iWD Create Department—Create privilege for iWD Department.
• iWD Delete Department—Delete privilege for iWD Department.
• iWD Read Process—Read privilege for iWD Process.
• iWD Modify Process—Modify privilege for iWD Process.
• iWD Create Process—Create privilege for iWD Process.
• iWD Delete Process—Delete privilege for iWD Process.
• iWD Read Tenant—Read privilege for Tenant.
• iWD Read Capture Point—Read privilege for Capture Point.

From Release 8.5.102
In order to apply full Role-Based Access Control to the iWD GAX Plug-in on the GAX dashboard, the
following role permissions have been added to the iWD GAX Plug-in's template:
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• IWD_READ_LOOKUP_TABLES—Read privilege for lookup tables
• IWD_MODIFY_LOOKUP_TABLES—Modify privilege for lookup tables
• IWD_CREATE_LOOKUP_TABLES—Create privilege for lookup tables
• IWD_DELETE_LOOKUP_TABLES—Delete privilege for lookup tables
• IWD_READ_DATAMART—Read privilege for Data Mart
• IWD_MODIFY_DATAMART—Modify privilege for Data Mart
• IWD_MONITOR_DATAMART—Monitor privilege for Data Mart
• IWD_MANAGE_DATAMART—Manage privilege for Data Mart

Users without the relevant permissions will not be able to view the iWD tile on the GAX dashboard.

iWD Manager Privileges

• View Solutions—Viewing privilege for iWD Solutions
• Configure Ixn Custom Properties—Privilege to configure Interaction Custom Properties needed by

iWD
• View Tasks for Departments—Viewing Tasks privilege for iWD Departments
• View Tasks for Processes—Viewing Tasks privilege for iWD Processes
• Modify Media Icons—Modification privilege for iWD Media Icons
• Create Media Icons—Creation privilege for iWD Media Icons
• Delete Media Icons—Deletion privilege for iWD Media Icons
• View Media Icons—Viewing privilege for iWD Media Icons
• Modify Filters—Modification privilege for iWD GTL Filters
• Create Filters—Creation privilege for iWD GTL Filters
• Delete Filters—Deletion privilege for iWD GTL Filters
• View Global Task List—Viewing Global Task List page privilege
• Export Tasks—Exporting tasks privilege
• Cancel Tasks—Canceling tasks privilege
• Hold/Resume Tasks—Putting on hold or resuming tasks privilege
• Modify Tasks—Modification of tasks privilege
• View Tasks by Capture Point—Viewing tasks by capture point privilege
• View All Tasks—Viewing all tasks in solution privilege
• Open Rules Authoring—Privilege to open Rules Authoring link
• Import Configuration—Privilege to import configuration from an XML file
• Export Configuration—Privilege to export configuration to an XML file
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Important Information About Filtering Permissions

The following additional information is also important to note when you are filtering permissions:

• Public filters can be changed from Private by any user that has Modify filter permissions.
• The owner of a Private filter can always modify or delete that filter, even if they do not have Delete and/

or Modify security role permissions.
• The username of the owner of a Private filter is displayed on the Filter configuration screen to make

referencing easy..
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Setting Shared User Access Roles Across
iWD and GRS

Background

This feature enables administration-level users to set and synchronize shared user access roles
across iWD and GRS, enforcing consistent behavior between them.

Before the introduction of this feature, if you configured two roles in IWD—Manager1 and Manager
2—where Manager 1 was dedicated to Department 1 and Manager 2 was dedicated to Department 2,
these configuration constraints were not read correctly by iWD Manager. This meant that in iWD
Manager, both Manager 1 and Manager 2 could see everything in both Departments. This feature
enables roles to be configured consistently across GRS and IWD.

Configuration Example in Genesys Administrator

The example below shows an administrator-level view of how to configure a user's permissions to
hide certain parts of the business structure from that user.

Provisioning in Genesys Administrator

1. In the Provisioning tab, locate the Business Units/Sites node in the navigation tree.
2. Find and display the Department to which you're going to configure (in this example) read-only

access—dep_1_NOT_visible_for_selenium_user.
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3. Find the user to work with—selenium_user.
4. Set permissions for this user (in this case, only Read Permission).

To configure other permissions to other parts of the business structure (for example Processes under
this Department) repeat steps 2, 3 and 4 for that Solution, Department or Process. The example
screens below assume that two Processes exist under the Department (dep_1) and that user
permissions are restricted to only one of those Processes.

Once you have saved the changes, they are propagated (when the applications connect or re-connect
to Configuration Server) to all the iWD and GRS components in which the Business Structure can be
either viewed or manipulated:

• Genesys Rules Authoring Tool (GRAT)
• iWD Manager
• iWD Plug-in for GAX

The GRAT administrator's view

In the graphic (an unrestricted view, perhaps for a manager or administrator), this is what we see:

• dep1—selenium user will not be able to see this Department in the Business Structure (configured in
the example above).

• dep—selenium user will be able to see this Department (and one of its Processes) in the GRAT
Business Structure (not shown in the example above).
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The iWD Manager administrator's view

The same changes are also propagated across iWD Manager...

The iWD Plug-in for GAX administrator's view

...and across iWD Plug-in for GAX.
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IWD Business Solution Configuration

Business Structure

Business Structure
[+] DESCRIPTION
The Business Structure is a hierarchy of business units. Each Tenant can contain one or more
Solutions as the first level of the hierarchy. Below Solutions are Departments. Below Departments are
Processes. For example:

• East London Office—Solution (note that this meaning means the top node of a business structure, rather
than the meaning of Solution in Genesys Configuration environment.)
• Finance Department—Department

• Accounts Payable—Process
• Order Processing—Process

Warning
All node names have to be unique within the parent node. For example, moving
Department D1 to another solution which already has a Department named D1
generates an error.

Warning
Only one business structure per Tenant is possible.

Levels of a Business Structure for a Tenant:

• [+] SOLUTIONS
Solutions are used for partitioning logical and physical resources for purposes of user access control and load partitioning
(performance). Normally there will be one Solution per Tenant, though you can configure multiple solution instances per tenant, if
necessary (for example, “Production” and “Test”).

A Solution in iWD represents a runtime environment, which is composed of the following:

• Runtime nodes—iWD runtime application instances that are within the Java application server in
which services are being run
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• Services—Services that enable iWD functionality, such as Data Mart, Statistics Adapter, and logging.
• Business logic—Primarily the configuration of iWD departments and processes.

The Solution level in a Business Structure corresponds to the Global level in Genesys Rules System for the processing logic of
business rules.

• [+] DEPARTMENTS
A Department represents an administrative unit within a Solution. A Solution can contain many Departments. The Department
level of a Business Structure corresponds to the Department level in Genesys Rules System for the processing logic of business
rules.

• [+] PROCESSES
A Process represents an administrative unit within a Department. A Department can contain many Processes. The Process level of
a Business Structure corresponds to the Process level in Genesys Rules System for the processing logic of business rules.

Display Options

Filters and Constraints

Configuration Server respects tenancy permission settings. You can access only those objects that
you have been granted permissions and privileges to access.

You can filter the contents of this list in two ways:

1. Type the name or partial name of an object in the Quick Filter field.
2. Click the cube icon to open the Tenant Directory filter panel. In this panel, click the Tenant that you

want to select. Use the Quick Filter field in this panel to filter the Tenant list.

You can sort the items in the list by clicking the Name column. Clicking a second time reverses the
sort order. You can add or remove columns by clicking Select Columns.

To select or de-select multiple objects at once, click Select.

Data Fields

Each entry is shown with the following data fields:

• Name—The element's name.
• Type—Solution, Department or Process
• ID—The runtime ID of this element.
• Contact Name—Contact name for queries about this element.
• Description—Free-format text description of the element.
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Solutions

To create a new Solution

To create a new Solution, do one of the following:

• If one or more Solution is already present, select one Solution and click More, then click Clone, then
edit the Solution data fields.

• If one or more Solution is already present, Display the details of an existing Solution and click Clone,
then edit the new Solution data fields.

• If no Solution is present, click the the New button (+), choose Solution, then edit the Solution data
fields.

Other Actions

From this context you can Delete this Solution.

Warning
1. Deleting a Solution can have huge implications for the operation of a contact
center. Do not undertake these without serious consideration.
2. if you delete a Solution, all related rules packages in GRS will be lost, and you and
will not be able to recreate new rules packages with the same name.

Solution Details

• Solution Name—The Solution name. Mandatory when you add a new Solution.
• ID—The ID of the Solution. Mandatory when you add a new Solution. The system will propose a default

new Runtime ID.
• Timezone—Solution timezone. Use the drop-down list to change this.
• First Day of Week—The first day of the working week for this Solution. Use the drop-down list to

change this.
• Description—Free-format text description of the Solution.

The following options allow customization of interaction queues used by iWD in the current Solution.
Non-standard queue names must be defined when there are multiple iWD business processes
configured in the same Tenant. Queue names can be selected from drop-down lists. If a value is
missing, a default name is displayed for this queue.
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• Queue for new tasks—Interaction queue recognized by iWD as an entry to the business process in
this solution. Default values:
• IRD—iWD_New

• Composer—iwd_bp_comp.Main.iWD_New

• Queue for captured tasks—Interaction queue for tasks successfully processed by the Classification
strategy. Default values:
• IRD—iWD_Captured.
• Composer—iwd_bp_comp.Main.iWD_Captured

• Queue for queued tasks—Interaction queue for tasks successfully processed by the Prioritization
strategy. Default vlaues:
• IRD—iWD_Queued

• Composer—iwd_bp_comp.Main.iWD_Queued

• Queue for completed tasks—Interaction queue for tasks marked as completed by agents. Default
values:
• IRD—iWD_Completed

• Composer—iwd_bp_comp.Main.iWD_Completed

• Queue for rejected tasks—Interaction queue for tasks rejected by the Classification strategy. Default
values:
• IRD—iWD_Rejected

• Composer—iwd_bp_comp.Main.iWD_Rejected

• Queue for canceled tasks—Interaction queue for tasks canceled by a Global Task List user or by a
capture point. Default values:
• IRD—iWD_Canceled

• Composer—iwd_bp_comp.Main.iWD_Canceled

• Queue for error-held tasks—Interaction queue for tasks that failed to be processed by the
Classification or Prioritization strategies. Default values:
• IRD—iWD_ErrorHeld

• Composer—iwd_bp_comp.Main.iWD_ErrorHeld

Interaction Server Settings

• Interaction Server—The Interaction Server for this Solution. Use the drop-down list to change this.
This drop-down list contains those Interaction Servers which contain the Solution's parent Tenant on
their Tenants list.

• Port—The connection port of the Interaction Server. Use the drop-down list to change this. This drop-
down list contains the Interaction Server chosen above ports from the ports list.
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Important
If two Solutions are configured to use the same Interaction Server, be aware that the
Port settings (that is, secure or non-secure) of the Solution that is configured second
are the ones that the Interaction Server will use. It is preferable to ensure that both
Solutions' Port settings are of the same type—either both secure, or both non-secure.
Every configuration object or parameter that references the Port ID (and therefore can
be either secure or non-secure) will work in the same way—the setting of the one
configured second (where two Solutions are configured) is the one that the Interaction
Server will use. This affects connection protocol, local timeout, remote timeout, trace
mode and transport protocol parameters.

• Connection Protocol—The connection protocol of the Interaction Server. Use the drop-down list to
change this. This parameter is set as the connection attribute of the Interaction Server connection in
the iWD Manager application.

• Protocol Timeout—The timeout configured for the connection protocol.
• Local Timeout—The timeout configured on the local server. This parameter is set as the connection

attribute of the Interaction Server connection in the iWD Manager application.
• Event Buffer Size—The maximum size in bytes of the event buffer.
• Remote Timeout—The timeout configured on the remote server. This parameter is set as the

connection attribute of the Interaction Server connection in the iWD Manager application.
• Threads—The number of threads available.
• EventLog JDBC URL—The URL of the JDBC event log. Mandatory for all database engines set in the

Eventlog DAP (connected to Interaction Server set above), apart from MSSQL.
• Attribute Filter Include—Attributes included here will appear in the Custom Attributes displayed in

the Global Task List in iWD Manager.
• Attribute Filter Exclude—Attributes excluded here will not appear in the Custom Attributes displayed

in the Global Task List in iWD Manager.

Permissions Settings (new in 8.5.105)

Business Structure details include a Permissions tab on which users with the relevant permissions
can view and edit permissions settings for all users of the selected node.

Permissions Table
Permission Description

Read Permission to read information and receive updates
about the object.

Create Permission to create objects in this folder.

Change Permission to change the properties of the object.
The Change permission is the
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Permission Description

same as allowing “Write” access.

Execute Permission to perform a predefined action or set of
actions with respect to the object.

Delete Permission to delete the object.

Read Permissions Permission to read the access control settings for
the object.

Change Permissions Permission to change the access control settings
for the object.

Execute Permission to perform a predefined action or set of actions with
respect to this object.

Propagate

For container objects (such as Tenants). The
Propagate check box controls whether to
propagate this set of elementary permissions to
the child objects. By default, the check box is
selected).

Actions

• Add Access Group—Displays the Select Access Group panel from which you can select one of the
available Access Groups to add to this node and for whom you can then configure permissions.

• Add Person—Displays the Select Person panel from which you can select one of the available
Persons to add to this node and for whom you can then configure permissions.

• Replace Recursively—Enables you, upon confirmation, to remove permissions for all child objects of
this container and replace them with the permissions defined in this container.

Departments

To create a new Department

To create a new Department, first choose the Solution to work with, then do do one of the following:

• If one or more Department is already present, select one Department and click More, then click Clone,
then edit the Department data fields.

• If one or more Department is already present, display the details of an existing Department and click
Clone, then edit the new Department data fields.

• If no Department is present, click the the New button (+), choose Department, then edit the
Department data fields.
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Other Actions

From here you can Clone, Delete or Move this Department. You can move the Department only to a
Solution. Any Processes configured under it will also be moved. Runtime IDs are not moved in the
Move function—you must create a new one for the Department and all its child Processes in its new
Solution.

Warning
1. Deleting or Moving a department can have huge implications for the operation of a
contact center. Do not undertake these without serious consideration.
2. If you delete a Department or Process, any rules assigned to those objects will be
inactivated and moved to the Solution level. This happens if you delete and re-create
a Solution/Department/Process with the same name.

Department Details

• Department Name—The department name. Mandatory when you add a new Department.
• ID—The department's Runtime ID. Mandatory when you add a new Department. The system will

propose a default new Runtime ID.
• Contact Name—The contact name for the department, for informational purposes.
• Contact Email—The contact email for the department, for informational purposes.
• Contact Phone—The contact phone number for the department, for informational purposes.
• Start Date—The date on which the department becomes active. If left empty, the period start date is

unconstrained.
• End Date—The last day that the department is active. If left empty, the period end date is

unconstrained (that is, the department will be active infinitely).
• Description—Free-format text description of the Department.

Department Attributes

Click Add to create new attributes.

• Name—The attribute name
• Type—Select from the drop-down list. Valid values are:

• Text

• Percentage

• Number
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• Date

• Lookup Table

• Value—The attribute value. If the type is a lookup table, then the value is set from the drop-down list.
• Description—Free-format text description of the attribute.

Department Metrics

Click Add to create a set of user-defined metrics, for reporting purposes.

[+] MORE
A key component of dashboards and reports is the comparison of actual metrics against target goals.
Understanding the effectiveness or efficiency of organizations requires measuring performance
against important goals that have been set by the organization. Targets can be associated with a
number of objects, such as processes, departments, or tenants. For example, a work-time goal for a
task will differ, based on its process; for example, orders will take longer than address changes. You
can use metrics to measure this. Example:

When a metrics value is set, it will be stored as a named attribute in Data Mart. If the value is
changed, the updates are pushed through to Data Mart with a valid_from and valid_to date/time
stamp. This is important for historical reporting. For example, if you update the target on November 1
from 2.5 to 3.5, all tasks up to November 1 will use 2.5, and all new tasks will use 3.5. If the value is
set at a department level, it applies to all processes, unless there is a specific value for that process.
For example, Department 1 has four processes: A, B, C, and D. Cost/Task @ Department 1 = 2.50,
which applies to Processes B, C, and D. Cost/Task @ Process A = 1.50, which applies only to Process
A.

• Name—The metric name
• Type—Select from the drop-down list. Valid values are:

• Text

• Percentage

• Number

• Date

• Lookup Table

• Value—The attribute value. If the type is a lookup table, then the value is set from the drop-down list.
• Description—Free-format text description of the attribute.

Permissions Settings (new in 8.5.105)

Business Structure details include a Permissions tab on which users with the relevant permissions
can view and edit permissions settings for all users of the selected node.
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Permissions Table
Permission Description

Read Permission to read information and receive updates
about the object.

Create Permission to create objects in this folder.

Change
Permission to change the properties of the object.
The Change permission is the
same as allowing “Write” access.

Execute Permission to perform a predefined action or set of
actions with respect to the object.

Delete Permission to delete the object.

Read Permissions Permission to read the access control settings for
the object.

Change Permissions Permission to change the access control settings
for the object.

Execute Permission to perform a predefined action or set of actions with
respect to this object.

Propagate

For container objects (such as Tenants). The
Propagate check box controls whether to
propagate this set of elementary permissions to
the child objects. By default, the check box is
selected).

Actions

• Add Access Group—Displays the Select Access Group panel from which you can select one of the
available Access Groups to add to this node and for whom you can then configure permissions.

• Add Person—Displays the Select Person panel from which you can select one of the available
Persons to add to this node and for whom you can then configure permissions.

• Replace Recursively—Enables you, upon confirmation, to remove permissions for all child objects of
this container and replace them with the permissions defined in this container.

Processes

To create a new Process

To create a new Process, first choose the Solution and Department to work with, then do one of the
following:
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• If one or more Process is already present, select one Process and click More, then click Clone, then edit
the Process data fields.

• If one or more Process is already present, display the details of an existing Process and click Clone,
then edit the new Process data fields.

• If no Process is present, click the the New button (+), choose Process, then edit the Process data fields.

Other Actions

From here you can Clone, Delete or Move this Process. You can move the Process only to a
Department. Runtime IDs are not moved in the Move function—you must create a new one for the
Process in its new Department.

Warning
1. Deleting or Moving a Process can have huge implications for the operation of a
contact center. Do not undertake these without serious consideration.
2. If you delete a Department or Process, any rules assigned to those objects will be
inactivated and moved to the Solution level. This happens if you delete and re-create
a Solution/Department/Process with the same name.

Process Details

• Process Name—The Process name. Mandatory when you add a new Process.
• ID—The Runtime ID of the Process. Mandatory when you add a new Process. The system will propose a

default new Runtime ID.
• Contact Name—The contact name for the process, for informational purposes.
• Contact Email—The contact email for the process, for informational purposes.
• Contact Phone—The contact phone number for the process, for informational purposes.
• Start Date—The date the process becomes active. The start date of the process cannot be earlier than

the start date of the parent department.
• End Date—The last day that the process is active. If left empty, the period end date inherits the end

date value of the parent department.
• Description—Free-format text description of the Process.

Process Attributes

Click Add to create new attributes.
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• Name—The attribute name
• Type—Select from the drop-down list. Valid values are:

• Text

• Percentage

• Number

• Date

• Lookup Table

• Value—The attribute value. If the type is a lookup table, then the value is set from the drop-down list.
• Description—Free-format text description of the attribute.

Process Metrics

Click Add to create new metrics.

[+] MORE
A key component of dashboards and reports is the comparison of actual metrics against target goals.
Understanding the effectiveness or efficiency of organizations requires measuring performance
against important goals that have been set by the organization. Targets can be associated with a
number of objects, such as processes, departments, or tenants. For example, a work-time goal for a
task will differ, based on its process; for example, orders will take longer than address changes. You
can use metrics to measure this. Example:

When a metrics value is set, it will be stored as a named attribute in Data Mart. If the value is
changed, the updates are pushed through to Data Mart with a valid_from and valid_to date/time
stamp. This is important for historical reporting. For example, if you update the target on November 1
from 2.5 to 3.5, all tasks up to November 1 will use 2.5, and all new tasks will use 3.5. If the value is
set at a department level, it applies to all processes, unless there is a specific value for that process.
For example, Department 1 has four processes: A, B, C, and D. Cost/Task @ Department 1 = 2.50,
which applies to Processes B, C, and D. Cost/Task @ Process A = 1.50, which applies only to Process
A.

• Name—The attribute name
• Type—Select from the drop-down list. Valid values are:

• Text

• Percentage

• Number

• Date

• Lookup Table

• Value—The attribute value.
• Description—Free-format text description of the attribute.
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Permissions Settings (new in 8.5.105)

Business Structure details include a Permissions tab on which users with the relevant permissions
can view and edit permissions settings for all users of the selected node.

Permissions Table
Permission Description

Read Permission to read information and receive updates
about the object.

Create Permission to create objects in this folder.

Change
Permission to change the properties of the object.
The Change permission is the
same as allowing “Write” access.

Execute Permission to perform a predefined action or set of
actions with respect to the object.

Delete Permission to delete the object.

Read Permissions Permission to read the access control settings for
the object.

Change Permissions Permission to change the access control settings
for the object.

Execute Permission to perform a predefined action or set of actions with
respect to this object.

Propagate

For container objects (such as Tenants). The
Propagate check box controls whether to
propagate this set of elementary permissions to
the child objects. By default, the check box is
selected).

Actions

• Add Access Group—Displays the Select Access Group panel from which you can select one of the
available Access Groups to add to this node and for whom you can then configure permissions.

• Add Person—Displays the Select Person panel from which you can select one of the available
Persons to add to this node and for whom you can then configure permissions.

• Replace Recursively—Enables you, upon confirmation, to remove permissions for all child objects of
this container and replace them with the permissions defined in this container.

Data Mart
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Data Mart

Display Options

Filters and Constraints

Configuration Server respects tenancy permission settings. You can access only those objects that
you have been granted permissions and privileges to access.

You can filter the contents of this list in two ways:

1. Type the name or partial name of an object in the Quick Filter field.
2. Click the cube icon to open the Tenant Directory filter panel. In this panel, click the Tenant that you

want to select. Use the Quick Filter field in this panel to filter the Tenant list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order. You can add or remove columns by clicking Select Columns.

To select or de-select multiple objects at once, click Select.

Data Fields

Each entry is shown with the following data fields:

• Name—Name of the solution hosting iWD Data Mart.

General

• Application—Name of the iWD Runtime Node application attached to the selected Solution. There is a
one-to-one relationship between Solutions requiring Data Mart and iWD Runtime Node applications. The
iWD Runtime Node can be detached from the Solution by selecting a blank name in this field.

• Host—Host where the iWD Runtime Node is installed. Selectable from the list of hosts configured in
GAX Configuration Manager.

• Port—Port assigned to iWD Runtime Node. Numeric field; the value must be between 1 and 65535
inclusive. The port must be unique within the host.

• ETL Scripts Directory—The directory on the server in which iWD Data Mart ETL scripts are stored. For
example, the default path used when iWD Data Mart is installed is C:\Program Files\GCTI\iWD Data
Mart\etl.

• From release 8.5.102—Configuration Server's Database Access Point—The name of the
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Database Access Point associated with Configuration Server. Required for Data Mart's Load Config job.
• Number of Threads—Performance tuning: the size of the thread pool.
• Ignored Dimensions—Performance tuning: the list of dimensions that will be ignored by the Load

Intraday job. One dimension per line.
• Default Dimension Key—Performance tuning: the default value which will be used for ignored

dimensions' keys.
• From release 8.5.105—Clear Dimension Cache—Enables or disables persistence of the dimension's

cache between Load Intraday job runs. With value true, the dimension's cache is cleared when the
Load Intraday job completes. With value false (default), the cache persists between Load Intraday job
runs. Requires restart of the IWD Runtime Node to take effect.

Logging

The Logging tab configures internal logging capabilities within the iWD Runtime Node.

• Log Level—The Service log level. This should be set to Info unless otherwise instructed by Genesys
Technical Support. The possible log levels are:
• Debug—The most detailed informational events that are most useful in debugging an application.
• Info—Informational messages that highlight the progress of the application.
• Warning—Potentially harmful situations.
• Error—Error events that might not affect the application’s ability to run.
• Trace—Turns on all logging.
• Off—Turns off all logging.

• Log Directory—The directory in which the log files will be stored, for all services. If it starts with / (on
Unix-based operating systems) or a drive letter (on Windows), an absolute path will be used; otherwise,
the path is relative from the iWD Runtime Node installation directory.

Note: It is strongly recommended that you only set the file path to a directory on a local machine,
not a remote location such as a shared network drive. Logging to a remote location can severely
impact performance.

• Log Age—Sets the number of days that log files should be kept in the system. A value of 0 disables this
limit.

• Log Size—Sets a limit on the size of a single log file, in megabytes. A value of 0 disables this limit.
• Log Files—Sets a limit on the number of log files that are kept for this service, excluding the current

log file. A value of 0 disables this limit.

Database

The Database tab defines a connection to a Data Mart database server. The configured database
and user must exist in the database server. The user must have read/write permissions to the
database.
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• Application—The name of the Database Access Point application associated with Data Mart instance.
• Database—The name of the database. This is available only for MS SQL Server.
• SID—Oracle System ID of the database. The Oracle System ID (SID) is used to uniquely identify a

particular database on a system. This is available only for Oracle database.
• Server—The database server. Selectable from list of configured hosts.
• Port—The TCP port number of the database server.
• User Name —The database user name.
• Password—The password for the database.
• Auto-Sync—The iWD Data Mart database will be initialized automatically the first time the Database

Service and Kettle ETL Service are started. If the Auto-Sync option is selected, this initialization is
automatic, and the Database Service will also check for updates to the iWD Data Mart database
whenever a new version of iWD Data Mart is installed. The Auto-Sync option will also initialize ETL plug-
ins.

• Custom URL (for Data Mart)—Add a specific custom URL here to override any default value for the
Data Mart database used by iWD Data Mart.

• Custom URL (for iWD SSJE)—Add a specific custom URL here to override any default value for the
Data Mart database used by BPR iWD StatServer extensions.

Stat Server

The Stat Server tab configures Statistics Adapter job and defines connection to Genesys Stat Server.
Statistics Adapter processes the statistical data created by the Aggregate Stats ETL job and writes
stat-types and filters in the configuration for Genesys Stat Server. CCPulse+ requests iWD statistics
from Stat Server, and reads the stat-types and filters from the Stat Server configuration.

Important
From release 8.5.108.02, multiple Stat Servers can be specified manually via the
Runtime Node configuration object. On the Options tab, provide a list of Stat Servers
separated by semicolons for the following option:

• '''[stat-server]/name'''—<StatServer_1>;<StatServer_2>;...;<StatServer_N>

• Application—The Stat Server's application name. Selectable from list of installed Stat Server
applications. Each Data Mart requires separate Stat Server instance.

• Dimension Mapping—Defines how statistical dimensions are mapped.
• Filter—Dimensions are mapped to CCPulse+ filters.
• Virtual Queue—Dimensions are mapped to Genesys virtual queues.

• Virtual Queue Name—Name of the Genesys virtual queue to which statistics are distributed.
Applicable only if Dimension Mapping is set to Virtual Queue.
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• Service Index—Statistical service index for configuration options. This should be unique inside the set
of indexes, assigned to statistical services served by the one instance of Genesys Stat Server.

• Extension File Name—Required to support a Genesys reporting environment with multiple instances
of Stat Server Java Extensions. This is the name of the Stat Server Java extension jar file
(BPR_iWD_Extension.jar). This file is saved to the Stat Server installation directory during installation
of the iWD Stat Extensions. You can find the location of this file in Stat Server configuration options as
the value of the java-libraries-dir option in the java-config section.

• Extension Section Name—Required to support a Genesys reporting environment with multiple
instances of Stat Server Java Extensions. This property maps to the section name for the specific Stat
Server Java Extension in the Stat Server configuration.

Schedules

The Schedules tab configures execution schedule of three Data Mart job groups. The syntax follow
standard CRON scheduling expression. For example, the following expression will cause the job to be
executed every 15 minutes:

0 0,15,30,45 * * * ?

For more information about CRON scheduling, see [http://www.quartz-scheduler.org/documentation/
quartz-2.1.x/tutorials/crontrigger Quartz Scheduler documentation]

• Intraday—The schedule for the Intraday job group: Load Config, Load Intraday, Aggregate Intraday,
Aggregate Stats and Statistic Adapter. Typically scheduled to run every 15 minutes.

• Historical—The schedule for the Historical job group: Load Historical, Aggregate Historical and
Maintain. Typically scheduled to run once a day, after midnight.

• Prune—The schedule for Prune job. Typically scheduled to run once a day, after Historical group.

Expirations

The Expirations tab configures the Maintain job, which deletes expired facts from Data Mart tables.

• Record Details—The number of days after which the detailed task (task_fact, task_event_fact, and
task_work_fact) data will be removed from the database.

• Aggregation 15 min—The number of days after which the data will be removed from 15-minute
aggregation tables.

Tenant Attributes

The Tenant Attributes tab enables selection of up to 5 of a tenant's custom attributes, that will be
loaded into the CUSTOM_DIM dimension and associated to the tenant via the CUSTOM_DIM_KEY field.

• Custom Attribute 1-5—User-configured custom Tenant attributes, selectable from the list of Custom
Attributes attached to the Tenant.
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Department Attributes

The Department Attributes tab allows selection of up to 5 of a departments's custom attributes
that will be loaded into the CUSTOM_DIM dimension and associated to the departments via the
CUSTOM_DIM_KEY field.

• Custom Attribute 1-5—User-configured custom Department attributes, selectable from the list of
Custom Attributes attached to any Department within the Solution.

Process Attributes

The Process Attributes tab allows selection of up to 5 of a process' custom attributes, that will be
loaded into the CUSTOM_DIM dimension and associated to the processes via the CUSTOM_DIM_KEY field.

• Custom Attribute 1-5—User-configured custom Process attributes, selectable from the list of Custom
Attributes attached to any Process within the Solution.

Task Attributes

The Task Attributes tab defines up to 10 names of a task's custom attributes that will be loaded
into the task_fact custom attribute fields (CUSTOM_ATTRIBUTE 1-10). Names must start with a
letter, and only underscores and alphanumeric characters are supported.

In order for Kettle to pick them up, it is necessary to create fields in the Event Log Database. In the
rpt_interaction and rpt_esp tables, add the fields in the following format:

*: Name: <attribute_name>, type: varchar(length).

These fields should be added to the mappings in the Event Log DAP options in the esp-custom-data
and itx-custom-data sections.

For example, in order to store a custom attribute with the name order_total in the iWD Data Mart,
as a task custom attribute:

1. Create a new column in the rpt_interaction table: order_total, type: varchar(50)
2. Create a new column in the rpt_esp table: order_total, type: varchar(50)
3. Create a new option in the esp-custom-data section of the Event Log DAP options:

order_total=order_total

4. Create a new entry option in the itx-custom-data section of the Event Log DAP options:
order_total=order_total

5. Add order_total to the Task Attributes list in iWD GAX Plugin.

Dimension Mapping
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The Dimension Mapping tab defines up to 5 comma-separated names of a task's custom attributes
that will be loaded into the CUSTOM_DIM dimension and associated to the task via the
CUSTOM_DIM_KEY field. Names must start with a letter, and only underscores and alphanumeric
characters are supported.

In order for Kettle to pick them up, it is necessary to create fields in the Event Log Database. In the
rpt_interaction and rpt_esp tables, add the fields in the following format:

*: Name: <attribute_name>, type: varchar(length).

These fields should be added to the mappings in the Event Log DAP options in the esp-custom-data
and itx-custom-data sections.

For example, in order to store a custom attribute with the name order_total in the iWD Data Mart,
as a task custom attribute:

1. Create a new column in the rpt_interaction table: order_total, type: varchar(50)
2. Create a new column in the rpt_esp table: order_total, type: varchar(50)
3. Create a new option in the esp-custom-data section of the Event Log DAP options:

order_total=order_total

4. Create a new entry option in the itx-custom-data section of the Event Log DAP options:
order_total=order_total

5. Add order_total to Dimension Mapping list in iWD GAX Plugin.

Lookup Tables

Lookup Tables

Lookup Tables
[+] MORE
You can specify lookup tables that can be used in rules, custom attributes, and metrics. Lookup tables
are simple key/label pairs and are displayed as dropdown controls. Although business rules are
managed in the Genesys Rules System, it is still possible to create rule parameters that use values
from iWD Lookup Tables. Example: the taskChannels parameter in the iWD Standard Rules Template
presents the user with a list of task channels that are read from an iWD Lookup Table.

The taskChannels parameter is configured as a database type rule parameter. The configuration of
that parameter instructs the Genesys Rules Authoring Tool how to query the iWD configuration
database to retrieve the values of the out-of-the-box iWD Lookup Table called channels. To create
additional rule parameters that will retrieve the values from other Lookup Tables, you can make
copies of the taskChannels parameter and modify the SQL query, changing the name of the Lookup
Table from channels to the name of your Lookup Table.
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Display Options

Filters and Constraints

Configuration Server respects tenancy permission settings. You can access only those objects that
you have been granted permissions and privileges to access.

You can filter the contents of this list in two ways:

1. Type the name or partial name of an object in the Quick Filter field.
2. Click the cube icon to open the Tenant Directory filter panel. In this panel, click the Tenant that you

want to select. Use the Quick Filter field in this panel to filter the Tenant list.

You can sort the items in the list by clicking a column head. Clicking a column head a second time
reverses the sort order. You can add or remove columns by clicking Select Columns.

To select or de-select multiple objects at once, click Select.

Data Fields

Each entry is shown with the following data fields:

• Name—The element's name.

Actions

To add a new Lookup Table

Either:

• From the List view, click New and complete the Lookup Table's details.
• Display the details of a Lookup Table and click Clone, then edit the details.

To add a new key/label pair to a Lookup Table

Display the Lookup Table by selecting it, then click Add and complete the new details.
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Other Actions

From this context you can Delete or Move this Lookup Table. You can move the Lookup Table only to
another Tenant. Runtime IDs are not moved in the Move function—you must create a new one for
theLookup Table in its new Tenant.

Warning
Deleting or Moving a Lookup Table can have huge implications for the operation of a
contact center. Do not undertake these without serious consideration.

Distribution Points and Lookup Tables

Important
Distribution point functionality and the DISTRIBUTION_POINT dimension in iWD Data
Mart are deprecated in release 8.5.103.03.

Distribution Points are attributes that can be assigned to tasks in business rules, and there is still a
Distribution Point dimension for this purpose in the iWD Data Mart schema.

Distribution Points must be configured as Lookup Tables at the Tenant level. The following procedure
describes the steps that are used to configure Distribution Points as Lookup Tables.

Configuring Distribution Points as Lookup Tables

1. In iWD GAX Plugin, configure a new Lookup Table for your tenant. The name of the Lookup Table must be
distributionPoints.

2. The distributionPoints lookup table must be configured under the iWD managed tenant in which the
rule action to assign the distribution point to a task is defined.

3. Start using the rule action Assign distribution point in your business rules.

There is a rule action in the iWD Standard Rule Template called Assign distribution point
that uses a rule parameter configured to read the values from the distributionPoints Lookup
Table. This rule action can be used in a business rule.
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IWD Services
If you have used the Genesys-recommended Genesys Administrator Extension installation procedure,
iWD Services are automatically populated into the iWD Plug-in for GAX when the iWD Runtime Node
is started. iWD Services are now configured in the iWD Plug-in for GAX. Please refer to the iWD GAX
Plug-in Help for details about configuring iWD services. The list of services is as follows:

• Logging
• Configuration Server Connector
• DM Database
• DM Kettle ETL
• DM Initialize
• DM Load Config
• DM Load Intraday
• DM Aggregate Intraday
• DM Aggregate Stats
• Statistics Adapter
• DM Load Historical
• DM Aggregate Historical
• DM Maintain
• DM Prune

Services are configured per Solution, and each Solution must be configured under a tenant in GAX.
Therefore, before configuring services, you must configure a Tenant and Solution.

.
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IWD Reporting

Overview

With an increasing number of choices in the marketplace and higher expectations of service quality,
the ability to measure the efficiency and effectiveness of customer service delivery becomes a key
component of success. iWD streamlines an often cumbersome reporting process through:

• Cradle-to-grave reporting from the time that a task enters the contact center until its completion.
• Consolidated reporting across the various systems that are involved in customer-service delivery: fax

servers, workflow, customer-relationship management, and Genesys Customer Interaction
Management.

• Reporting that is based on business context—with business process, customer segment, and product
independent of channel, instead of being limited to interactions, queues, channels, and workflows.

The key to achieving the desired business results is having access to actionable business intelligence.
Genesys iWD offers comprehensive reporting, providing management insight into business operation.
It provides key indicators of performance both through current-day statistics and on an historical
basis. The historical metrics are provided based on aggregates and measures that are populated by
scheduled ETL processes, which extract data from the Genesys Interaction Server Event Log
database and load it into the iWD Data Mart. This next figure provides a functional overview of iWD’s
reporting components. Third-party services can reference iWD statistics from the GTL_STAT table
(GTL, for Global Task List) to display data in dashboards or within Genesys CCPulse+.
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Important
Each iWD solution requires its own Data Mart.

Database Objects

iWD Data Mart consists of the following database objects:

• Fine-grained fact tables—Store all attributes that are associated with tasks (I_TASK_FACT/
H_TASK_FACT tables), work-related events (I_TASK_WORK_FACT/H_TASK_WORK_FACT tables),
when the task was assigned to one or more agents; and a full audit history of the task
(I_TASK_EVENT_FACT/H_TASK_EVENT_FACT tables).

Important
The term agent refers to any resource, configured as a Person object in Configuration
Server, that can handle tasks. (Within Genesys Administrator, Person objects appear
as User objects within the interface.)

• Aggregated fact tables—Describe tasks in an iWD-oriented context across the various stages, or the
iWD life cycle of the task, from capture and classification to distribution to agent.

• Dimensions—Describe task attributes that are common across the fact tables in iWD Data Mart, such as
iWD business process, priority, business value, and date and time. Fact tables link to these dimensions
through keys.

• Measures—Represent numerical values (such as totals, durations, averages, minimums, and
maximums) that are stored in aggregated fact tables across intraday and historical intervals. For
example, the total number of completed tasks by 15-minute interval by an iWD process and business
value would be captured within the I_TASK_CAPT_FACT_15MIN intraday table.

When they are connected to existing enterprise data marts, including Genesys Info Mart, analysts
gain access to comprehensive views of the entire customer experience. Analytical reporting
leverages existing business intelligence tools, such as those that are provided by Pentaho (which is
an open-source product suite for business intelligence) or through a host of commercial products
from Cognos or SAP Crystal Reports.
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iWD Data Mart–Dimensions, Measures, and Facts

Reporting Services

The Statistics Adapter Service allows performance of custom aggregations on data and sends the
resulting statistics to Genesys Stat Server. Statistics then can be viewed in CCPulse+ or any other
Stat Server client.

Historical reporting is enabled by a number of ETL jobs that transform and load iWD runtime data into
a separate reporting database that is called the iWD Data Mart for a list of preconfigured ETL jobs).
Essentially, the iWD Data Mart is a set of star schemas that contain historical iWD data that is
optimized for reporting. The ETL jobs are set up as scheduled services in iWD. Refer to the iWD 8.5
Data Mart Reference Guide for more information.

Statistics for a Chosen Dimension Available Through Stat Server

The list of statistics coming from iWD Data Mart that are available in Stat Server is as follows:
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• GTL_ACTIVE—Number of active tasks for each department and process configured in the system.
• GTL_HELD—Number of held tasks for each department and process configured in the system.
• GTL_PENDING_15MIN—Number of pending tasks, as of the trailing 15-minute interval, for each

department and process.
• GTL_OVERDUE_15MIN—Number of overdue tasks, as of the trailing 15-minute interval, for each

department and process.
• GTL_NEW_15MIN—Number of new tasks, as of the trailing 15 minute interval, for each department and

for the solution.
• GTL_NEW_30MIN—Number of new tasks, as of the trailing 30 minute interval, for each department and

for the solution.
• GTL_NEW_60MIN—Number of new tasks, as of the trailing 60 minute interval, for each department and

for the solution.
• GTL_COMPLETED_15MIN—Number of completed tasks, as of the trailing 15 minute interval, for each

department and for the solution.
• GTL_COMPLETED_30MIN—Number of completed tasks, as of the trailing 30 minute interval, for each

department and for the solution.
• GTL_COMPLETED_60MIN— Number of completed tasks, as of the trailing 60 minute interval, for each

department and for the solution.

In addition to the above statistics, a set of filters is created—for each Solution, Department and
Process there is one filter created. The filter definition looks like this:

• Filter name—GTL_<object type>_<object runtime id>

The object type can be one of these values:
• SLT
• DPT
• PRC

For example, the filter name for a Process with runtime ID T2_C3_P4 is:
T2_C3_P4: GTL_PRC_T2_C3_P4

• Filter definition—PairExists("Dimension", "<object type>_<object runtime id>")

For example, the filter definition for a Process with runtime id = T2_C3_P4 is:
PairExists("Dimension", "PRC_T2_C3_P4")
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Configuring CCPulse+ for iWD

Purpose

In Genesys, iWD current-day statistic measure types are presented as statistic objects, and iWD
statistic dimensions are defined as filters. Therefore, it is necessary to combine statistic objects with
filters in order to get a measure type for a dimension.

Prerequisites

• The iWD Data Mart database has been created, and the corresponding Database service has been
configured and is running.

• The Aggregate Statistics ETL job is configured and running.
• Stat Server must be running, with the iWD Stat Extensions installed.
• The Statistics Adapter service must be configured and running.

Procedure

1. Start CCPulse+, and connect to the Genesys Stat Server (File > New).
2. In the Object Types dialog box, select the Virtual Queue object type for the corresponding Genesys

tenant and switch, and click Next.
3. In the Object Instances dialog box, select the virtual queue that is used by the iWD to submit

statistics, and click Finish.

Important
This is the virtual queue that was specified in setup using the iWD Setup Utility. From
release 8.5.104, iWD Setup Utility is no longer supported.

Next Steps
To be able to view iWD current-day statistics in Genesys CCPulse+, it is necessary to create a
CCPulse+ template. The following procedure explains how to create a CCPulse+ template.
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Creating a CCPulse+ template

Purpose
To create a CCPulse+ template to use to view iWD current-day statistics.

1. Open the CCPulse+ template wizard by selecting Template Wizard... from the Tools menu.
2. In the Template Definition dialog box, select the Virtual Queue object type in the Available Object

Types list, then select the Create New Template option, and click Next.
3. In the Pre-defined Statistics dialog box, enter the template name, then click the New Group button,

and enter a name for the newly created statistic group.
4. Expand the TotalCustomValue stat type in Available Statistics tree view, and select the iWD statistic

that you want to add to the template (all iWD statistic names have a “GTL” prefix).
5. Click the >> button to add the selected statistic to the newly created statistic group.
6. In the Requested Statistics tree view, select the newly added statistic, and then click the Properties

button.
7. In the Statistic Properties dialog box enter Alias (which is how the statistic is displayed in

CCPulse+). Set the following values, then click OK:
• Insensitivity to 1

• Interval Type to Selection and GTLAggregated

• Notification Mode to Time Based

• Filter to the filter type that represents the required iWD dimension

8. Add more statistics and statistic groups, if necessary, and then click the Next button.
9. In the Graph dialog box, adjust graph parameters, if necessary, and then click Finish.

10. In the CCPulse+ main window, select the virtual queue instance that is used by the iWD to submit
statistics. Create a real-time view for this virtual queue.

11. In the Real-Time Data Template dialog box, select the previously created template from the list, and
click OK.
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Configuring Pulse for iWD
Pulse does not provide an iWD widget template. This must be created manually first. Please check
the Pulse Deployment Guide or contact your Genesys provider.
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Configuring iWD for Multiple Business
Processes

• For the IWD Business Process for IRD, see the Working with the IWDBP for IRD document for full
details.

• For the IWD Business Process for Composer, see the Working with the IWDBP for Composer
document for full details.

iWD supports multiple business processes (or, more generally, interaction workflows) in one tenant.
For example, it is possible to create separate business processes for different media types. As a
result, business processes may be simpler and easier to maintain. Independently created business
processes define their own sets of interaction queues. iWD allows you to configure custom queues for
each iWD solution. Each independent business process requires a separate iWD solution.

Interaction Queues

iWD recognizes seven interaction queues. By default they are created by the standard iWD business
process (IWDBP) and have the following names in the IWD Business Process for IRD:

• iWD_New

• iWD_Captured

• iWD_Queued

• iWD_Completed

• iWD_Rejected

• iWD_Canceled

• iWD_ErrorHeld

In the iWDBP for Composer they have the following names:

• iwd_bp_comp.Main.iWD_New

• iwd_bp_comp.Main.iWD_Canceled

• iwd_bp_comp.Main.iWD_Captured

• iwd_bp_comp.Main.iWD_Completed

• iwd_bp_comp.Main.iWD_ErrorHeld

• iwd_bp_comp.Main.iWD_Queued

• iwd_bp_comp.Main.iWD_Rejected

If there is more than one business process, customized queues must be configured for each solution
in the iWD GAX Plug-in. The set of allowed queues is taken from all defined business processes. The
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names of the chosen queues will then be used by both iWD Manager and iWD Data Mart instead of
the default ones.

Adding Custom Queue Names to Interaction Server
You must also ensure that the names of all customized queues for completed tasks are added to the
list of queue names in Interaction Server in the completed-queues option.

Select the newly created business process in iWD Manager and click the Configure Ixn Custom
Properties feature in iWD Manager. See also Configuring Customer Interaction Properties.

Filters

Pre-defined filters on the Global Task List have explicit queue names in their conditions. When custom
queues are defined, it is necessary to update filters' criteria with generic queue names instead of
explicit ones. For example, the filter criterion Queue is iWD_Completed or Queue is
iwd_bp_comp.Main.iWD_Completed should be changed to Queue is Completed. After such a change
the filter will work correctly in all solutions with defined custom queues for completed tasks.

The following filter criteria support generic queue names:

• Queue is '{queue}',
• Queue is not '{queue}'.

When you choose one of these criteria in the Filters page of iWD Manager, a drop-down list appears
in place of '{queue}'. There are seven generic queue names available on the list:

• Canceled

• Captured

• Completed

• ErrorHeld

• New

• Queued

• Rejected

and a special value, "(Custom...)". When "(Custom...)" is selected, an edit box appears that allows
you to write an explicit queue name.

Integrated Capture Points

Integrated Capture Points' options must be set accordingly so that they can put new or modified
interactions in the correct interaction queues. When an integrated Capture Point is connected with an
iWD solution, its options are automatically synchronized with the solution. The following options are

Configuration Configuring iWD for Multiple Business Processes

iWD Deployment Guide 152



updated in Capture Points to work with a customized iWD business process:

JMS Capture Point and File Capture Point

• inbound-transformer-parameters

• CancelQueues

• CompleteQueues

• RestartQueues

• outbound-transformer-parameters

• CancelQueues

• CompleteQueues

• ErrorHeldQueues

• RejectQueues

• RestartQueues

Web Service Capture Point and Database Capture Point

• iwd-parameters

• CancelQueues

• CompleteQueues

• ErrorHeldQueues

• RejectQueues

• RestartQueues

All Capture Points

• default-values

• Queue

The following mapping between configured queues and Capture Points' options is maintained.

Capture Point Option iWD Solution's Queue Default Value in IRD Default Value in
Composer

default-values/Queue New iWD_New iwd_bp_comp.Main.iWD_New
RestartQueues New iWD_New iwd_bp_comp.Main.iWD_New
CompleteQueues Completed iWD_Completed iwd_bp_comp.Main.iWD_Completed
RejectQueues Rejected iWD_Rejected iwd_bp_comp.Main.iWD_Rejected
CancelQueues Canceled iWD_Canceled iwd_bp_comp.Main.iWD_Canceled
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Capture Point Option iWD Solution's Queue Default Value in IRD Default Value in
Composer

ErrorHeldQueues Error Held iWD_ErrorHeld iwd_bp_comp.Main.iWD_ErrorHeld

The options are updated whenever a user changes any of the queues in the iWD Solution
configuration in GAX. They are also modified when a user changes the assigned Solution in the
Capture Point's configuration in GAX. If no Solution has been assigned to the Capture Point, the queue
options can be set manually.
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Database Cluster Configuration

Access to the Database Layer

Support for cluster level solutions like Oracle RAC or MSSQL Cluster requires configuration in
configuration objects that access the database layer. Most of these configuration objects (except the
regular one) provide an extension called Custom JDBC URL that must be used in cluster solutions like
Oracle RAC or MSSQL Cluster. Objects and their configurations are listed below:

• The DAP in IWD Runtime Node that accesses the iWD Data Mart database (Custom JDBC URL can be set
up using:
GAX -> Configuration/iWD Plugin -> Datamart -> chosen solution -> Database field "Custom
URL (for Datamart)")

• The DAP in IWD Runtime Node that accesses the Configuration Server database (Custom JDBC URL can
be configured manually by adding a jdbc section to the DAP options, with key url and a suitable value)

• The DAP in Interaction Server that accesses the Interaction Server database (Custom JDBC URL can be
configured manually by adding a jdbc section to the DAP options, with key url and a suitable value)

• The DAP in Interaction Server that accesses the EventLog database (Custom JDBC URL can be set up
using:
GAX -> Configuration/iWD Plugin -> Business Structure -> chosen solution two times ->
Interaction Server Settings -> EventLog JDBC URL)

• The JDBC URL in Runtime Node that uploads to Stat Server Java Extensions via one of the Data Mart jobs
(Custom JDBC URL can be set up using:
GAX -> Configuration/iWD Plugin -> Datamart -> <chosen solution> -> Database filed
"Custom URL (for iWD SSJE)")

• The JDBC URL in the iwd.properties file in iWD Manager that accesses the iWD Manager
database—click here.

Configuration for Oracle Support

Oracle 12c and Oracle 12c RAC are both supported in release 8.5.103. Configurations with and
without Single Client Access Name (SCAN) are supported.

Custom JDBC URLs

There are different Oracle JDBC URLs depending on whether your configuration has SCAN enabled or
disabled.
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SCAN enabled
The Oracle JDBC URL for the Data Mart DAP is:

jdbc:evo:oracle:@//rac-scan:1521/orcl.abc.xyz.domain.com

The Oracle JDBC URL for the Stat Server Java Extensions is:

jdbc:evo:oracle:@//rac-scan:1521/orcl.abc.xyz.domain.com

SCAN disabled
The Oracle JDBC URL for the Data Mart DAP is:

jdbc:evo:oracle:@(DESCRIPTION=(LOAD_BALANCE=on)(ADDRESS=(PROTOCOL=TCP)(HOST=RACNode1)
(PORT=RACNodePort1))(ADDRESS=(PROTOCOL=TCP)(HOST=RACNode2)(PORT=RACNodePort1))
(CONNECT_DATA=(SERVICE_NAME=RACServiceName)))

The Oracle JDBC URL for Stat Server Java Extensions is:

jdbc:evo:oracle:@(DESCRIPTION=(LOAD_BALANCE=on)(ADDRESS=(PROTOCOL=TCP)(HOST=RACNode1)
(PORT=RACNodePort1))(ADDRESS=(PROTOCOL=TCP)(HOST=RACNode2)(PORT=RACNodePort1))
(CONNECT_DATA=(SERVICE_NAME=RACServiceName)))

Limitations

• If RAC failover is forced when iWD Data Mart jobs are running, iWD Data Mart jobs will finish with an
error. The next execution of iWD Data Mart jobs finish correctly without errors.

• Database initialization processes (dbup) for the iWD Manager and iWD Data Mart databases do not
support failover. Initial configuration should be carried out made in a stable environment. If an error
occurs during initialization the database must be dropped and created again from scratch.

• In this initial release of Oracle support, only one SCAN is supported, though there might be up to three
in a given environment.

Configuration Database Cluster Configuration

iWD Deployment Guide 156



Install and Configure iWD Web

Prerequisites

Before installing and starting iWD Web, you must have followed as a minimum steps 1 thru 10 as
described in the Task Summary here.
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Installing iWD Web Manually on Windows
1. Make sure you have the IP for Windows available on your server. You must also have access to iWD Web

templates.
2. Login to GAX.
3. Import the iWD Web templates (iwdweb and iwdwebapp)
4. Create an application based on the iwdweb template.

Important
iWD Web requires two applications: the first one is of type 3rd party server and is used to store configuration
options in configuration server as well as defining interaction server and message server connections. The
other one is of type 3rd party application. It is used to define user credentials/permissions for login operation
in iWD Web GUI. This step refers to the first application (3rd party server).

5. Login to your Windows server.
6. Create an iWD Web log directory: /GCTI/iWD
7. Locate and double-click setup.exe in the iWD Web directory of the iWD DVD.
8. The iWD Web Installation Wizard opens. Click Next in the Welcome screen.
9. In the Connection Parameters to the Configuration Server screen, enter the login details to connect

to Genesys Configuration Server and then click Next:
• Host name—The host of Genesys Configuration Server
• Port—The port that is used by Genesys Configuration Server
• User name—The user name of the Person (or User) as defined in Genesys Configuration Manager or

Genesys Administrator.
• Password—The password that is associated with the Person (or User).

10. Choose the iWD Web application and click Next.
11. Choose the destination location for iWD Web.
12. Click Next.
13. In the Ready to Install screen, click Install to begin the installation of iWD Web.
14. When the installation has been completed, click Finish.
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Installing IWD Web Manually on Linux
1. Make sure you have the IP for Linux available on your server. You must also have access to iWD Web

templates.
2. Login to GAX.
3. Import the iWD Web templates (iwdweb and iwdwebapp).
4. Create an application based on the iwdweb template.

Important
iWD Web requires two applications: the first one is of type 3rd party server and is used to store configuration
options in configuration server as well as defining interaction server and message server connections. The
other one is of type 3rd party application. It is used to define user credentials/permissions for login operation
in iWD Web GUI. This step refers to the first application (3rd party server).

5. Login to your Linux server.
6. Create a user who will be used to manage the iWD Web application (in the sample installer below,

genesys).
7. Re-login using your iWD Web user credentials.
8. Create an iWD Web log directory as follows: mkdir -p /GCTI/iWD
9. Execute the installer:

[genesys@xx-yyy-zzzzzz ip]$ pwd
/home/genesys/ip
[genesys@xx-yyy-zzzzzz ip]$ ls -la
total 45456
drwxrwxrwx.  2 genesys genesys     4096 Jul  8 12:50 .
drwx------. 38 genesys genesys     4096 Jul  8 12:50 ..
-rwxrwxr-x.  1 genesys genesys 42876663 Jul  8 12:50 data.tar.gz
-rwxrwxr-x.  1 genesys genesys     3527 Jul  8 12:50 genesys_silent.ini
-rwxrwxr-x.  1 genesys genesys    53716 Jul  8 12:50 gunzip
-rwxrwxr-x.  1 genesys genesys  2772389 Jul  8 12:50 installer.tar.gz
-rwxrwxr-x.  1 genesys genesys     5188 Jul  8 12:50 install.sh
-rwxrwxr-x.  1 genesys genesys     1322 Jul  8 12:50 ip_description.xml
-rwxrwxr-x.  1 genesys genesys     8114 Jul  8 12:50 iscript.tar.gz
-rwxrwxr-x.  1 genesys genesys    13539 Jul  8 12:50 ospatchlist.txt
-rwxrwxr-x.  1 genesys genesys     5102 Jul  8 12:50 read_me.html
-rwxrwxr-x.  1 genesys genesys   738069 Jul  8 12:50 tar
-rwxrwxr-x.  1 genesys genesys    36270 Jul  8 12:50 tar_gunzip_license.txt
[genesys@xx-yyy-zzzzzz ip]$ ./install.sh
**************************************************
* Welcome to the Genesys 8.5 Installation Script *
**************************************************

Installing iWD Web, version 8.5.aaa.bb

Please enter the hostname or press enter for "xx-yyy-zzzzzz" =>

Please enter the following information about your Configuration Server:
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Configuration Server Hostname =>pl-byd-iwd163
Network port =>2020
User name =>selenium
Password =>

Please choose which application to install:
1 : iWD Web_8.5.aaa.bb_xx-yyy-zzzzzz
=>1

Please enter full path of the destination directory for installation =>/genesys/
iWD_Web_8.5.aaa.bb

Extracting tarfile: data.tar.gz to directory: /genesys/iWD_Web_8.5.aaa.bb
iWD_Web.sh
iwdweb-8.5.aaa.bb.jar

Installation of iWD Web, version 8.5.aaa.bb has completed successfully.

[genesys@xx-yyy-zzzzzz ip]$ cd /genesys/iWD_Web_8.5.aaa.bb
[genesys@xx-yyy-zzzzzz iWD_Web_8.5.aaa.bb]$ ls -la
total 48048
drwxrwxrwx.  2 genesys genesys     4096 Jul  8 12:53 .
drwxr-xr-x. 55 genesys genesys     4096 Jul  8 12:53 ..
-rwxrwxr-x.  1 genesys genesys     1322 Jul  8 12:53 ip_description.xml
-rwxrwx---.  1 genesys genesys 49156325 Jul  3 19:18 iwdweb-8.5.aaa.bb.jar
-rwxr-x---.  1 genesys genesys     2392 Jul  8 12:53 iWD_Web.sh
-rwxrwxr-x.  1 genesys genesys    13539 Jul  8 12:53 ospatchlist.txt
-rwxrwxr-x.  1 genesys genesys     5102 Jul  8 12:53 read_me.html
[genesys@xx-yyy-zzzzzz iWD_Web_8.5.aaa.bb]$
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Creating and Configuring iWD Web in GAX

Creating iWD Web Application

1. Create a new iWD Web application (iWD Web app_8.5.aaa.bb_xxxyyyzzz) based on the iwdwebapp
template.

Important
This should be of type ThirdPartyApplication.

Configuring iWD Web Server Application

1. Open the iWD Web Server Application which was created during installation process.
2. Add Interaction Server and Message Server to its Connections tab.

Important
iWD Web supports HA Configuration Server deployment. Primary config server must be up & running when
iWD Web is starting. Later failover may encounter.

Important
iWD Web supports HA Interaction Server deployment. For default profile HA for Interaction Server API client is
supported. For wscp profile HA for capture point is not supported.

Important
iWD Web supports HA Message Server deployment.

3. Make sure that the correct tenant is added to the Tenants tab.
4. Configure the application details on the Options tab:

a. Configure the boot section:
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i. Set the boot:iwdweb.config_server.client_app_name property to the same as the iWD Web
Application name (iWD Web app_8.5.aaa.bb_xxxyyyzzz)

Important
This is a ThirdPartyApplication type. If this application doesn't already exist, you must create it.

ii. Set profile parameter in the spring.profiles.active option.
You can select either the default value default or wscp to determine how iWD Web will interact
with Interaction Server:
• default configures iWD Web to interact directly via the Genesys PSDK and Interaction Server

API client. This is the default value.
• wscp configures iWD Web to interact with Interaction Server through a Web Service Capture

Point (already embedded in Interaction Server).

For the Security profile, you must use the default value form-login value to ensure Spring
security supports authentication against Configuration Server using username/password
credentials entered on a login form and to enable CSRF protection. This Security profile is also
set by Spring Boot's spring.profiles.active option which should look like this with default
values configured:
boot:spring.profiles.active: default,form-login

This means form login username/password authentication and direct connection via Interation Server API.

iii. Configure any other iWD Web properties as required. See here for more details.

b. If you selected default in the previous step:
i. Set the inx:solution_id (runtime_id) (SLT1).
ii. Set the inx:capture_point_id property. Use the iWD Web Capture Point name iWD_Web_WSCP.
iii. inx:department_id, inx:process_id may be used to set default values for Department and

Process.
iv. Configure any other required properties.
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Configure a Web Service Capture Point for
iWD Web

If you selected Spring profile wscp

If you chose the wscp value for the Spring profile, you need to configure a Web Service Capture Point
(WSCP) for iWD Web to use. The quickest way to do this is to clone an existing WSCP and make
configuration changes specific to your iWD Web application and environment. Or, you could create a
new one in GAX using the information in this topic.

If you selected Spring profile default

Either create a new WSCP dedicated to iWD Web or clone an existing one and make the following
configuration changes:

1. Change settings:capture-point-type to a dummy capture point type—for example,
X_webservice_X.

Important
If the default profile is used, only the runtime_id property from the Capture Point is used. The dummy
capture point that you create should not be used by any other applications, tools or clients. The iWD Web
WSCP capture point runtime_id property is added to each task which is sent to Interaction Server. The
runtime_id property allows iWD Manager to identify the originator of iWD Web tasks. Based on this property,
Data Mart is also able to identify these tasks and calculate aggregates which are used to calculate statistics.

2. Make a note of the newly created capture point's runtime_id.
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Configuring iWD Web Services
Property Default Description/Notes

Web Server
server.port 9990 Web server port
Configuration Server Options
iwdweb.config_server.host localhost Configuration Server host
iwdweb.config_server.port 2020 Configuration Server port

iwdweb.config_server.application iWDWeb Configuration Server third party
server name

iwdweb.config_server.client_app_nameiWDWebApp

Configuration Server third party
application name for
user connections. Can be configured on
Configuration
Server in third party server (the one
named by
iwdweb.config_server.application
property)
options under the boot section.

iwdweb.config_server.protocolTimeout30000
Configuration Server connection
timeout
(in milliseconds)

Configuration Server TLS Connections
iwdweb.tls.keyStore none TLS key store path
iwdweb.tls.keyStorePassword none TLS key store password

iwdweb.tls.validateCert on
Always validate certificate. When
set to off,
certificate is not being validated

HTTPS Configuration

server.ssl.enabled none Set to true to enable SSL
support

server.ssl.keyStoreType none The format used for the keystore
(for example, jks)

server.ssl.key-store none The path to the keystore
containing the certificate

server.ssl.key-store-password none The password used to generate
the certificate

For more information about how to configure SSL in Spring Boot, please refer to the vendor's Reference
Guide.
Redis Options
spring.redis.host localhost Redis server host
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Property Default Description/Notes
spring.redis.port 6379 Redis server port
Tasks Repository Options

iwdweb.repository.redis true

Use Redis as back-end repository.
The Redis back-end
repository allows to make job lists
permanent and
survive iWD Web restart.

iwdweb.repository.inmemory true

Use In Memory back-end
repository. In scenarios
where there are issues with connection to
Redis server,
used as fallback when this option is
enabled. When
In Memory back-end repository is used,
the job history
is cleaned after iWD Web restart.

Spreadsheet File Upload Limits

iwdweb.upload.maxFileSize 1MB

Upload maximum size allowed
for uploaded files. Values
can use the suffixed "MB" or "KB" to
indicate a Megabyte
or Kilobyte size

iwdweb.upload.maxRequestSize 1MB

Upload maximum size allowed
for multipart/form-data
requests. Values can use the suffixed
"MB" or "KB" to
indicate a Megabyte or Kilobyte size.

iwdweb.upload.fileSizeThreshold -1

The size threshold after which
upload files will be
written to disk. Values can use the
suffixed "MB" or
"KB" to indicate a Megabyte or Kilobyte
size.

CSV File Format
iwdweb.csv.columnSeparator ; CSV file format column separator
iwdweb.csv.lineSeparator \r\n CSV file format line separator

iwdweb.csv.quoteChar " CSV file format quotation
character

Date & Time
iwdweb.datetime.format yyyy-MM-dd Date and time attributes format
Audit
iwdweb.audit.queueCapacity 10000 Audit's data queue capacity
Logging
iwdweb.logging.dir /GCTI/iWD Logging files directory location.
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Property Default Description/Notes

Only:

• Command line—--
iwdweb.logging.dir=/var/
logs/

• System—java
-Diwdweb.logging.dir=/var
/logs/ ...

• Environment—export
IWDWEB_LOGGING_DIR=/var/
logs/
or export
IWDWEB_LOG_DIR=/var/
logs/. Property sources are
examined. Moreover,
directory must have write
permission enabled for
used which runs iwdweb
application.

• On Windows:
• Command line—add --

iwdweb.logging.dir=
"C:/Program Files/
GCTI/iWD Web/logs/" to
JavaServerStarter.exe
command.
Please note to use "/"
instead of "\".
Example— "C:\PROGRA~1\
GCTI\IWDWEB~1\
IWDWEB~1.04_\
JavaServerStarter.exe"
-host xx-yyy-zzzzzz
-port 2020 -app
"iWD
Web_8.5.aaa.bb_xx-yyy-
zzzzzz" --
iwdweb.logging.dir=
"C:/Program Files/
GCTI/iWD Web/iWD
Web_8.5.aaa.bb_xx-yyy-
zzzzzz/logs/"
You may also use "\" but
please remember to not
escape last ".
Example—"C:\PROGRA~1\
GCTI\IWDWEB~1\
IWDWEB~1.04_
\JavaServerStarter.exe
" -host xx-yyy-zzzzzz
-port 2020 -app
"iWD
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Property Default Description/Notes

Web_8.5.aaa.bb_xx-yyy-
zzzzzz" --
iwdweb.logging.dir=
"C:\Program Files\
GCTI\iWD Web\iWD
Web_8.5.aaa.bb_xx-yyy-
zzzzzz\logs\\"

• System—In
JavaServerStarter.ini
in [JavaArgs]
section add
-Diwdweb.logging.dir=C
:\Program Files\GCTI\
iWD Web\logs\

• Environment—Add
IWDWEB_LOGGING_DIR or
IWDWEB_LOG_DIR system
variable

Tasks Scheduler

iwdweb.scheduler.poolSize 10 Sets the core number of threads
in pool

Async Tasks Executor

iwdweb.async.corePoolSize 2 Sets the core number of threads
in pool

iwdweb.async.maxPoolSize 5 Sets the maximum allowed
number of threads

iwdweb.async.queueCapacity 1000 Sets the capacity for the tasks
executor queue

Web Service Capture Point

iwdweb.wscp.uri none
WebService SOAP service
endpoint. Must be
configured when the wscp profile
is used.

iwdweb.wscp.connectionTimeout 10000
WebService SOAP service
endpoint socket
connection timeout (in
milliseconds)

iwdweb.wscp.readTimeout 10000
WebService SOAP service
endpoint read
socket connection timeout (in
milliseconds)

Submitter Async Tasks Executor

iwdweb.submitter.corePoolSize 20
WebService SOAP service
endpoint task
submitter's core number of
threads in pool

Install and Configure iWD Web Configuring iWD Web Services

iWD Deployment Guide 167



Property Default Description/Notes

iwdweb.submitter.maxPoolSize 50
WebService SOAP service
endpoint task
submitter's maximum allowed
number of threads

iwdweb.submitter.queueCapacity 10000
WebService SOAP service
endpoint task
submitter's tasks queue capacity

iwdweb.submitter.caps 1000
WebService SOAP service
endpoint task
submitter's call attempts per
seconds

GAX & Global Task List Options

iwdweb.url.gax none Genesys Administrator Extension
(GAX) URL

iwdweb.url.gtl none intelligent Workload Distribution
(iWD) tasks list URL
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Customer and Partner Translation

Extracting localization files from iWD Manager

Prerequsities

• iWD Manager installed in base (en-US) localization - without Genesys-provided localization package

Procedure

1. Locate the Tomcat directory, where iWD Manager is installed.
2. Within the Tomcat directory, locate file webapps/iwd_manager/WEB-INF/lib/iwd_common.jar.
3. Extract file evo/resources/resources.properties from the iwd_common.jar file to a temporary

location. File iwd_common.jar is a zip file and can be opened with 7zip or WinZip utility on Windows
and unzip utility on Linux.

4. In the Tomcat directory, locate file webapps/iwd_manager/WEB-INF/classes/evo/cmc/ui/resources/
resources.properties. Append the content of this file to the extracted resources.properties file
saved in the temporary location.

Extracting localization files from iWD Datamart Node

Prerequisities

• iWD Datamart Node installed in base (en-US) localization – without Genesys-provided localization
package

Procedure

1. Locate file lib/iwd_common.jar within the iWD Datamart Node installation directory.
2. Extract file evo/resources/resources.properties from the iwd_common.jar file to a temporary

location. File iwd_common.jar is a zip file and can be opened with 7zip or WinZip utility on Windows
and unzip utility on Linux.

3. Locate file lib/iwd_dm.jar within the iWD Datamart Node installation directory
4. Extract file evo/gtl/datamart/resources/resources.properties from the iwd_dm.jar to a

temporary location. File iwd_dm.jar is a zip file and can be opened with 7zip or WinZip utility on
Windows and unzip utility on Linux.

5. Concatenate both extracted files.
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Extracting localization files from iWD GAX Plugin

Prerequisities

• Genesys Administration Extension package installed
• iWD GAX Plugin installed within Genesys Administration Extension

Procedure

1. Locate file iwd_gax.jar within the Genesys Administration Extension installation directory.
2. Extract file web/nls/lk.js from iwd_gax.jar to a temporary location. File iwd_gax.jar is a zip file and

can be opened with 7zip or WinZip utility on Windows and unzip utility on Linux.

Translating the resources.properties localization file

Prerequisities

• File resources.properties extracted from appropriate iWD package and saved in temporary location
• JDK 7 installed

Procedure

1. Rename file resources.properties to resources.utf8.
2. Translate the file resources.utf8. Each line in the file contains a key and value separated by the ‘=’

character. Only the value part needs to be translated—key and ‘=’ character must remain unchanged.
Any text in braces {} must remain unchanged. The file should be saved in UTF-8 encoding.

3. Use the native2ascii utility located in JDK 7 to convert file resources.utf8 into resources.properties
native2ascii –encoding utf8 resources.utf8 resources.properties.

Translating the lk.js localization file

Prerequisities

• Localization file extracted from iWD Plug-in for GAX and saved in temporary location

Procedure

1. Only text in quotes needs to be translated. Any text in braces {} is a parameter and must be left
unchanged.

2. The file must be saved in UTF-8 encoding.
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Installing translated resources.properties in iWD Manager

Prerequisities

• iWD Manager package is installed in base (en-US) localization – without Genesys-provided localization
package

• Translated resources.properties file is available in temporary location

Procedure

1. Locate the Tomcat directory, where iWD Manager is installed
2. Copy file resources.properties into webapps/iwd_manager/WEB-INF/classes directory within

Tomcat.
3. Restart Tomcat.

Installing the translated resources.properties in iWD Datamart
Node

Prerequisities

• iWD Datamart Node installed in base (en-US) localization – without Genesys-provided localization
package

• Translated resources.properties file is available in temporary location

Procedure

1. Copy file resources.properties to the config directory within iWD Datamart Node installation
directory

2. Restart iWD Datamart Node.

Installing the translated lk.js in iWD Plug-in for GAX

Prerequisities

• Genesys Administration Extension package installed
• Appropriate localization package for Genesys Administration Extension installed (either Genesys- or

Customer-provided)
• iWD GAX Plugin installed within Genesys Administration Extension
• Translated lk.js file is available in a temporary location

Procedure
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1. Locate file iwd_gax.jar within the Genesys Administration Extension installation directory
2. Update file web/nls/lk.js in iwd_gax.jar in the temporary location. File iwd_gax.jar is a zip file and

can be updated with 7zip or WinZip utility on Windows and zip utility on Linux.
3. Restart Genesys Administration Extension.
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High Availability

High Availability for iWD Components

The Interaction Server Integrated Capture Points support warm standby. For more information about
this support, see the eServices Multi-tenancy and Load Balancing Guide.

The iWD Manager and iWD Runtime Node components support only single node deployments.

Configuring a GRE Cluster

Please refer to the Genesys Rules System Deployment Guide for information about how to
configure a cluster of rules engines to provide a load-balanced solution.
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